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Getting Started

How Azure Native Qumulo Works

This section explains the main functionality of Azure Native Qumulo (ANQ), provides a feature

comparison between ANQ and Qumulo on other platforms. In addition, it explains the difference
between ANQ Hot and Cold, specifies ANQ's known limitations and compliance posture, gives an
overview of deploying the service in Azure, and lists the supported Azure Regions for the service.

What is Azure Native Qumulo?

is a fully managed service that provisions a Qumulo file system and creates a resource (for
managing the file system) under your Azure subscription. provides the same multi-protocol
support, interfaces, and functionality as Qumulo on premises.

makes it possible to configure file protocols, quotas, replication, and other features regardless of
underlying infrastructure or storage and without tracking resource quotas or costs. The service
receives the latest updates and features continuously and, if any issues occur, replaces compute
and storage resources automatically.

Names and Versions

In this guide, we refer to the features and functionality of Qumulo Core as _ ()_ or the
service.

Following ‘s initial launch, we configured the Qumulo file system in Azure to have
significant flexibility and performance improvements. For more information, see Feature
Comparison with Qumulo on Other Platforms (page 4).

Default workloads are called Hot workloads. Workloads that use the Azure Blob Storage
Cold Tier are called Cold workloads (page 5).

Feature Comparison with Qumulo on Other Platforms

The following table compares the features of with those of Qumulo on other platforms.

O Note
Because is a fully managed service, direct access to hosts with SSH is unavailable. To
configure the service, you can use:

qoCLI—from a remote machine

Qumulo Core Web Ul—by using any of the service's IP addresses


https://docs.qumulo.com/administrator-guide/qq-cli/getting-started.html

Feature Qumuloon | Qumuloon

AWS as an Premises
AMI
Automatic deployment v
Automatic infrastructure replacement v v
Automatic updates v
Availability in Cloud Marketplace v v
Customer support v v v
Integration with Azure Portal v
Payment for preprovisioned file system capacity v v
Payment for used storage space only v
Performance scales elastically at any capacity v
Performance scales with provisioned capacity v v
Qumulo Core features v v v
Simple and fast deployment under 15 Minutes v

Known Limitations
IPve Addresses: Currently, Azure Networking features don't support IPv6 addresses.

Initial Authentication over SMB: When you deploy the service initially, all users can use the
SMB protocol. However, the admin user can authenticate over all protocols except over
SMB.

To allow the admin user to authenticate over the SMB protocol, change the admin user’s
password.

Qumulo Compliance Posture

For information about Qumulo’s third-party attestations, including FIPS 140-2 Level 1, GDPR,
HIPAA, and SOC 2 Type Il, see Qumulo Trust Center.


https://qumulo.com/trust/

Using Cold Workloads

Cold uses Azure Blob Storage Cold Tier and has the same data integrity as Hot, a slightly lower
(99% rather than 99.9%) guaranteed availability, and a sustained high performance and read
throughput. Cold is designed for workloads in which the majority of the data is written once, read
infrequently, and retained for a long time period.

O Note

When Azure Blob Storage Cold Tier causes an availability event, it affects only the data within
the files, not the metadata. While the data of a specific file might become unavailable, the
file system and data within other files remain accessible.

Deploying
This section outlines the process of configuring and deploying .
1. You specify the following configuration.

Regional Settings: The availability zone and region. For more information, see Supported
Azure Regions (page 7)

Networking Settings: The virtual network in the same region. For more information, see
Virtual Networking Prerequisites (page 10)

Storage Class: For more information, see Using Cold Workloads (page 5).

2. When Qumulo creates your instance, it deploys and configures the following Azure
resources:

Managed Resource Group: This group contains the networking resources that the service
deploys.

When you create your service instance, you can specify an existing resource group or create a
new one.

Delegated Subnet: The delegated subnet that the service uses to provision endpoints for
your virtual network.

When you create your service instance, you can specify an existing delegated subnet or
create a new one..

Qumulo Service Resource: The Azure resource that represents one instance of the service.
You can use this resource to manage and view the service configuration.
Marketplace SaaS Resource: The Qumulo Marketplace SaaS resource that you select.

Azure uses this resource for billing purposes.


https://learn.microsoft.com/en-us/azure/virtual-network/subnet-delegation-overview

™ Tip
To automate the creation of instances for long-term use cases and for short-term
components of automated storage workflows, use Azure Resource Manager.

Supported Azure Regions

The following table lists the regions that supports. % indicates supported zoneless regions.

S (Arizona) West US 3

US (California) West US v % v %

S (lllinois) North Central US v % v %
US (lowa) Central US v v
US (Texas) South Central US v v

S (Virginia) East US v v
Us (Virginia) East US 2 v v
US (Washington) West US 2 v v
Canada (Toronto) Canada Central v v
Europe (Frankfurt) Germany West Central v v
Europe (Gavle) Sweden Central v v
Europe (Ireland) North Europe v v
Europe (Netherlands) West Europe v v
Europe (Oslo) Norway East v v
Europe (Paris) France Central v v
Europe (Zurich) Switzerland North v v
UK (London) UK South v v
Australia (New South Wales) Australia East v v


https://learn.microsoft.com/en-us/azure/azure-resource-manager/management/overview

Brazil (Sao Paulo State) Brazil South

India (Pune) Central India v v
Japan (Tokyo, Saitama) Japan East v v
Korea (Seoul) Korea Central v v
UAE (Dubai) UAE North v v

Usage Billing and Metering for

Once an hour, every deployed Hot and Cold instance reports a metering event to Azure
Marketplace.

O Note

Billing for Cold Instances

Cold instances:
- Are billed at a lower rate than Hot instances
Include a set amount of used capacity, higher than that of an Hot instance
Include a set amount of data that you can retrieve per month

When you exceed this amount, we charge a per-gigabyte rate for reading data from the
instance (regardless of protocol).

Have a minimum data retention period of 120 days.

When you delete data early (before the retention period expires), you incur a short-lived
data charge, equal to the remaining duration of the retention period.

Metering Dimensions for Hot and Cold

Both Hot and Cold use the Used Capacity metering dimension. In addition:
Metering for Hot instances uses the Used capacity and Used throughput dimensions

Metering for Cold instances uses the Data read and Data deleted early dimensions.



O Note

Because the throughput of an instance can vary significantly within an hour, Qumulo Core
samples the used throughput every minute, rounds the computed throughput value to 1
GBps, and then multiplies it by the used capacity during this minute.



Virtual Networking Prerequisites for Azure Native
Qumulo

This section lists the prerequisites for Azure Native Qumulo (ANQ), describes the components of
virtual networking for the service, explains how to configure them, and provides virtual
networking best practices.

How Qumulo Manages Virtual Networking for

When you create an instance, Qumulo manages the underlying storage and compute resources
for the service. These resources reside within Qumulo’s Azure tenant.

The instance connects to your Azure subscription by using VNet injection, an Azure-specific
networking technology that establishes an automatic, direct connection between your resources
and service resources without complicated manual configuration or VNet peering.

VNet injection lets you:

- Apply routing and security policies to your service endpoints by using the Azure Portal,
CLI, and API.

Create endpoints that allow access to by inserting special network interfaces into your
subnet. This process binds these network interfaces directly to the compute resources of
your instance.

When you create your instance, the Azure Portal guides you to create an appropriate subnet
configuration in your virtual network. Then, VNet injection delegates privileges to Qumulo by
communicating with the subnet.

Prerequisites for Configuring Virtual Networking

This section explains the prerequisites for configuring virtual networking for , such as creating
roles, configuring dedicated subnets, and load-balancing endpoints.

Creating Owner and Contributor Roles

The service requires an owner or contributor role with access to your Azure subscription.

A Important
A custom role must have write permissions to the resource groups in which you create your
delegated subnet and service.

Creating A Dedicated Subnet

The service requires a dedicated subnet.

10


https://learn.microsoft.com/en-us/azure/virtual-network/virtual-network-peering-overview
https://learn.microsoft.com/en-us/azure/virtual-network/subnet-delegation-overview

O Note

Your subnet address range should be at least /24 (it should contain at least 256 IP
addresses, including 251 free IP addresses and 5 |IP addresses reserved for Azure.)

Your subnet must be in the same region as the file system.

To Create a Dedicated Subnet Automatically

We recommend using the Azure Portal's automatic subnet creation and configuration
functionality.

1. Create your instance.
2. Inthe Azure Portal, click Manage Subnet Configuration.
3. When prompted, enter an IP address range for your subnet.

The Azure Portal configures your subnet and the required delegation for VNet injection
automatically.

To Create a Dedicated Subnet Manually

To apply a specific subnet configuration, you can first create a subnet and then select it when you
create your instance.

1. Identify the region in which you want to subscribe to.
2. Inthe region, create a new virtual network or select an existing virtual network.
3. Inyour virtual network, create a new subnet.

Use the default configuration or update the subnet network configuration based on your
network policy.

4. Delegate the newly created subnet to Qumulo.Storage/fileSystems .

Load-Balancing Endpoints

Qumulo provisions multiple endpoints to allow access to . Every endpoint appears in the Azure
Portal as a network interface with an IP address. Qumulo creates a managed resource group
under your subscription for these endpoints.

™ Tip
To view links to your managed resource groups and network interfaces, use the Portal view of
your Qumulo.Storage/fileSystems resource.

11



To avoid the bandwidth limits of individual endpoints, use round-robin DNS to distribute your
workload traffic across your endpoints.

Configuring Virtual Networking

This section provides an overview of configuring virtual networking for , including configuration
of network security groups, route tables, and back- and front-end networking.

A Important
To enforce network policies for traffic to and from the service, you can apply network security
groups and route tables to a delegated subnet.

Configuring Network Security Groups

Network security groups let administrators enforce networking traffic rules. You can assign
network security groups to individual network interfaces or to entire subnets.

™ Tip
Because it is possible to create or remove network interfaces from an instance, we
recommend assigning security groups to a delegated subnet.

To ensure that your configuration doesn’t block a specific protocol, follow the guidance in
Required Networking Ports for Qumulo Core (page 70).

Configuring Route Tables

To configure explicit traffic routing to and from the service, you must attach an Azure route table
to a delegated subnet, and then configure your route table.

Common configuration scenarios include routing service traffic:
- Through a firewall
- Through a gateway appliance
- Across multiple virtual network peering configurations

Configuring Back-End and Front-End Networking

The service uses a split-networking configuration in which different network interfaces handle
back-end and front-end traffic.

Because it isn't possible to access the back-end network configuration or affect back-end traffic
within your instance, you can configure firewalls and security groups within your virtual network
without having to consider back-end connectivity requirements.

12


https://en.wikipedia.org/wiki/Round-robin_DNS
https://learn.microsoft.com/en-us/azure/virtual-network/subnet-delegation-overview
https://learn.microsoft.com/en-us/azure/virtual-network/manage-route-table

Deploying and Viewing Information about Your Azure
Native Qumulo Instance

This section explains how to deploy Azure Native Qumulo (ANQ), view information about your
service, and connect to the Qumulo Core Web UI.

For an introduction, see How Works (page 4).

To Deploy

This section explains how to deploy the service in Azure.
1. Log in to the Azure Portal and search for ~°

2. On the Create a Qumulo resource in Azure page, on the Basics tab, in the Project details

section:

a. Select a Subscription that you can access as an owner or contributor.

b. Select a Resource group or click Create new.

O Note
A resource group is a container that holds related Azure resources. We

recommend creating a resource group exclusive to your Qumulo
infrastructure.

3. In the Azure resource details section:
a. Enter a Resource name.
This is the name of your service.
b. Select a Region.
For more information, see Supported Azure Regions (page 7).
c. Select an Availability zone.

Azure pins the service resources in a region to this availability zone.

O Note
By creating all your Qumulo resources within the same availability zone, Azure

can reduce latency.

In the Administrator account section, enter a Password and then re-enter it.

13



5. In the Qumulo file system details section:

a. Ifthis option is available in the region you chose, select an Availability Zone into
which to deploy the instance.

b. For Storage Class, select Hot or Cold.
For more information, see Using Cold Workloads (page 5).
6. Inthe Pricing plan section, select a pricing plan.

The pay-as-you-go plan is the default plan.

For up-front pricing plans and free trials, .
7. On the Networking tab, in the Configure virtual network section:

a. Select the Virtual network for hosting your service. For more information, see
Virtual Networking Prerequisites for (page 10).

b. Do one of the following:
Select an existing delegated subnet to associate with your service.

- To create a new delegated subnet, click Manage subnet configuration.

O Note
You can associate only one delegated subnet with one service instance.

8. On the Tags tab, enter any custom tags as a name-value pair.

9. To create a service, click Next: Review + Create >.

Viewing Service Information and Connecting to the Qumulo Core Web Ul

When Azure finishes creating your service, you can view information about the service and start
using the Qumulo Core Web UL.

Viewing the IP Addresses of Your Service

To view the IP addresses associated with your service, click IP Addresses on the sidebar.

™ Tip
We recommend using round-robin DNS to load balance (page 11) traffic across your service IP
addresses.

To Log in to the Qumulo Core Web Ul

To log in to the Qumulo Core Web Ul, you must identify your service endpoint.

14


https://learn.microsoft.com/en-us/azure/virtual-network/subnet-delegation-overview

1. Click Overview and then copy the Qumulo Core Web Ul Login URL. For example:

https://192.168.0.1/1login

2. Enter the URL into a browser from a machine that runs, or is connected to, the virtual

network where you deployed .

O Note

If you connect from a machine that is in a different virtual network, establish
virtual network peering between the two virtual networks.

If you connect from an on-premises machine, ensure that you connect by using

Azure VPN Gateway or Azure ExpressRoute.

3. When the page prompts you for a Username, enter admin .

4. When the page prompts you for a Password, enter the administrator password that you

configured previously (page 13).

15


https://learn.microsoft.com/en-us/azure/virtual-network/virtual-network-peering-overview
https://learn.microsoft.com/en-us/azure/vpn-gateway/vpn-gateway-about-vpngateways
https://learn.microsoft.com/en-us/azure/expressroute/expressroute-introduction

Connecting Azure Native Qumulo to Microsoft Entra
Domain Services

This section explains how to connect Azure Native Qumulo (ANQ) to Microsoft Entra Domain
Services (DS).

A Important
On October 1, 2023, Microsoft renamed Azure Active Directory Domain Services to Microsoft

Entra Domain Services.

Microsoft Entra DS provides managed domain services such as Windows Domain Join, Group
Policy, LDAP, and Kerberos authentication. You can connect your to standard Active Directory (on-
premises AD or self-managed AD in the cloud) or to Microsoft Entra DS.

For information about joining Microsoft Entra DS, see the following resources in the Microsoft
Entra documentation.

- Tutorial: Configure virtual networking for a Microsoft Entra Domain Services managed
domain

- Tutorial: Join a Windows Server virtual machine to a Microsoft Entra Domain Services
managed domain

To Configure Microsoft Entra Domain Services (Microsoft Entra DS)
1. Create an instance of Microsoft Entra DS by entering the following details.
Name: Your domain name.
We recommend entering $DOMAIN.onmicrosoft.com that the system creates for you.

You can also use your own custom domain name that acts as a routable or non-routable
domain suffix.

- VNet: A VNet and a resource group for your Microsoft Entra DS instance.
- SKU: Standard
Forest: User

After the system completes deploying your managed domain (this takes 1-2 hours), it
creates the VNet that you specified.

2. Configure DNS for your managed domain.
a. Logintothe Azure portal and search for microsoft entra domain services.

b. Click your domain.

16


https://learn.microsoft.com/en-us/azure/active-directory-domain-services/tutorial-configure-networking
https://learn.microsoft.com/en-us/azure/active-directory-domain-services/tutorial-configure-networking
https://learn.microsoft.com/en-us/azure/active-directory-domain-services/join-windows-vm
https://learn.microsoft.com/en-us/azure/active-directory-domain-services/join-windows-vm
https://azure.microsoft.com/en-us/

c. Inthe Required configuration steps section, under Update DNS server settings for
your virtual network, write down the domain controllers (DNS servers) that the
managed domain deployment created for you, and then click Configure.

For more information, see Update DNS settings for the Azure virtual network in
the Microsoft Entra Domain Services documentation.

3. (Optional) If the Microsoft Entra DS managed domain VNet is different from the VNet that
you used for deploying, peer the two VNets.

For more information, see Configure virtual network peering in the Microsoft Entra
Domain Services documentation.

4. Configure the DNS servers to point to the servers that the managed domain provided for
you.

For more information, see Custom DNS Configuration on Qumulo Care.

5. To finish configuring your file system to work with Microsoft Entra DS, join your cluster ton
AD by logging in to the Qumulo Core Web Ul and clicking Cluster > Active Directory.

0 Note

We recommend giving an administrative role to the user who joins the domain. For
newly created users, the system requires a password reset when the user logs in to
the Azure portal.

Next Steps

After you deploy your Microsoft Entra DS instance and connect to it, you can configure SAML
Single Sign-On (SSO) for your instance (page 26).

17


https://learn.microsoft.com/en-us/azure/active-directory-domain-services/tutorial-create-instance#update-dns-settings-for-the-azure-virtual-network
https://learn.microsoft.com/en-us/azure/active-directory-domain-services/tutorial-configure-networking#configure-virtual-network-peering
https://care.qumulo.com/hc/en-us/articles/360026611494
https://azure.microsoft.com/en-us/

Performance Characteristics and Default Service Limits
of Azure Native Qumulo v2

This section describes the performance characteristics and default service limits of Azure Native
Qumulo (ANQ) v2.

V2 introduces a file system architecture that offers improved performance and flexibility for file
systems of any size. For this reason, we eliminated the concept of total available capacity. You pay
only for the data you store and, separately, for the throughput you use.

O Note

- We describe the performance of your v2 instance in terms of throughput (bytes per
second), IOPS, and operation latency.

Because V2 is a distributed file system, it is very effective for servicing multi-stream
workloads with multiple clients or threads. The throughput and IOPS for single-
stream and low-concurrency workloads might be lower than the performance
characteristics listed in this section.

Throughput Performance

V2 instances can perform at above 100 Gbps with high-concurrency, multi-stream workloads.
However, when you provision an v2 instance, Qumulo sets a default service limit of about 4 GBps.
If you have a workload that needs higher sustained or peak throughput peak, to raise this service
limit.

0 Note
The default service limit isn't a hard cap. In certain scenarios, it might be possible to reach a
throughput higher than 4 GBps with default configuration.

IOPS Performance
By default, v2 is optimized for high-throughput (rather than high-IOPS) workloads.

For workloads with IOPS sensitivity, for a technical consultation.

18



Supported Configurations and Known Limits for Qumulo
Core

This section provides an overview of supported configurations and known limits for Qumulo Core.

Supported Configurations

Configuration Type Supported Value

Protocols
FTP

FTPS

NFSv3

NFSv4.1 (page 177)
- S3 API (page 236)
- SMB 2.002
- SMB 21
- SMB 3.0
- SMB 31
- SMB 311

Browser Google Chrome 80 (and higher)

Clients over SMB .
! v - macOS 10.14 (and higher)

- Windows 7 (and higher)

Clients over NFS .
I v - macOS10.14 (and higher)

Linux Kernel 2.6.x (and higher)

Linux Configuration Qumulo Core is up to date with all Ubuntu 20.04 security up-
dates.

19



Configuration Type Supported Value

Domain-Functional Level

Kerberos V5 Encryption
Types

LDAP Servers

Python Version for qq CLI

Known Limits

Microsoft Windows Server 2008 R2 (and higher)

O Note
Qumulo Core doesn't support Samba Domain Controllers.

RC4-HMAC-MD5
- AES256-CTS-HMAC-SHAI

- AESI28-CTS-HMAD-SHAI

OpenlLDAP for Group Expansion

3.8 (and higher)

On-Premises Cluster Size
Cloud Cluster Size

NFS Exports

SMB Shares

Access Control Entries (ACESs)
in an Access Control List (ACL)

NFS Groups

Characters in Cluster Name

Characters in Full Path (Path
Name)

Characters in File Path Compo-
nent (File or Directory)

265 nodes
100 nodes
64,000
40,000

200

16, when not using LDAP or Active Directory for RFC 2307 at-
tributes

2-15, alphanumeric and hyphen ( - )

32,760 (limited by protocol)

255 (limited by protocol)

20


https://www.ietf.org/rfc/rfc2307.txt

Files in a Directory

File Size

Total Files

Hard Links for Each File
LDAP Domains

Active Directory Domains
DNS Servers

Snapshots

Quotas

S3 Bucket Object Versions

Total Replication Relationships

NFS Sockets

4.3 billion

9 exabytes
18 quintillion
1,024

1

3
40,000

4.3 billion

O Note
This approximate value of 232 is equivalent to the possi-
ble maximum of directories or the entire inode space.

Unlimited (4,294,967,296 theoretical)

100

0 Note

If a directory is more than 100 levels below the file sys-
tem root directory, you can't use it as a replication
source.

8,000 TCP sockets for each node

0 Note
A client configured with the NFS nconnect mount option
uses multiple sockets.

21



SMB Sockets

REST API Sockets

S3 API| Sockets

5,000 TCP sockets for each node

0 Note
A client configured with the SMB Multichannel feature
uses multiple sockets.

1,000 TCP sockets for each node

1,000 TCP sockets for each node

22



Replication Version Requirements for Qumulo Core

This section explains the relationship between the version of Qumulo Core that a cluster runs and
data replication between it and other clusters.

The replication process creates a consistent point-in-time copy of data in a directory on a source
cluster when Qumulo Core transfers the data to a directory on a target cluster. Because two
clusters are required for the replication process, there are specific requirements for version of
Qumulo Core that the two clusters must run.

Replication for Qumulo Core 6.0.0.x (and Higher)

For Qumulo Core 6.0.0.x (and higher), clusters that run different versions can replicate with all
quarterly and non-quarterly versions, up to eight quarters in the future.

The following example shows a replication compatibility matrix for quarterly and non-quarterly
version of Qumulo Core.

II

()
EXd - - -l -
g - - -@§c- -
EN EN

H: - @ -
- - -

The following example shows replication options for a cluster running the quarterly (future) 8.0.0
version.

10.0.1

23



6.0.0x (g) < 610 (q) < .. < 7.2.0.2 (q) < 7.3.0 (q) < > 81.0(q) »
8.2.0 (q) » ... » 9.3.0 (q) » 10.0.0 ()

The following example shows replication options for a cluster running the non-quarterly (future)
8.0.1 version.

6.1.0 () < 61.0 (q) < .. < 72.02 (q) < 7.3.0 (q) < |[EXs}l » 81.0 (9) » 8.2.0 (q)
> ..»9.3.0(q) » 10.0.0 (q)

O Note
This schema doesn't impact replication compatibility for versions lower than 6.0.0 that are

still only compatible with a maximum of two quarterly versions.

Replication for Qumulo Core 5.0.1to 6.0.0

From Qumulo Core 5.0.1 to 5.3.4, clusters that run different versions can replicate between the
current version and up to two previous or future quarterly versions.

The following example shows replication options for a cluster running the quarterly 5.1.0 version.

4.3.0 (q) < 5.0.0 (q) < BIYEN > 5.2.0 (q) » 5.3.0 (q)

The following example shows replication options for a cluster running the non-quarterly 5.1.1

version

5.0.0 (g) < 5.1.0 (q) < » 5.2.0 (9) » 5.3.0 (q)

O Note

- From version 5.0.1, Qumulo Core blocks replication between unsupported versions.
For example, version 5.0.1 can't replicate with versions before 4.3.0 or after 5.2.0.

- In this scenario, version 5.2.0 is a hard limit. Versions 5.2.1 (and higher) can't replicate

with versions 5.0.1 (or lower).
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Replication for Qumulo Core 2.11.0 to 5.0.0

From Qumulo Core 2.11.0 to 5.0.0, clusters that run different versions can replicate between at least
two consecutive quarterly versions. For example:

415 | 420(q) | 427

415
420 (q)
421

25



Authentication

Configuring SAML Single Sign-On (SSO) for Your Qumulo
Cluster

This section explains how to integrate your Qumulo cluster with your organization's single sign-on
(SSO) service by configuring Security Assertion Markup Language (SAML) 2.0 for Qumulo Core
5251 (and higher).

For more information about the SAML standard for exchanging authentication information, see
SAML 2.0.

Prerequisites

Before you begin, make sure that you have done the following.

- To join your cluster to an Active Directory (AD) domain, log in to the Qumulo Core Web Ul
and click Cluster > Active Directory.

O Note
Qumulo Core supports SAML authentication only for AD users.

- To allow the cluster to find group memberships for SAML-authenticated users, configure
the Base DN in your AD configuration, even if you don't use POSIX attributes.

Ensure that your SAML Identity Provider (IdP) is linked to the same AD. An identity
provider (such as Azure AD, Duo, or Okta) is a system that authenticates users (for
example, by using passwords and additional factors).

Typically, an IT department manages an IdP centrally and the IdP is linked with AD. Before
you can enable SSO, your IT department must register a new Service Provider (SP) in your
IdP. A service provider is the server which users access, in this case a Qumulo cluster.

O Note
You can use trusts, as long as the Base DN covers all users that might require access
to your cluster.

- Configure your IdP to return AD User Principal Names (UPNs, for example
alice@example.com) or an email address as a name identifier for an authenticated user.
Typically, a nameID usesthe format of an email address.
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To Configure SAML SSO for Your Qumulo Cluster

This process requires coordination between the cluster administrator and SSO administrator.

1. The cluster administrator contacts the SSO administrator and asks the SSO administrator
to create a SAML integration for the Qumulo cluster.

2. The SSO administrator creates a SAML integration with your organization’s SSO identity
provider (page 26) (IdP).

a. The SSO administrator uses the cluster's fully qualified domain name (FQDN)
format for the service provider (page 26) (SP) endpoint (also known as the
assertion consumer service URL), in the following format:

https://<my-cluster>.<my-org>.com/saml

0 Note

Because the user’s browser performs DNS resolution (for example, in a VPN-
only scenario), it isn't necessary for an external DNS server to be able to
resolve the cluster’'s FQDN.

b. If prompted, the SSO administrator enters the HTTP POST binding for the SP
endpoint. Typically, this binding is specified by default.

c. If prompted for SP Entity ID (alternatively named Application Identifier or
Audience), the SSO administrator enters https://<my-cluster>.<my-org>.com/
saml .

d. If SAML Signing (depending on the SSO service, this option is named differently)
configuration is available, the SSO administrator sets it to Sign SAML response and
assertion.

O Note
Qumulo Core requires that the IdP sign both the assertion and the entire
SAML response.

e. To configure the IdP to use an algorithm based on SHA-256 (certain SSO providers
use older algorithms, such as SHA-1, by default), follow the instructions in your SSO
provider's documentation.
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™ Tip
Commonly, a signatureAlgorithm key is set to rsa-sha256 and the
digestAlgorithm key is set to sha256 in the configuration file.

3. After creating the SAML integration, the SSO administrator provides the following
information to the cluster administrator.

- The certificate (public key) of the identity provider,ina .pem file.
This certificate lets the cluster verify the authenticity of the messages from the IdP.

- The IdP SSO URL—to which the Qumulo cluster can send authentication requests—in the
following format:

https://<my-org>.<sso-provider>.com/foo

O Note
The IdP SSO URL often contains a unique identifier for the SAML integration. We don't
recommend using the same identifier on several clusters simultaneously.

- The ldP issuer or EntityId.

O Note
Don't confuse EntityId with SP Entity ID.

For example:

http://www.<sso-provider>.com/abcl2de34fgAB5CDh61i7

- The FQDN of the cluster, in the following format:

<qumulo-cluster>.<my-org>.com

4. To configure and enable SAML login to the Qumulo cluster, the cluster administrator runs
the qq saml modify settings command. For example:
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qq saml modify settings
--enable \
--idp-certificate-file ~/certificate.pem \
--cluster-dns-name <qumulo-cluster>.<my-org>.com \
--idp-entity-id http://www.<sso-provider>.com/abcl2de34fgAB5CDh6i7 \
--idp-sso-url https://<my-org>.<sso-provider>.com/abcl2de34fgAB5CDh6i7/saml

O Note

- To view the current SAML configuration, the cluster administrator can run the qq
saml get settingscommand.

- To allow specific changes (for example, correct a typo, update a DNS name or an
expired certificate, or temporarily disable SAML SSO without losing any of the
other settings), the cluster administrator can run the qq saml modify settings
command to change individual SAML settings independently.

For first-time SAML configurations, the cluster administrator must provide all of
the required settings.

- Aside from a basic check of the IdP certificate, Qumulo Core doesn't verify the
configuration parameters. It is the cluster administrator's responsibility to ensure
that IdP-initiated SAML login works correctly. (This login type initiates when the
user clicks Continue to SSO login in the Qumulo Core Web Ul or selects the
Qumulo cluster on the SSO portal.)

Supported SAML SSO Workflows

Qumulo Core supports three SAML SSO workflows:
- Standard SAML workflows that the IdP (page 26) or SP (page 26) initiates

- A workflow that the qq CLI initiates
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O Note

Members of the built-in Administrators role always have access to the Qumulo Core
Web Ul.

- To allow other users to access the Qumulo Core Web Ul, you must assign the built-in
Observers role to individual users or to groups.

Depending on policy, additional verification might be necessary for users. For
example, the SSO administrator can enforce mandatory two-factor authentication
(2FA) for certain clusters.

If the user accesses the Qumulo Core Web Ul by connecting to a node physically, the
login page doesn't show doesn't show Continue to SSO login on the Qumulo Core
Web Ul login page, even if SSO is configured.

IdP-Initiated SSO Workflow

1. A user authenticates to her organization’s SSO portal and then selects the Qumulo cluster
on the SSO portal.

2. The SSO portal redirects the user to the cluster's endpoint.

If the user has sufficient privileges, the Qumulo Core Web Ul logs the user in. Otherwise,
the Qumulo Core Web Ul displays an error message.

SP-Initiated SSO Workflow

1. A user navigates to the Qumulo cluster's Web Ul endpoint in a browser.

2. If the Qumulo cluster has SAML SSO configured, the user can click Continue to SSO login
on the Qumulo Core Web Ul login page.

the Qumulo Core Web Ul redirects the user to the configured SSO portal. Because the
authentication request uses HTTP-Redirect Binding, the login URL appears.

https://<my-org>.<sso-provider>.com/abcl2de34fgAB5CDh6i7/saml?SAMLRequest=abcd
efgh1234567890. ..

3. The user clicks the login link and the SSO portal authenticates the user.

4. The SSO portal redirects the user to the cluster’'s endpoint.
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gqg-CLI-Initiated SSO Workflow

In Qumulo Core 5.3.0 (and higher), a user can authenticate a qq CLI session by using SSO.

1. Auser usesthe qq sso login command. For example:

qq --host 203.0.113.0 sso login

The login URL and a prompt appear. The following is an example URL.

https://<my-cluster>.<my-org>.com/saml-login?login-id=12345678-1234-1234-123
4-123456789012

O Note
The user must complete the following step within 5 minutes, while the qq CLI pauses

for authentication.

2. When the user opens the login URL in a browser, the URL redirects the user to a
configured SSO portal and one of the following two scenarios takes place:

If authentication succeeds, the browser shows a message that contains an eight-character
verification code and asks the user to return to the CLI session.

The user copies the verification code and enters it into the waiting prompt of the sso login
command.

o |If the verification code is correct, the command recognizes that authentication is complete and
shows the authenticated username.

o |f the verification code is incorrect, the user must retry the workflow.
If authentication doesn't succeed, the browser displays an error message.

The user must retry the workflow.
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Requiring SSO Authentication for Cluster Management

A Important

If you use the --require-sso flag, you can no longer run the qg logincommand with
your AD account password. Instead, you must run the qq sso logincommand</a>.

- This setting doesn't restrict access through file protocols such as SMB.

Because the FTP protocol sends passwords in plaintext, it is inherently insecure. In
addition, many FTP clients don't support Transport Layer Security (TLS) or fall back
quietly to the plaintext protocol. For this reason, all Qumulo clusters have FTP
disabled by default.

In Qumulo Core 5.3.0 (and higher), you can run the qq saml modify settings command to require
AD users to use SSO authentication for managing your cluster. For example:

ggq saml modify settings --require-sso true

When the cluster requires SSO authentication, your cluster rejects password-based
authentication from AD users in the Qumulo Core Web Ul, REST API, and qq CLI.

Known Issues and Limitations

Local users (the built-in admin user and any additional users) can always use their
passwords to authenticate to the Qumulo Core Web Ul and the qq CLI.

A Important
We recommend setting a strong password for the built-in admin user and using this
account only for emergencies.

If SSO is required for a Qumulo cluster, it isn't possible to log in to the Interactive API
documentation section of the APIs & Tools page in the Qumulo Core Web Ul.

Qumulo Core doesn’t support:

o SAML Single Logout (SLO): We recommend clicking Sign out in the Qumulo Core
Web UL

o Automatic Configuration from Metadata XML: You must specify each parameter
by using the qq CLI.

o Returning to Previous Web Ul Page: You can't return to a previous page after re-
authenticating (for example, after a timeout).
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o Azure AD SAML Toolkit: Currently, due to a configuration deficiency in the toolkit,
IdP-initiated SSO isn't operational for Qumulo as a Service. Use the SP-initiated
SSO workflow (page 30).

Troubleshooting SAML SSO Authentication
This section explains troubleshooting common and uncommon SAML SSO authentication issues.
Common Issues

Typically, if SAML authentication fails, Qumulo Core’s in-browser error message explains the
reasons for failure and you can resolve the issue by setting the right configuration by using the qq
saml modify settings command. Examples of this issue type include the following scenarios:

SAML isn't enabled on the Qumulo cluster.

- There is clock skew between the IdP and the Qumulo cluster (the SSO service sets the
clock skew tolerance, typically to 5 minutes).

- The cluster-dns-name or idp-entity-id on the Qumulo cluster aren’t configured
correctly.

- Auser isn't a member of the Observers role that Qumulo Core requires for granting access
to the Qumulo Core Web UI.

Uncommon Issues

In more complex cases, the in-browser errors are less informative for security reasons. For
example, if you configure an incorrect IdP certificate on your cluster, the Signature validation
failed. SAML Response rejected. error appears.

Several AD configuration issues can cause a User not found error:
- The Qumulo cluster isn't joined to AD.
- The Qumulo cluster is joined to AD that isn't connected to the IdP.
IdP sends usernames ( namelD ) in an unusual format.

To verify that you can use a username, run the qq auth find identity command. For
example:

qq auth find identity --name MyUsername

- The Configured Base DN doesn't include all users.

To find a security identifier (SID), run the qq auth find identity command. For example:
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qq auth find identity --name MyUsername

To verify that a username is discoverable, run the qq ad sid to account command. For
example:

gq ad _sid to account --sid S-1-5-32-544

If an error occurs, contact your AD administrator and request the correct Base DN. For
more information, see Specifying the Base Distinguished Name (Base DN) (page 200).
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Configuring the Search Trusted Domains Option in
Active Directory for a Qumulo Cluster

This section explains how to restrict the scope of LDAP queries by using the Search Trusted
Domains configuration option for a Qumulo cluster joined to an Active Directory (AD) domain.

During normal AD domain operations, a Qumulo cluster often encounters LDAP referrals that
indicate to the cluster in what other locations within an AD domain it might locate requested
information. Often, these referrals are hints to other trusted AD domains which a cluster accesses
through a Domain Trust, such as a Parent Domain Trust or an external Domain Trust.

Reducing Latency by Disabling Search Trusted Domains

In Qumulo Core 6.1.0.3 (and lower), to permit Qumulo clusters to follow LDAP referrals, the Search
Trusted Domains configuration option is enabled by default.

In Qumulo Core 6.1.1 (and higher), to reduce the potential latency of AD domain operations that
might trigger and follow LDAP referrals unnecessarily (particularly for large, complex AD
environments with multiple Domain Trusts), you can disable the Search Trusted Domains
configuration option.

Disabling this option might benefit your system if you can determine that all relevant user and
group accounts—which you might expect to use POSIX attributes, logins with SAML Single Sign-
On (SS0O), or logins with NFS4.1 and Kerberos—are located entirely in the current domain.

Limitations of Disabling Search Trusted Domains

This section explains the limitations of disabling the Search Trusted Domains configuration
option.

Trusted Domains Specified in the Base DN

The Base DN (Distinguished Name) configuration option specifies the path that limits LDAP
queries. When you set the Base DN to the top-level domain or base path of a domain, LDAP
searches span the entire domain’'s LDAP structure, including LDAP referrals to other domains that
have a Trust with the currently joined domain.

Often, the Base DN configuration ensures that the system searches all Organizational Units (OUs)
in the domain, for example when the Administrator team might not have control over the OUs
that contain the user accounts to be retrieved. (This is common in a dynamic environment that an
external team manages.)

Qumulo Core lets you configure multiple Base DNs by providing their paths in a semicolon-
separated list that includes the paths of other trusted domains. This configuration permits the
trusted domains to use POSIX attributes and SAML SSO logins.
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A Important
Disabling Search Trusted Domains disregards any trusted domains specified in the Base DN.

Ignoring LDAP Referrals and Qumulo Core Authentication Processes

To decide whether your system should ignore LDAP referrals, consider the Qumulo Core
authentication processes that this might affect.

Authentication Processes that Trigger LDAP Queries

Identity mapping from NTFS to POSIX (SMB to NFS) by using the Use Active Directory for
POSIX attributes AD configuration option

SAML single sign-on (SSO) (page 26)
NFSv4.1 and Kerberos (page 198)
REST API access tokens (page 40)

- S3 access keys (page 241)

Unaffected Authentication Processes

Kerberos SMB SSO logins from Domain Local or Trusted Domain users

NTLMv2 SMB logins (username and password) from Domain Local or Trusted Domain
users

Domain Local groups that contain users and groups from other Trusted Domains

Users or groups added to SMB share permissions by using the Qumulo Core Web Ul or qq
CLl

- Security Identifiers (SIDs) resolved to usernames by using client dialog boxes, for example
in MacOS Finder or Windows File Explorer
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Configuring LDAP on your Qumulo Cluster

This section explains how to configure LDAP on Qumulo Core 2.12.1 (and higher).

To Configure LDAP by Using the Qumulo Core Web Ul

1. Logintothe Qumulo Core Web Ul..

2. Click Cluster > LDAP.

3. On the LDAP Configuration page, click Edit and then do the following:

a.

b.

g.

For Use LDAP features, click Yes.
Enter the LDAP URI.

For Base DN, enter the Distinguished Name (DN) from which the LDAP server
searches for users.

For Bind Username, enter the username for logging in to LDAP services.

O Note
This username must have the permission to search within the provided DN.

For Bind Password, enter the password that corresponds to the username.

(Optional) For Encrypt Connection, click Yes.

A Important

By default, Qumulo requires an encrypted connection to connect to LDAP
(either LDAPS or StartTLS). If you disable the option to connect without
TLS, you might expose credentials over your network.

- To use encrypted connections, you must install a valid certificate for your
LDAP server (page 130).

Click Save.

37



Creating and Using Bearer Tokens to Authenticate
Qumulo Core REST API Calls

This section explains how to create bearer tokens—by using the Qumulo Core REST API or the
Web Ul—to authenticate Qumulo Core REST API calls.

When you use the Qumulo Core REST API, you begin an authentication session by logging in to a
Qumulo cluster. Different REST endpoints require different types of authentication: For example,
certain REST APl endpoints, such as /vl/version, don't require any authentication, while the
/vl/session/login APl endpoint requires a username and a password.

Calling the login API gives you a bearer token (or access token)—a temporary credential that
Qumulo Core sends together with subsequent API calls as proof of authentication. A bearer token
is valid for 10 hours. After a bearer token expires, you must create a new bearer token.

Creating a Bearer Token

To create a bearer token, you can use the Qumulo Core REST API or Qumulo Core Web UL.

A Important
Only administrative users (or users with PRIVILEGE ACCESS TOKENS WRITE) can create bearer
tokens.

To Create a Bearer Token by Using the REST API

Begin an authentication session by calling the /vl/session/login REST APl endpoint and specify
the username and password. For example:

curl -k -X POST https://203.0.113.0:8000/v1/session/login \
-H "Content-Type: application/json" \
-d '{ "username": "Alice", "password": "rbFAYMdtGrwTAV4TROcZ"}'

The following is example output.
{ "bearer_token": "1:EXAMPLElSnp6MVZvUXhRQUViN2RCYUFVZy9zTElB..." }

To Create a Bearer Token by Using the Qumulo Core Web Ul
1. Log in to the Qumulo Core Web Ul.

2. Click APIs & Tools.
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3. Under Interactive APl documentation, enter your username and password and click Apply
credentials.

The Authentication succeeded. message appears.
4. Expand the Access Tokens section and then the POST Al/auth/access-tokens/ section.

5. On the upper-right side, click Try it out, ensure that the Request body is correct, and then
click Execute.

The following is example output.

{ "bearer token": "1:EXAMPLElSnp6MVZvUXhRQUViN2RCYUFVZy9zTElB..." }

To Use a Bearer Token to Authenticate a Qumulo Core REST API Call

Place the bearer token in your request header. In the following example, the API call lists the
nodes in a cluster.

curl -k -X GET https://203.0.113.0:8000/v1/cluster/nodes/ \
-H "Authorization: Bearer 1:EXAMPLE1Snp6MVZvUXhRQUViN2RCYUFVZy9zTE1B..."

The following is example output.

{
"id": 1,
"node status": "online",
"node_name": "my-node-name",
"uuid": "12345a6b-7c89-0d12-3456-78fe9012f345",
"label": "al:23:45:6b:70:80",
"model number": "Q0626",
"capacity in bytes": "25605032656896",
"serial number": "1234567890",
"mac_address": "00:00:1a:00:23:bc"

b
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Connecting to External Services

Creating and Using Access Tokens to Authenticate
External Services to Qumulo Core

This section explains how to create and use access tokens—by using the Qumulo Core REST AP,
Python SDK, and qq CLI—to authenticate external services to Qumulo Core.

™ Tip

It is possible to confuse the terms access token and session token. Unlike access tokens,
session tokens are short-lived and require a password to refresh, for example, to authenticate
by using the qq logincommand. Access tokens are the focus of this section.

In Qumulo Core 5.3.0 (and higher), you can use access tokens to let a user authenticate to the
Qumulo Core REST API without having to complete repetitive login procedures.

Access tokens are long-lived. They provide an alternative to session-based authentication that the
gqq login command and the Qumulo Core Web Ul use. They also support support authentication

for services, long-lived automation processes, and programmatic REST API access that doesn't
require user input.

A Important

- An attacker can use an access token to authenticate as the token's user to Qumulo
Core REST API (through HTTP, the Python SDK, or the qq CLI) and gain all of the user's
privileges. Treat access tokens, and the bearer tokens they generate, like passwords.
Store your tokens securely, rotate your tokens often, and create a token revocation
policy for your organization.

Because a token allows indefinite authentication to the associated user's account, we
strongly recommend against creating tokens for individual Qumulo Core REST API
users. For more information, see Best Practices for Using Access Tokens (page 47).

Prerequisites

PRIVILEGE ACCESS TOKEN WRITE is required for creating, disabling, and deleting access
tokens for all users in the system.

PRIVILEGE ACCESS TOKEN READ is required for listing access tokens.
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Creating and Using Access Tokens

PRIVILEGE ACCESS TOKEN WRITE is required for creating, disabling, and deleting access tokens for
all users in the system. This section explains how to create access tokens without or with an
expiration time by using the qq CLI.

To Create an Access Token without an Expiration Time

Run the qq auth create access token command and specify the user. For example:

$ gqq auth create access token jane

You can:

Specify the user as a name

Qualify the user by using a domain prefix, for example:
° ad:jane
o AD\jane
o local:jane

Specify ID types, for example:
o auth id:1234

o SID:S-1-1-0

0 Note
- Although you can create groups for users, you can't create access tokens for groups.

- To use an access token in the qq CLI, you must use the --file flag—to specify a path
for saving your credentials file in a format that the qq CLI can use—when you create
the access token.

The qq auth create access token command returns a JSON response that contains the bearer
token body and the access token ID, which you can use to manage the access token.
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"bearer_token": "access-vl:abAcde...==",
"id": "12345678901234567890123"

A Important

As soon as you receive your bearer token, record it in a safe place. If you misplace the
bearer token, you can't retrieve it at a later time. You must create a new access token.

Any user can have a maximum of two access tokens. If a user already has two access
tokens, creating new tokens fails until you remove at least one token from the user.
We strongly recommend creating a single access token for each user and using the
second access token to perform secret rotation.

Treat access tokens, and the bearer tokens they generate, like passwords. Store your
tokens securely, rotate your tokens often, and create a token revocation policy for your
organization.

To decrease the risk of giving an attacker full administrative access—including access
to cluster data—avoid generating tokens for accounts with administrative privileges.

To Create an Access Token with an Expiration Time

In Qumulo Core 5.3.2 (and higher), you can run the qq auth create access token command and

specify the expiration time. You can specify the expiration time in different formats. For example:

$ ggq auth create access token jane --expiration-time 'Jan 01 2023

$ qq auth create access token jane --expiration-time '01/01/2023 00:00'

When an access token's expiration time elapses, it isn't possible to use the token for
authentication. Any attempt to use the token results in an authentication error. To continue the
authentication process, you must either create a new access token (page 40) or update the
expiration time for your existing token (page 46).

O Note
The --expiration-time flag interprets arguments as timestamps in the UTC time zone.
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Using Bearer Tokens for Authentication

A Qumulo Core access token returns a bearer token (page 41), an item in the Authorization HTTP
header which acts as the authentication mechanism for the Qumulo Core REST API.

REST API

When you use the Qumulo Core REST API, add the bearer token to the Authorization HTTP
header. For example:

Authorization: Bearer access-vl:abAcde...==

You can also add the bearer token to a curl command. For example:

$ curl https://203.0.113.0:8000/v1l/session/who-am-i -H 'Authorization: Bearer acces
s-vl:abAcde...=='

Python SDK

When you use the Qumulo Python SDK, add the bearer token to a RestClient object. For
example:

from qumulo.rest client import RestClient
from qumulo.lib.auth import Credentials
client = RestClient('203.0.113.0', 8000, Credentials('access-vl:abAcde...=="))

For more information, see the Qumulo Core Python SDK.
qq CLI

To use an access token in the gqq CLI, you must use the --file flag—to specify a path for saving
your credentials file in a format that the qq CLI can use—when you create the access token. For
example:

$ qq auth create access token jane --file ./qumulo credentials

To use the credentials file, specify its location by using the --credentials-store flag. For
example:

$ qq --credentials-store ./qumulo credentials who am i
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Getting Metadata for Access Tokens

PRIVILEGE ACCESS TOKEN READ is required for listing access tokens. This section explains how to
get metadata for a specific access token or all access tokens by using the qq CLI.

To Get Metadata for a Specific Access Token

Run the auth get access token command and specify the access token ID. For example:

$ gq auth get access token 1234567890123456789012

This command returns a JISON object that lists:
- The access token ID
- The user that the access token represents
- The access token's creator
- The access token's creation time
- The access token's expiration time
- Whether the access token is enabled

For example:
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“creation time": "2022-12-06T01:14:39.56621474Z",
"creator": {

"auth_id": "500",

"domain": "LOCAL",

"gid": null,

"name": "admin",

"sid": "S-1-1-12-12345678-2345678901-1234567890-500",
"uid": null

b
"enabled": true,
"expiration time": "2023-01-01T00:00:00Z",
"id": "12345678901234567890123",
"user": {
"auth id": "1002",
"domain": "LOCAL",

"gid": null,

"name": "svc",

"sid": "S-1-1-12-12345678-2345678901-1234567890-1002",
"uid": null

To Get Metadata for All Access Tokens

Runthe gq auth list access tokens command.

A Important

Listing access tokens doesn't return the bearer token required for authentication. If you
misplace the bearer token, you can't retrieve it at a later time. You must create a new access
token.

The auth list access tokens command returns:
- The access token ID
- The user that the access token represents
- The access token's creator
- The access token's creation time
- The access token's expiration time
- Whether the access token is enabled

For example:
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id user creator creation time

1234567890123456789012 svc admin 2022-10-27T15:18:09.725513764Z
0987654321098765432109 svc admin 2022-10-27T15:18:24.9975729187Z

expiration time enabled

True
2023-01-01T00:00:00Z False

To filter the command’s output by user, use the --user flag and use the same format for the
name as for the qq auth create access token command.

Modifying the Expiration Time for an Access Token

PRIVILEGE ACCESS TOKEN WRITE is required for creating, disabling, and deleting access tokens for
all users in the system. This section explains how to modify access tokens by using the qq CLI.

Run the auth modify access token command and specify the access token ID and the expiration
time. For example:

$ ggq auth modify access token 1234567890123456789012 --expiration-time 'Jan 01 2023

When an access token'’s expiration time elapses, it isn't possible to use the token for
authentication. Any attempt to use the token results in an authentication error. To continue the
authentication process, you must either create a new access token (page 40) or update the
expiration time for your existing token (page 46).

O Note
The --expiration-time flag interprets arguments as timestamps in the UTC time zone.

Disabling an Access Token

To help you check your system’s security posture, Qumulo Core lets you disable an access token
without deleting it. This is a good way to check for dependencies on the access token before you

delete the token permanently.

PRIVILEGE ACCESS TOKEN WRITE is required for creating, disabling, and deleting access tokens for
all users in the system. This section explains how to disable an access token by using the qq CLI.
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A Important
After you disable an access token, you can no longer use any bearer tokens associated with
the access token to authenticate to Qumulo Core.

To disable an access token, run the qq auth modify access token command, specify the access
token ID, and use the -d flag. For example:

$ qq auth modify access token 1234567890123456789012 -d

To enable an access token, run the qq auth modify access token command, specify the access
token ID, and use the -e flag. For example:

$ qq auth modify access token 1234567890123456789012 -e

Deleting Access Tokens

PRIVILEGE ACCESS TOKEN WRITE is required for creating, disabling, and deleting access tokens for
all users in the system. This section explains how to delete an access token by using the qq CLI.

A Important
After you delete an access token, you can no longer use any bearer tokens associated with
the access token to authenticate to Qumulo Core.

To delete an access token, run the qq auth delete access token command and specify the
access token ID. For example:

$ ggq auth delete access token 1234567890123456789012

Best Practices for Using Qumulo Core Access Tokens

This section lists the best practices for limiting the exposure to lost credentials and working with
Qumulo Core access tokens securely.
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Avoiding Creation of Tokens for Administrative Accounts

An attacker can use an access token to authenticate as the token’'s user to Qumulo Core REST API
(through HTTP, the Python SDK, or the qq CLI) and gain all of the user’s privileges. To decrease
the risk of giving an attacker full administrative access—including access to cluster data—avoid
generating tokens for accounts with administrative privileges.

Generating Tokens for Service Accounts

When you connect external services to the Qumulo Core REST API, we recommend creating a
service account with limited privileges for each individual service and generating an access token
for each service account.

To Create a New Service Account

1. Log in to the Qumulo Core Web Ul.

2. Create a service account.
a. Click Cluster > Local Users & Groups.
b. Inthe Users section, click Create.

c. Inthe Create user dialog box, enter a User name and Password, re-enter the
password, and then click Create.

3. Create a role with privileges.
a. Click Cluster > Role Management.
b. In the Role Management section, click Create Role.

c. On the Create Role page, enter a Name and Description, click the Privileges for the
user, and then click Save.

4. Assign the service user to the role.

a. On the Role Management page, find the name of the role you created and then
click Add Member.

b. Inthe Add Member to <MyRoleName> dialog box, for Trustee, enter the name of
the user you created and then click Yes, Add Member.

5. Create access tokens (page 40) for your service account.
Rotating Access Tokens
We strongly recommend rotating access tokens for a service account at a regular interval.
To Rotate an Access Token for a Service Account

1. To ensure that there is only one access token for each service account, run the qq
auth list access tokens command.

If multiple access tokens exist, delete any unused access tokens.
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. To create a new access token for the service account, run the qq
auth create access token command.

In the credential store of your service, replace the old access token with the new one.
. Test that your service account can access the Qumulo Core REST API.

Confirm that there is nothing else relying on the old access token by disabling it first. If
this causes any disruptions then you can re-enable it while you resolve the issue.

. To delete the old access token, run the qq auth delete access token command.
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Connecting Your Kubernetes Cluster to Your Qumulo
Cluster by Using the Qumulo Container Storage
Interface (CSI) Driver

This section introduces the Qumulo Container Storage Interface (CSl) driver and explains how you
can connect your Kubernetes cluster to your Qumulo cluster by using the Qumulo CSI driver.

To automate container storage, enable dynamic volumes, and help you scale your application
container images based on usage and workflows, Qumulo uses its CSl driver to connect the
Kubernetes orchestrator to Qumulo persistent storage. (In comparison, for example, the NFS CSI
Driver for Kubernetes requires unprivileged NFS access for dynamic volumes and doesn’t support
volume sizing and expansion.)

For general driver information, see the Container Storage Interface (CSl) Specification.

Supported Features

The Qumulo CSI Driver supports:
- Static and dynamic (expansion) provisioning over NFSv3
- The following Persistent Volume Claim access modes:
o ReadOnlyMany
o ReadWriteMany
o ReadWriteOnce
o ReadWriteOncePod

NFSv4.1

A Important
Even when you enable NFSv4.1 for your Qumulo cluster, you must explicitly configure

NFSv4.1 to work with Kerberos (page 198).

Unsupported Features
- Volume cloning

- Volume snapshot and restore

Requirements

- A Qumulo cluster

Kubernetes 1.19 (and higher)
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Connecting Your Qumulo Cluster to Kubernetes

This section explains how you can configure, provision, and mount Qumulo storage for each Pod
(a logical wrapper for a container) on Kubernetes by using dynamic provisioning. This gives you
more control over persistent volume capacity.

Step 1: Install the Qumulo CSI Driver

1. Logintoa machine that has kubectl and can access your Kubernetes cluster.
2. Download the .zip file or use one of the following commmands.

S3:

aws s3 cp s3://csi-driver-qumulo/deploy v1.1.0.zip ./

HTTP:

wget https://csi-driver-qumulo.s3.us-west-2.amazonaws.com/deploy v1.1.0.zip

3. Extract the contents of the .zip file.
4. Run the shell script and specify the current release version. For example:

Linux:

cd deploy v1.1.0
chmod +x install-driver.sh
./install-driver.sh

Windows:

cd deploy_v1.1.0
install-driver.bat

The script configures Qumulo’s prebuilt Elastic Container Registry (ECR) image (from
public.ecr.aws/qumulo/csi-driver-qumulo:v1.1.0 ) and installs it on your Kubernetes
system.
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Step 2: Configure Volume and NFS Export Paths

To prepare your Qumulo cluster for connecting to your Kubernetes cluster, you must first
configure your volume and NFS export paths on your Qumulo cluster by setting the following
parameters for each storage class that you define.

™ Tip
Write down the paths for the following YAML keys for the storageclass-qumulo.yaml file that
you use when you create a storage class in step 5 (page 54).

1. For storeRealPath, from the root of the Qumulo file system, create a directory for storing
volumes on your Qumulo cluster, for example /csi/volumesl.

O Note

Because the CSI driver doesn’t create the directory listed in the storeRealPath key
automatically, this directory must exist below the NFS export and must not be the
NFS export itself.

2. For storeExportPath, create the NFS export for hosting the persistent volume.

3. Ifyour cluster has more than one tenant, specify the tenant ID that contains your NFS
export for the tenantId parameter. For more information, see Configure Multi-Tenancy
with Qumulo on Qumulo Care.

0 Note
If you have only one tenant, it isn't necessary to specify the “tenantld™ parameter.

- You must provide the value for tenantId as a string. For example: "2".

Step 3: Configure Credentials

To connect your Kubernetes cluster to your Qumulo cluster, you must either use an existing
account or create a new account for the CSI driver to communicate with the Qumulo API.

1. Configure a username and password for a user on your Qumulo cluster.
2. The configured username must have the following file permissions:
Lookup on storeRealPath

Create directories in storeRealPath

Create and modify quotas:

o PRIVILEGE QUOTA READ
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o

PRIVILEGE QUOTA WRITE
Read NFS exports: PRIVILEGE NFS EXPORT READ
Perform TreeDelete operations on volume directories: PRIVILEGE FS DELETE TREE WRITE

For more information, see Role-Based Access Control (RBAC) with Qumulo Core (page 59) on

Qumulo Care.

Step 4: Create and Configure Secrets

To allow the CSl driver to operate with your Qumulo cluster, you must create and configure
Secrets. You may use either Basic Authentication with a username and password, or an Access
Token. Depending on configuration, Basic Authentication may be disallowed and using an Access

Token will be required.

1. Configure one of the following authentication types.

Basic Authentication:

kubectl create secret generic clusterl-login \
--type="kubernetes.io/basic-auth" \
--from-literal=username=bill \
--from-literal=password=SuperSecret \
- -namespace=kube-system

- Access Token:

TOKEN="access-v1:zNTc5D0zWTdNi/KsZ0620fu71TweGh47u+S/5NbV. . ."
kubectl create secret generic clusterl-login \
--from-literal=access token="$TOKEN" \
- -namespace=kube-system

2. Give the CSl driver access to the Secrets. For example:
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kubectl create role access-secrets \
--verb=get, list,watch \
--resource=secrets \
--namespace kube-system

kubectl create rolebinding \
--role=access-secrets default-to-secrets \
--serviceaccount=kube-system:csi-qumulo-controller-sa \
--namespace kube-system

Step 5: Create a Storage Class

To link your Kubernetes cluster to your Qumulo cluster, you must create a storage class on your
Kubernetes cluster.

1. Begin with the example Qumulo storage class configuration.

O Note

In the following example, it is possible to use a fully qualified domain name
(FQDN) for the parameters: server: entry.

For such a configuration, all Kubernetes nodes in the cluster must be able to
resolve FQDNSs.
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apiVersion: storage.k8s.io/v1l
kind: StorageClass
metadata:
name: clusterl
provisioner: qumulo.csi.k8s.io0
parameters:
server: 203.0.113.0
storeRealPath: "/regions/4234/volumes"
storeExportPath: "/some/export"
csi.storage.k8s.io/provisioner-secret-name: clusterl-login
csi.storage.k8s.io/provisioner-secret-namespace: kube-system
csi.storage.k8s.io/controller-expand-secret-name: clusterl-login
csi.storage.k8s.io/controller-expand-secret-namespace: kube-system
reclaimPolicy: Delete
volumeBindingMode: Immediate
mountOptions:
- nolock
- proto=tcp
- vers=3
allowVolumeExpansion: true

2. Edit the configuration for your Qumulo cluster.
a. Name your storage class.
b. Specify server and storeRealPath .
c. Specify storeExportPath.

d. (Optional) Specify tenantId.

O Note
You must provide the value for tenantId as a string. For example: "2".

e. Configure the following parameters to point to the Secrets that you have created
and configured (page 53) in the namespace in which you installed the CSl driver:

controller-expand-secret-name
controller-expand-secret-namespace
provisioner-secret-name
provisioner-secret-namespace

f. Specify the NFS mountOptions . For example:



mountOptions:
- nolock
- proto=tcp
- vers=3

g. To create the class, apply the configuration. For example:
kubectl create -f storageclass-qumulo.yaml

Step 6: Create a Persistent Volume Claim (PVC) and Apply it to a Pod

To apply a PVC claim to a Pod dynamically, you must first configure and create it.

1. Begin with the example PVC configuration.

apiVersion: vl
kind: PersistentVolumeClaim
metadata:
name: claiml
spec:
accessModes:

- ReadWriteOnce
storageClassName: clusterl
resources:

requests:

storage: 1Gi

2. Edit the configuration for your PVC claim.
a. Name your claim.
b. Change storeClassName to the name of your claim.

c. Specify the capacity in spec.resources.requests.storage . This parameter lets you
create a quota on your Qumulo cluster.

d. To create the claim, apply the configuration. For example:
kubectl apply -f dynamic-pvc.yaml

3. Use the claim in a Pod or a Deployment. For example:
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apiVersion: vl
kind: Pod
metadata:
name: claiml-pod
spec:
volumes:
- name: clusterl
persistentVolumeClaim:
claimName: claiml
containers:
- name: claiml-container
image:
volumeMounts:
- mountPath: "/clusterl"
name: clusterl

A Important
When the PVC is released, a tree-delete is initiated on the Qumulo cluster for the

directory that the PVC indicates. To prevent this behavior, set reclaimPolicy to Retain.

4. You can launch and use your container image.
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Authorization

Managing File Locks in Qumulo Core

This section explains how file locks, legal holds, and retention periods work in Qumulo Core. For
information about working with S3 Object Lock, see Enabling Object Lock for S3 Buckets (page
256).

How File Locks Works in Qumulo Core

A file lock can prevent a regular file from being modified. There are two file lock types, both of
which require the FS FILE LOCK WRITE privilege.

Legal Hold: A file lock that you can enable for an indefinite time period. This file lock type
is best suited for temporary scenarios.

Retention Period: A file lock that you can enable for a specific period of time by
configuring a retention period which can be extended but never shortened or removed.
This file lock type is best suited to locking files for a known time period.

For more information and examples of configuring file locks, see the following resources in the
Qumulo qgq CLI Command Guide:

qq fs file modify lock

qq fs file get attr

How You Can Use File Locks to Implement the Write Once Read Many
(WORM) Model

To lock any newly created file once the client finishes writing to it, you can watch for file attribute
and directory changes by using REST (page 169). For example, you can use the
child data written or child size change events. For more information, see SSE Payload
Notification Types (page 170).

To implement the WORM model and maintain the file's write-once integrity, use file locks to
prevent any further modifications after the file becomes immutable following the initial write
operation.
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Managing Role-Based Access Control (RBAC) for Users
and Groups in Qumulo Core

This section explains how Role-Based Access Control (RBAC) for users and groups works in
Qumulo Core, explains the role types, and shows how to manage them by using the Qumulo Core

Web Ul.

To share management responsibilities with others, you can grant specific privileges to a user or
group—Ilocally or through Active Directory—by using RBAC.

A Important

For changes to take effect, a user account with newly assigned roles must log out of
Qumulo Core and then log back in (or its sessions must time out).

Because certain privileges (such as replication-write privileges) can overwrite or move
data to a location where a user has greater (or total) permissions, use special care
when you grant privileges to roles and users.

Qumulo Core Role Types

This section explains the Administrators, Data-Administrators, Observers, and Custom role types

in Qumulo Core.

Administrators

O Note
Only the default administrator account can access a Qumulo cluster by using SSH.

This role is suitable for system administrators. Users with this role have full access to, and control
of, the cluster, including:

Configuration and management of general cluster settings for audit logging, snapshots,
replication, quotas, and so on by using the Qumulo Core Web Ul, REST API, or qq CLI

Creation of files and directories in any current and future directories

Reading of any files and file attributes and listing of any directories in any current and
future directories

Deletion or renaming of any files and directories in any current and future directories

Changing of ownership and permissions for any files and directories in any current and
future directories
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Data-Administrators

This role is suitable for Qumulo Core REST APl and qq CLI users who don't have access to the
Qumulo Core Web Ul but have the same file privileges as those of the Administrators role,
including:

Read and write permissions for all NFS, SMB, quota, and snapshot APIs
Read-only permissions for local APl users
- Access to analytics and file system

Observers

This role is suitable for users or groups who can access the Qumulo Core Web Ul and read-only
APIs (with the exception of debug APIs and authentication settings).

O Note

Clusters that run Qumulo Core 3.0.5 (and higher) don't assign the Observers role
automatically and non-administrative users don't have access to the Qumulo Core
Web Ul or read-only APIs (unless you explicitly assign the necessary role to specific
usernames).

It is possible to assign both Data-Administrators and Observers roles to a single user.
This can give the user the ability to manage data on your Qumulo cluster by using
the Qumulo Core Web Ul without full administrative access.

Custom

For information about managing RBAC and creating custom roles by using the qq CLI, see the
following sections in the Qumulo qq CLI Command Guide:

gqq auth_assign role
gq auth create role
qq auth list privileges
qq auth modify role

gqq auth unassign role

Managing Roles by Using the Qumulo Core Web Ul

This section explains how to add a member to, and remove a member from, an existing Qumulo
Core role and how to create and edit a custom role.

To Add a Member to an Existing Qumulo Core Role

1. Log in to the Qumulo Core Web Ul.
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2. Click Cluster > Role Management.
3. On the Role Management page, next to the role to assign, click Add Member.

4, In the Add Member to <Role Type> dialog box, enter the Trustee and then click Yes, Add
Member.

™ Tip
For examples of valid trustees, click . :

5. Click Yes, Assign Role.
To Remove a Member from an Existing Qumulo Core Role

1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > Role Management.
3. On the Role Management page, next to the user or group to remove from a role, click

To Create a Custom Qumulo Core Role

1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > Role Management.
3. On the Role Management page, on the the upper-right side, click Create Role.
4. On the Create Role page:
a. Enter a Name and Description.
b. Select the privileges to add to the role and click Save.

To Edit a Custom Qumulo Core Role

1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > Role Management.

3. On the Cluster Management page, next to the role to edit, click m

4. On the Edit <Role Name> page, select the privileges to include in the role and click Save.
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Managing Cross-Protocol Permissions (XPP) in Qumulo
Core

This section explains how Cross-Protocol Permissions (XPP) work in Qumulo Core and how to
enable, disable, and check the status of XPP by using the qq CLI.

How Cross-Protocol Permissions (XPP) Work in Qumulo Core

Qumulo Core works with clients that use multiple protocols, such as SMB (page 0) and NFS (page
0). While SMB and NFS permission models are interoperable at a basic level, SMB offers a complex
permission definition which isn't fully compatible with NFS. For this reason, it is necessary to
“translate” between the two protocols when clients access the same files and directories over
SMB and NFS.

XPP enables mixed SMB and NFS protocol workflows by preserving SMB access control lists, by
maintaining permission inheritance, and by reducing application permission incompatibility.

When there are no cross-protocol interactions, Qumulo Core operates according to precise
protocol specifications. When protocol conflicts arise, XPP minimizes the possibility of application
incompatibility.

A Important
- XPP doesn't break compatibility with previous Qumulo Core releases.

Enabling XPP doesn't change the rights on existing files in your file system. Changes
take place only after you enable XPP.

For more information, see the following resources:
Qumulo Core Permission Modes
- Cross-Protocol Permissions (XPP) in Common Scenarios
- Cross-Protocol Permissions Test Drive Website.

Common Workflow Scenarios for Working with Cross-Protocol Permissions (XPP)

This section gives examples of common workflow scenarios and explains how Qumulo Core
functions when you enable XPP in these scenarios.

- Single-Protocol Workflows (Only SMB or NFS): Qumulo Core operates as expected,
according to original protocol specifications.

Mixed-Protocol Workflows (Mostly Windows or SMB): Qumulo Core operates as expected,
with the following exceptions:

62


http://0.0.0.0:4001/qumulo-doc/azure-native-administrator-guide/smb/
http://0.0.0.0:4001/qumulo-doc/azure-native-administrator-guide/nfs/
http://0.0.0.0:4001/qumulo-doc/azure-native-administrator-guide/nfs/
https://care.qumulo.com/hc/en-us/articles/360020318054
https://care.qumulo.com/s/article/Cross-Protocol-Permissions-XPP-in-Common-Scenarios
https://sites.google.com/qumulo.com/xpp-test-drive

o Because running the chmod command on a directory doesn'’t affect the ACL that
the directory’s children inherit, the command doesn’t break the permission
inheritance.

o To preserve compatibility, the chmod command retains the ability to strip rights
from privileged groups and to override the inherited rights for individual files.

Mixed-Protocol Workflows (Mostly NFS) Qumulo core operates as expected, with one
exception: To preserve compatibility, Qumulo Core permits SMB clients to add access
control entries (ACEs) to files and directories

O Note

XPP reveals permissions that Native Permissions Mode hides. This can trigger security checks
from ssh and sshd commands. If you use ssh to access NFS home directories, see Using SSH
with Cross-Protocol Permissions for more information.

To Manage Cross-Protocol Permissions (XPP)

Qumulo Core enables and disables XPP immediately, without scanning the directory tree.
Existing file and directory permissions remain unaffected unless—or until—your workflow
modifies them.

- Toenable XPP, runthe qq fs set permissions settings cross protocol command.
™ Tip
We recommend creating a snapshot before enabling XPP in a production

environment.

- Todisable XPP, run the qq fs set permissions settings native command.

- To check the current permissions mode, run the qq fs get permissions settings

command.

Troubleshooting the Permissions for a File or Directory

Explain Permissions Tools is a suite of diagnostic utilities that examines a file or directory and
explains the structure of permissions for the file or directory. For more information, see the
following sections in the Qumulo qq CLI Command Guide:

qq fs acl explain_chmod
qq fs acl explain posix mode

qq fs _acl explain rights

63


https://care.qumulo.com/hc/en-us/articles/360022920274
https://care.qumulo.com/hc/en-us/articles/360022920274
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_acl_explain_chmod.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_acl_explain_chmod.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_acl_explain_posix_mode.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_acl_explain_posix_mode.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_acl_explain_rights.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_acl_explain_rights.html

Using SMB Host Restrictions in Qumulo Core

This section explains how to use SMB host restrictions in Qumulo Core to provide fine-grained
control of access to SMB shares, based on client IP address ranges.

Depending on the configuration of your Qumulo cluster, you can grant full access, read-only
access, deny specific hosts, or deny all access. It is also possible to configure a Qumulo cluster to
prevent shares which a client can't access from being enumerated.

A Important

Because host restrictions interact with user or group share permissions and file permissions
on the basis of least privilege, in order for Qumulo Core to grant a privilege for a particular
file, the file's permissions, the share's user permissions, and the share's host permissions
must all permit the privilege.

Host restrictions apply in the order in which you write them, from top to bottom. For example, if
you deny a privilege to a host at the beginning of the permission list, and a later entry allows the
same privilege to the same host, Qumulo Core doesn't grant the privilege.

How SMB Host Restriction Precedence Works

When you create or modify an SMB share, you can use one of the following SMB host restrictions,
listed here in order of precedence.

A Important

If you don't specify any of the following restrictions, the SMB share gives all hosts full
control

If you specify one of the following restrictions, the SMB share denies access to any
hosts that you don't specify.

If you specify multiple addresses or ranges, separate them by using spaces.

1. Deny All Access

2. Deny Specific Hosts: IP address ranges to which Qumulo Core denies access to this share,
regardless of other permissions

3. Permit Read-Only Access: IP address ranges to which Qumulo Core permits only read-only
access

4. Full Access: IP address ranges to which Qumulo Core permits full access
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A Important
The file's permissions and the share’s user permissions must also grant full access.

Managing SMB Host Restrictions by Using the qqg CLI

For information about viewing, modifying, and removing host restrictions and hiding SMB shares
from unauthorized hosts by using the qq CLI, see the following sections in the Qumulo qq CLI
Command Guide:

qq smb_add share
gq smb_list share
gq smb_mod share

gq smb_modify settings

™ Tip

To hide an SMB share in the Web Ul, append $ to its name. To access the share, you
must use the fully qualified domain hame (FQDN). For example:
\\storage.example.com\MyShare$.

65


https://docs.qumulo.com/qq-cli-command-guide/smb/smb_add_share.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_add_share.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_list_share.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_list_share.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_mod_share.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_mod_share.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_modify_settings.html
https://docs.qumulo.com/qq-cli-command-guide/smb/smb_modify_settings.html

Using Active Directory for POSIX Attributes in Qumulo
Core

This section explains how to use Active Directory (AD) for POSIX attributes in Qumulo Core for
clusters with multi-protocol access (with NFS and SMB) that manage POSIX and Windows
identities from within Active Directory.

A Important
For changes to take effect, any Qumulo clusters that are already joined to an Active Directory
domain must leave the domain and then rejoin it.

How Full Credential Expansion Works in Qumulo Core

Because the SMB and NFS protocols have unique identifiers and exist in different identity
domains, it becomes difficult to link the two protocols when they represent the same identity. In
addition, storage devices can't determine the entity that attempts to access a file; as a result, a file
that a Linux system writes can be inaccessible on a Windows machine.

One solution to this issue is full credential expansion, which involves mapping the two
identities—Windows identities for SMB clients and POSIX identities for NFS clients—by using
Active Directory as a central reference. For more information, see RFC 2307 . This approach
ensures that, when you use Active Directory to maintain identity mappings from POSIX to
Windows, Qumulo Core abides by the mappings.

After you enable Active Directory for POSIX attributes in Qumulo Core, you must enable user
identity mapping from your Windows SID to your NFS UID. To do this, assign a user object (SID or
objectSid ) to every object in Windows and enter the NFS UID of the user as an object attribute.
This configuration allows Qumulo Core to correlate an NFS UID (for example, 2053 ) to a SID on
Windows (for example, S-1-5-21-...).

Whenever this user identity is required (for example, to check permissions), Qumulo Core uses the
established mapping to retrieve the entire identity for the user by referencing the NFS UIDs and
GIDs, and all SIDs, including the group IDs of any relevant parent groups.

O Note

The full credential expansion method lets your Qumulo Core cluster support more than 16
group memberships for your NFS users, as long as Active Directory manages the group
memberships.
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Enabling Active Directory for POSIX Attributes in Qumulo Core

This section explains how to enable Active Directory for POSIX attributes in Qumulo Core by using
the Web Ul and REST APL.

To Enable Active Directory for POSIX Attributes by Using the Qumulo Core Web Ul
1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > Active Directory.
3. On the Active Directory page:
a. Enter the details for your Active Directory server.
b. For Use Active Directory for POSIX Attributes, click Yes.

c. (Optional) To limit part of the Active Directory tree that Qumulo Core can query,
enter a Base DN (Distinguished Name) for User and Group Accounts.

d. Click Join.

When your cluster joins Active Directory, all SMB sessions and NFS operations result in full
credential expansion for every user. For example, when NFS UID 2053 attempts to access a file,
the cluster first queries the AD server to:

Determine the groups to which the user belongs
Map the user and groups to all Windows SIDs
- Apply permissions based on the fully expanded credential set

This configuration allows Qumulo Core to correlate an NFS UID (for example, 2053 ) to a SID on
Windows (for example, S-1-5-21-...).

To Manage Active Directory for POSIX Attributes by Using the Qumulo Core REST API

To toggle Qumulo Core’s ability to use Active Directory for POSIX attributes, use the fields
use ad posix attributes and base dn for the following REST APl endpoints.

- Get Configuration and Status: /v1/ad/status
- Get Operation Status: /v1/ad/monitor
- Join Active Directory: /vl/ad/join
To map identities from one domain to another, use the following REST API endpoints.
- GIDto SIDs: /vl/ad/uids/:gid:/sids

Local Username to All Related Identities: /vl/auth/local-username/:username:/related-
identities

POSIX GID to All Related Identities: /vl/auth/posix-gids/:id:/related-identities

POSIX UID to All Related Identities: /vl/auth/posix-uids/:id:/related-identities
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- SID to Expanded Group SIDs: /v1/ad/uids/:gid:/sids
- SIDto GID: /vl1/ad/uids/:uid:/gid
- SIDto UID: /vl/ad/uids/:sid:/uid

UID to SIDs: /v1/ad/uids/:uid:/sids

- Windows NT SID to All Related Identities: /vl1/auth/sids/:id:/related-identities

O Note
It is possible for one UID to be mapped to multiple SIDs.

To retrieve related identities, use the /vl/auth/auth-ids/:id:/related-identities REST API
endpoint.
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Storage Management

Creating and Managing Directory Quotas in Qumulo

Core

This section explains how to create, modify, and delete directory quotas by using the Qumulo
Core Web Ul and how to use the Cluster Alerts for Qumulo script to manage cluster quota
notifications.

To Create a Directory Quota

1.

2.

Log in to the Qumulo Core Web UL.
Click Sharing > Quotas.
On the right side of the Storage Quotas page, click Create Quota.
In the Create Quota dialog box:
a. Enter the Path to the directory to which to add a quota.
b. Enter the quota Limit and enter the units.

c. Click Save.

To Modify a Directory Quota

1.

2.

3.

4.

Log in to the Qumulo Core Web UL.
Click Sharing > Quotas.

For a storage quota, in the Actions column, click E .

In the Edit Quota dialog box, change the quota limit and click Save.

To Delete a Directory Quota

1.

2.

3.

4.

Log in to the Qumulo Core Web UL.
Click Sharing > Quotas.

For a storage quota, in the Actions column, click m )

In the Delete quota for path? dialog box, click Yes, Delete.

Configuring Email Notifications for Cluster Quotas

For information about configuring email notifications for your cluster's quotas, see Cluster Alerts
for Qumulo on GitHub.

For an example configuration, see example config.json.

69


https://github.com/Qumulo/cluster-email-alerts
https://github.com/Qumulo/cluster-email-alerts

Network Configuration

Required Networking Ports for Qumulo Core

This section explains which inbound and outbound networking ports Qumulo Core requires.

O Note

Active Directory authentication services require their own network port range. For an
authoritative list, see Active Directory and Active Directory Domain Service Port
Requirements in the Windows Server 2008 R2 and Windows Server 2008 documentation.

Networking Ports for Inbound Connections

21 TCP FTP

80 TCP
m TCP

UDP
443 TCP
445 TCP
2049 TCP

UDP
3712 TCP
8000 TCP
9000 TCP

32768-60999 TCP

HTTP (Web UI)

rpcbind or portmapper for NFSv3

HTTPS (Web UI)

SMB

NFS or MOUNT

0 Note

Qumulo Core supports UDP for the MOUNT protocol for older
clients. However, any NFS clients—that specify the TCP mount
option or transfer data over NFS after mounting—don't use
UDP.

Replication
REST API
S3 AP, if you enable the S3 API for your Qumulo cluster (page 236)

FTP Passive Mode
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Networking Ports for Outbound Connections

O Note
For cluster formation and inter-node communication, Qumulo Core requires unblocked IPv4

traffic in the local subnet.

53

88

11

123

135

389,
636

443

514

3712

ubP

TCP

TCP

ubP

TCP

TCP

TCP

TCP

TCP

DNS

Kerberos

rpcbind or portmapper for NSM and NLM

O Note
Depending on the client portmapper configuration, Qumulo Core might
require additional ports.

Synchronization of product and network time, for authentication and time-
stamping of artifacts such as audit logs, by using the Network Time Protocol
(NTP).

DCERPC or Netlogon (Domain Controller Binding)

LDAP to Active Directory or to a standalone LDAP server (by default)

Qumulo Shift for Amazon S3 (by default)
Audit with Rsyslog (by default)

Replication (by default)
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Configuring IPv6 in Qumulo Core

This section explains how to configure IPv6 in Qumulo Core by configuring the default gateway
and maximum transmission unit (MTU).

O Note

- The Qumulo Core Web Ul doesn't show the default gateway for IPv6.

- As for IPv4, you can configure one untagged IPv6 network by using VLAN O or
multiple tagged networks by using VLAN 1-4094 statically.

It is possible to configure an IPv4 network alongside an IPve network on any VLAN.

. Currently, Qumulo Core doesn't support VPN connections by using IPv6.

To Configure IPv6 by Using the qqg CLI

1.

To specify the default gateway for IPv4 and IPv6 traffic, run the qq network mod interface
command. For example:

qq network mod interface --default-gateway 192.168.0.1 \
--default-gateway-ipv6 2001:db8:60e0:7352:e9d2:e180:e7e8:cdb8 \
--mtu 1500

To specify IPv6 addresses for your Qumulo cluster, run the qq network mod network
command to modify the default network configuration. For example:

qq network mod network --network-id 1 \
--assigned-by STATIC \
--netmask 2001:db8::/64 \
--ip-ranges 2001:db8:0:0:1::1-2001:db8:0:0:1::ffff \
--floating-ip-range 2001:db8:0:0:2::1-2001:db8:0:0:2::ffff \
--dns-servers 2001:db8:8560:26eb:19f2:fe28:c49f:7f4c \

2001:db8:2ebf:276a:375:a593:5c3a:d4c4 \

--dns-search-domains example.com

0 Note
For IPv6 networks, you can specify subnets by using CIDR notation (for example,
2001:DB8/32) or by using a standard netmask (for example, ffff:ffff:ffff:ffff::).
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. To verify the configuration and confirm the assigned IPv6 addresses, uses the qq
network poll command.

(Optional) to check that the assigned IPv6 addresses are accessible, run the ping
command with the IPv6 address of a node in your cluster.
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Configuring Round-Robin DNS on Windows Server for
Qumulo Core

This section explains how to configure a single namespace on your Qumulo cluster to configure
round-robin DNS on a domain controller running Windows Server 2008 R2 (or higher).

O Note
To perform the following operations, you must be a member of the Domain Admins,
Enterprise Admins, or DnsAdmins group.

Step 1. Confirm that Round-Robin DNS Support is Enabled

1. In the Microsoft Management Console (MMC), ensure that the DNS Manager snap-in is
installed.

2. Click Start > Administrative Tools > DNS, right-click DNS, and then click Properties.

3. Click Advanced and ensure that round-robin DNS is enabled.

Step 2: Add DNS Entries for Each Remote Desktop Session Host Server

1. In the DNS Manager snap-in, expand your server name, then Forward Lookup Zones, and
then your domain name.

2. Right-click a zone and then click New Host (A or AAAA).

3. For Name, enter the hostname (virtual name) for clients that connect to your Qumulo
cluster.

O Note
Don't enter the hostname of another existing server.

4. Enter the first floating IP address for one of the nodes in your cluster.

O Note
Use only floating IP addresses for round-robin DNS entries.

5. Repeat these steps for each floating IP address that belongs to a node in your cluster.
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Step 3: Configure the Time to Live (TTL) for DNS Requests to Your Cluster

To ensure that client connections to your cluster are balanced evenly, you must provide a single
namespace for your cluster. To do this, configure your DNS server to send a different IP address
for each DNS request for your Qumulo cluster.

For example, you can set the TTL for each record to 0, to allow each DNS lookup for your Qumulo
cluster to yield one of the four configured IP addresses.

1. In the DNS Manager snap-in, click View > Advanced and open your records for editing.

2. Configure the TTL for each record.
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Global Namespace

How Portal Relationships between Qumulo Clusters
Enable Global Namespace Functionality in Qumulo Core

This section explains how creating portals on Qumulo clusters, and establishing relationships
between spoke and hub portals, enables Global Namespace functionality in Qumulo Core.

™ Tip
For a general conceptual introduction, see What is Hub and Spoke Topology?

For specific implementation of the Global Namespace functionality in Qumulo Core,
see Example Global Namespace Scenarios (page 79).

Qumulo clusters can take advantage of the Global Namespace functionality that lets clusters
across disparate geographic or infrastructural locations (on-premises and in the cloud) access the
same data while maintaining independent namespace structures on each cluster (for example,
by setting only a portion of the cluster’s file system as the portal root directory).

To enable Global Namespace functionality, you must define a spoke portal (page 77) on one
cluster, a hub portal (page 77) on another cluster, and then propose a portal relationship (page 77)
between the two.

A Important

Before you begin to implement Global Namespace in your organization, we strongly
recommend reviewing this page, especially the Known Limitations (page 81) section.

For any questions, contact the Qumulo Care team.

Key Terms

The following key terms help define the components of Global Namespace functionality in
Qumulo Core.

- Spoke Portal Root Directory, Hub Portal Root Directory: A directory on a cluster that uses a
portion of its file system for the hub portal or spoke portal.

According to the file system permissions that a hub portal might impose, you can access
a portal root directory by using NFSv3, SMB, or the Qumulo Core REST API.
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O Note
To ensure strict consistency with the hub portal, all file system objects under the
spoke portal root directory are read-only.

Spoke Portal: An interface point on a Qumulo cluster that accesses a portion of the file
system on another cluster (which has a hub portal). A directory on a cluster defines the
root directory for spoke portal. The spoke portal initiates the creation of a hub portal.

Hub Portal: An interface point on a Qumulo cluster that shares a portion of its file system
with another cluster (which has a spoke portal). A directory on a cluster defines the root
directory for hub portal. The spoke portal initiates the creation of a hub portal.

0 Note

It isn't possible to create hub portal without a spoke portal. For example, a spoke
portal on Cluster A can propose a portal relationship to Cluster B. This action initiates
the creation of a hub portal in a Pending state on Cluster B. You must authorize the
portal relationship before you can use it.

Portal Relationship: A proposal that a spoke portal on one Qumulo cluster issues to
another Qumulo cluster (which will have a hub portal), which the Qumulo cluster with the
hub portal authorizes.

Cluster: Any Qumulo cluster that shares a portion of its file system for a hub portal or a
spoke portal. A directory on a cluster defines the root directory for a spoke portal or a hub
portal.

™ Tip
Because part of a Qumulo cluster's file system can hold the hub portal root directory
or spoke portal root directory, using the correct terminology can help avoid confusion:

o Y hub cluster

[e]

hub portal host cluster

o X spoke cluster

[e]

spoke portal host cluster

Portal States

Throughout the process of creating a spoke portal (page 77) and proposing a portal relationship
(page 77), either portal type can be in one of the following states.



e o

Unlinked Qumulo Core has created the spoke portal, but hasn't established a relationship for
it. Use the qq portal propose hub command.

Pending Qumulo Core has established a relationship between the spoke portal and a hub
portal, but the hub portal hasn't given its authorization. Use the qq portal autho-
rize hub command.

Active The portal relationship is operational for both clusters and the spoke portal root di-
rectory is accessible if full connectivity is established.

Ended The spoke portal root directory is inaccessible because the relationship between
the hub portal and spoke portal was removed.

Working with the Global Namespace Functionality

When the hub portal (page 77) authorizes the portal relationship (page 77), the contents of the
hub portal root directory become available to the spoke portal (page 77) immediately.

The first time a client accesses a spoke portal root directory, the spoke portal begins to read and
cache data from the hub portal. Subsequent access to the same data accesses the cache of the
spoke portal host cluster, with performance characteristics equivalent to access to non-portal
data on the spoke portal host cluster. Caching takes place on demand, when a client with access
to the spoke portal accesses new portions of the namespace that the hub portal provides. For
more information, see Configuring Cache Management for Spoke Portals in Qumulo Core (page
88).

To ensure strict consistency, the system uses a proprietary locking synchronization mechanism to
ensure that any changes made on the hub portal become available immediately to any client
reading this data from the spoke portal.

O Caution
The cache of a spoke portal is inherently ephemeral. You must not use it in place of data
replication or backup.

Qumulo Core enforces permissions in the same way for files and directories in the spoke portal
root directory and the hub portal root directory.
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A Important

Only system administrators can access the files and directories that cluster-local
users own on the hub portal host cluster.

Deleting the portal relationship doesn't affect the data on the hub portal.

- A spoke portal is inaccessible without full connectivity between the two clustersin a
portal relationship.

You can remove the portal relationship from either the spoke or hub portal.

If you remove the spoke portal, Qumulo Core also deletes its root directory, reclaims the
capacity consumed by cached data, and the hub portal enters the Ended state.

If you remove the hub portal, all data transfer to the spoke portal stops immediately and
the spoke portal enters the Ended state (however, its cached data is present but
inaccessible).

Example Global Namespace Scenarios

The following are examples of some of the most common scenarios for workloads that use Global
Namespace functionality.

Edge Clusters

In this scenario, you deploy a single, large central cluster at your organization’s data center and
multiple, small edge clusters at your organization’s branch offices or in remote locations.
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The Global Namespace functionality lets you make the data on the central cluster available to the
remote clusters without the need to replicate data to each location. The data remains available to
the edge clusters even if their capacity is lower than that of the central cluster.

Active Workload with Archive

In this scenario, several clusters serve active workloads but require access to a large data archive
after the initial workflow completes.

Tree-Delete
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O,

Replicate Data Se

—
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Create Portal Relationship
From Archive Cluster — E

s

to Active Cluster
Hub
Active Workload Data Archive
Cluster Cluster

The Global Namespace functionality lets you:



Move your cold (infrequently accessed) data to a central archive cluster and then provide
access to this data by using a portal on the original cluster.

The active workload clusters can reclaim most of the data set capacity that was tiered to
the data archive cluster. In other words, it is possible to access all the data as before, while
using only the capacity on the active workload clusters for the data that your system reads
through the portal.

Serve specific archive capacity and performance needs by scaling the archive cluster
independently of any active workflow clusters.

Known Limitations of the Global Namespace Functionality in Qumulo Core
General

Currently, it is possible to configure and manage Global Namespace functionality only by
using the qq CLL

File System

- A Qumulo cluster can be a portal host for any number of hub portals or for a single spoke
portal. It isn't possible for a Qumulo cluster to be a host for spoke and hub portals
simultaneously.

- To ensure strict consistency with the hub portal, all file system objects under the spoke
portal root directory are read-only.

Only system administrators can access the files and directories that cluster-local users
own on the hub portal host cluster.

Data Caching

- Although first-time data access to data in the spoke portal root directory is subject to
round-trip latency between the spoke portal host cluster and the hub portal host cluster,
subsequent access to the data is faster. Making changes to data under the hub portal root
directory is also subject to latency when the system recaches these changes upon access.

- The cache of a spoke portal is inherently ephemeral. You must not use it in place of data
replication or backup.

Future Qumulo Core upgrades might remove cached data from the spoke portal, which
can result in a temporary increase in data access latency.

Portal Connectivity

- A spoke portal is inaccessible without full connectivity between the two clusters in a portal
relationship.

- A spoke portal is inaccessible if the hub portal host cluster and the spoke portal host
cluster run different versions of Qumulo Core.



Protocols

It isn't possible to create a spoke portal on a cluster with the NFSv4.1, FTP, or S3 protocols
enabled or to enable these protocols on an existing spoke potal host cluster.

Protocol locks don't synchronize between the hub portal host cluster and the spoke portal
host cluster. Specifically, NFSv3 or NLM byte-range locks, SMB share-mode locks, SMB
byte-range locks, and SMB leases function independently on the two clusters.

Qumulo Core doesn't send SMB2 CHANGE NOTIFY messages for changes within the spoke
portal root directory.
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Configuring a Portal Relationship Between Two Qumulo
Clusters

This section explains how to use the Global Namespace functionality in Qumulo Core by creating
a spoke portal (page 77) on one cluster, proposing a portal relationship (page 77) to another
cluster (which creates the hub portal) (page 77), and authorizing the relationship by using the qq
CLI.

A Important

Before you begin to implement Global Namespace in your organization, we strongly
recommend reviewing How Portal Relationships between Qumulo Clusters Enable a
Global Namespace in Qumulo Core (page 76), especially the Known Limitations (page
81) section.

For any questions, contact the Qumulo Care team.

Configuring a Portal Relationship Between Two Qumulo Clusters

This section explains how to configure a portal relationship between two Qumulo clusters by
using the qq CLI.

Prerequisites
- Two clusters with the same version of Qumulo Core

Network connectivity on TCP port 3713 from the cluster that shares a portion of its file
system for the spoke portal root directory (page 76) to the cluster that will share a portion
of its file system for the hub portal root directory (page 76)

PRIVILEGE PORTAL GLOBAL READ for viewing the status for a hub portal or spoke portal and
retrieving general portal information

Spoke portals

o PRIVILEGE PORTAL SPOKE EVICT : Control automatic cache management for active
spoke portals by configuring a free threshold (page 88)

o PRIVILEGE PORTAL SPOKE READ :View the status of a single spoke portal

o PRIVILEGE PORTAL SPOKE WRITE : Create a spoke portal and propose a relationship
with a hub portal

Hub portals

o PRIVILEGE PORTAL HUB READ :View the status of a specific hub portal
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°  PRIVILEGE PORTAL HUB WRITE : Authorize a hub portal and confirm a relationship
with a spoke portal

A Important

If both of the clusters use Active Directory, they must be joined to the same domain
or each cluster must be joined to Active Directory domains that have a two-way trust
relationship to each other.

- A Qumulo cluster can be a portal host for any number of hub portals or for a single
spoke portal. It isn't possible for a Qumulo cluster to be a host for spoke and hub

portals simultaneously.

Step 1: Create the Spoke Portal

This section explains how to create the spoke portal (page 77) on one cluster and propose the
creation of a portal relationship (page 77) to another cluster (which creates the hub portal (page

77)).

1.

On one cluster, choose a location for the spoke portal root directory (page 76). For
example, /remote/projects.

To propose an initial portal relationship, run the qq portal create command and specify
the spoke portal root directory, the IP address of the proposed hub portal host cluster, and
the proposed hub portal root directory on that cluster. For example:

qq portal create \
--spoke-root /remote/projects \
--hub-address 203.0.113.0 \
--hub-root /projects

The spoke portal enters the Pending state. The following is example output from the
command.

ID State Hub Spoke Root Hub Root ID

2 Pending 203.0.113.0 /remote/projects 3

If Qumulo Core can't establish a connection from the cluster with the spoke portal portion
to the cluster with the hub portal portion, it displays an error message and the spoke
portal enters the Unlinked state.

To propose a portal relationship at a later time, do the following:
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a. To find the spoke portal ID, run the qq portal list command.

b. Runthe qq portal propose hub command and specify the spoke ID, the IP
address of a prospective Qumulo cluster with the hub portal portion, and the
proposed hub portal root directory on that cluster. For example:

qq portal propose hub \
--spoke-id 2 \
--hub-address 203.0.113.0 \
--hub-root /projects

O Note
- We recommend using floating IP addresses.

Qumulo Core doesn't support fully qualified domain names (FQDNSs) for
this operation.

Portal IDs are unique within each cluster. It isn't possible to use a portal ID

from a spoke portal to identify the other side of the relationship, or the
other way around.

c. When the portal relationship is established, both spoke portal and hub portal
enter the Pending state.

O Note

In this state, the spoke portal root directory is empty and Qumulo Core
doesn't transfer any data until the hub portal authorizes the portal
relationship.

You can check the status of a cluster by using the qq portal list command. The

following is example output from the command that shows the portal ID, state,
role, and root directory.

From the spoke portal host cluster

ID State Role Local Root

2 Pending Spoke /remote/projects

From the hub portal host cluster
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ID State Role Local Root

4  Pending Hub /projects/

Step 2: Authorize the Portal Relationship

This section explains how to authorize the portal relationship (page 77) from the hub portal (page
77) to the spoke portal (page 77).

1. Tofind the hub portal ID, run the qq portal list command.

™ Tip
To retrieve portal configuration information, run the qq portal list spokesand qq
portal list hubscommands.

2. To authorize the proposed portal relationship, run the qq portal authorize hub
command and specify the hub portal ID and the IP address that the current cluster can
use to contact the cluster that proposed the relationship. For example:

qq portal authorize hub \
--id 4\
--spoke-address 203.0.113.1

0 Note
Portal IDs are unique within each cluster. It isn't possible to use a portal ID from a
spoke portal to identify the other side of the relationship, or the other way around.

The following is example output from the command that shows that the portal
relationship for the hub portal isin the Active state.

ID State Root Peer Address Peer Name

4 Active /projects 203.0.113.1 qfsd-edge

After a few seconds, the spoke portal enters the Active state as well. You can now use the
spoke portal root directory.
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Configuring Cache Management for Spoke Portals in
Qumulo Core

This section explains how to configure automated removal of cached data from spoke portals and
how to remove cached directories and files from spoke portals by using the qq CLI.

Before you can configure spoke portal cache management, your Qumulo cluster must have an
active portal relationship (page 83).

How Cache Management Works in Qumulo Core

By default, Qumulo Core automatically recaches data on spoke portals upon access and
maintains a minimum of 5% free capacity on clusters whose spoke portals contain cached data.
Qumulo Core removes cached data in the background until it meets its configured free threshold
or until it removes all cached data from the spoke portals.

You can configure the automated removal of cached data (page 88) or remove cached data from
spoke portals by using the qq CLI (page 89).

O Note

Although this process doesn'’t affect data on the hub portal, accessing the portions of spoke
portals whose cached data has been removed can incur the same latency as during initial
access.

Configuring Automated Removal of Cached Data from Spoke Portals

This section explains how to configure automatic cache management for active spoke portals. To
control automatic cache management, you can configure a free threshold. For example, if you set
the free threshold setting to 0.05, Qumulo Core begins to remove cached data from spoke
portals when the system is 95% full.
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A Important

Depending on the free threshold configuration, the maximum amount of cached
data that Qumulo Core can remove is equal to the amount of data that spoke portals
consume.

Spoke portals function as long as Qumulo Core has sufficient capacity for servicing
in-flight file system requests. However, having to continuously fetch data from the
hub portal can decrease system performance.

If file system objects unrelated to spoke portals consume all usable capacity on a
cluster, clients can experience issues while attemping to access spoke portals.

- Toview the current free threshold, run the qq portal get eviction settings command.

- To configure the current free threshold, run the qq portal set eviction settings
command and specify the free threshold value as a decimal between 0.0 and 1.0.Inthe
following example, Qumulo Core begins to remove cached data from spoke portals when
the system is 80% full.

qq portal set eviction settings \
--free-threshold 0.2

Removing Cached Data from Spoke Portals by Using the qqg CLI

This section explains how to free capacity by removing a cached directory, file, or a child file or
directory linked to a parent directory.

To Remove a Cached Directory
1. Ensure thatthe jq toolis installed on your system.

2. To determine the spoke ID, run the qq portal list spokes command and compare the
spoke portal root directory to the path of the cached directory to be removed.

3. To determine the ID of the directory to be removed, run the qq fs file get attr
command and pipe the output to the jq tool. For example:

qq fs file get attr \
--path /portals/seattle/media/ | \
jq .id
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4. Runthe qq portal evict tree command and specify the spoke ID and directory ID. For
example:

gq portal evict tree \
--spoke-id 3 \
--dir-id 29710

Qumulo Core begins to remove the cached directory. The following is example output.

{
"monitor uri": "vl/tree-delete/jobs/29710"

}

5. Toview the status of the removal process, run the qq tree delete get command and
specify the directory ID.

The following is example output.

id initial path mode

29710 /portals/seattle/media PORTAL EVICTION

To Remove a Cached File

1. Ensure that the jq toolis installed on your system.

2. To determine the spoke ID, run the qq portal list spokes command and compare the
spoke portal root directory to the path of the cached file to be removed.

3. To determine the ID of the file to be removed, run the qq fs file get attr command
and pipe the output to the jq tool. For example:

qq fs file get attr \
--path /portals/seattle/project.xml | \
jq .id

4, Runthe qq portal evict data command and specify the spoke ID and file ID. For
example:
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qq portal evict data \
--spoke-id 3 \
--file-id 14560

The cached file is removed. The following is example output.

{
"evicted blocks": 5000

}

To Remove a Cached Link from a Directory to its Child File or Directory

O Note
If no links remain to a cached child file or directory, this operation also removes the cached

child.

1. Ensure thatthe jq toolis installed on your system.

2. To determine the spoke ID, run the qq portal list spokes command and compare the
spoke portal root directory to the path of the of the child file or directory to be removed.

3. To determine the ID of the directory whose cached link to a child file is to be removed, run
the qq fs file get attr command and pipe the output to the jg tool. For example:

qq fs file get attr \
--path /portals/seattle/ | \
jq .id

4, Runthe qq portal evict link and specify the spoke ID, the directory ID, and the name of
the cached child file or the path of the cached child directory to be removed. The
following example specifies the file project.xml.

gqq portal evict link \
--spoke-id 3 \
--dir-id 54890 \
--name project.xml

The following is example output.
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{

}

"evicted blocks": 2
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Web Ul

Setting the Qumulo Core Web Ul Login Banner

This section explains how to set a login banner for the Qumulo Core Web UI.
In Qumulo Core 5.2.1 (and higher), clusters have an optional login banner that users must

acknowledge before being they can log in to the Qumulo Core Web UI.

To Set the Qumulo Core Web Ul Login Banner

To set the login banner, run the qq web ui modify settings command. To specify the Markdown
file to use for the banner, use the --login-banner flag. For example:

qq web ui modify settings --login-banner my-banner.html

To Clear the Qumulo Core Web Ul Login Banner

To clear the login banner, run the qq web ui modify settings command and use the --disable-
login-banner flag.

qq web ui modify settings --disable-login-banner

To View the Current Web Ul Login Banner

To view the current login banner, run the qq web ui get settings command and use the --
login-banner flag.

qq web ui get settings --login-banner
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Setting the Qumulo Core Web Ul Inactivity Timeout

This section explains how to set an inactivity timeout for the Qumulo Core Web Ul.

In Qumulo Core 5.1.0 (and higher), clusters have an optional inactivity timeout that logs users out
of the Qumulo Core Web Ul if they don't interact with it for a specified amount of time.

O Note

During the final minute of the timeout period, the Your Session is About to Expire dialog box
appears. The dialog box shows a countdown and lets the user renew the session or log out
immediately. When deciding on the timeout length, take your users’ needs into
consideration.

To Set the Qumulo Core Web Ul Inactivity Timeout

To set an inactivity timeout, run the qq web ui modify settings command and use the --
inactivity-timeout flag to specify the timeout in minutes. For example:

qq web ui modify settings --inactivity-timeout 15

To Clear the Qumulo Core Web Ul Inactivity Timeout

To clear an inactivity timeout, run the qq web _ui modify settings command and use the --
disable-inactivity-timeout flag.

qq web ui modify settings --disable-inactivity-timeout

To View the Current Web Ul Inactivity Timeout

To view the current inactivity timeout, run the qq web ui get settings command:

gqq web ui get settings

94


https://docs.qumulo.com/qq-cli-command-guide/web/web_ui_modify_settings.html
https://docs.qumulo.com/qq-cli-command-guide/web/web_ui_modify_settings.html
https://docs.qumulo.com/qq-cli-command-guide/web/web_ui_modify_settings.html
https://docs.qumulo.com/qq-cli-command-guide/web/web_ui_modify_settings.html
https://docs.qumulo.com/qq-cli-command-guide/web/web_ui_get_settings.html
https://docs.qumulo.com/qq-cli-command-guide/web/web_ui_get_settings.html

Getting Started with the gqg CLI

This section explains how to download and get started with the qq CLI.

The qq CLIis a powerful tool that lets you configure, manage, and administer Qumulo clusters.

Prerequisites
The qgq CLI works with Python 3.8 to 3.11.

™ Tip
- On Linux or macOS, run the chmod +x qq command to make the qq CLI executable.

- On Windows, use the python.exe interpreter to run the qq CLI.

Downloading or Installing the qg CLI

This section explains how to download the qgq CLI from your Qumulo cluster or how to install it by
using the Python SDK.

To Download and Run the qqg CLI from Your Qumulo Cluster

1. Log in to the Qumulo Core Web Ul.
2. Click APIs & Tools > Download gg Command-Line Tool for Python 3.8+
3. Runthe qg CLI.
- On Linux or macOS, run the chmod +x gqg command to make the qq CLI executable.

- On Windows, use the python.exe interpreter to runthe qq CLI.
To Install the gqq CLI by Using the Python SDK

Run the pip install qumulo api command.

Exploring Your Qumulo Cluster by Using the qqg CLI

The best way to start exploring your Qumulo cluster by using the qg CLI is to learn about its most
frequently used commands. For example:

qq login : Connect to the IP address of one of the nodes in your cluster and log in.
qq nodes_list : List information about the nodes in your cluster.

qq version : Show the version of Qumulo Core running on your cluster.

qq fs_read_dir : List the contents of a directory on your cluster.

qq fs_write : Write a file to a directory on your cluster.
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™ Tip
To get a complete list of qq CLI commmands, run the qq --help command.

To Run qq CLI from a Remote Machine

Run the gq login command and specify the IP address of one of the nodes in your cluster and
your credentials. For example:

gq --host 203.0.113.0 login \
-u admin
-p NWObJbixtQcQzkqg5q4sp

To Run qq CLI from a Node in Your Cluster

Use SSH to log in to one of the nodes in your cluster.

O Note

It is possible to run qq CLI commands as the administrative Linux user. However, to do this,
you must authenticate by using the qq login command.
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Enabling Autocomplete for the gqqg CLI

This section explains how to enable automatic cormmand completion for the qg CLI and for

command aliases.

The qgq CLI supports Python argparse completion that helps you use the CLI more effectively. This
section explains how to enable automatic command completion for the gqq CLI and for

command aliases.

A Important
The following procedures apply to running the qq CLI on Linux, macOS, and Windows

Subsystem for Linux. Don't run these commands on Qumulo nodes

To Enable Autocomplete for the gqqg CLI

1. Install the argcomplete Python package.

pip install argcomplete

O Note
Qumulo Core supports argcomplete 2.0.0 and higher.

2. Activate the argcomplete package.
sudo activate-global-python-argcomplete
3. Search for any conflicting qg entries.
complete | grep qq

If conflicting entries exist, remove them by specifying the entry name or path. For

example:

complete -r /my/path
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4. To enable autocompletion for the qgq CLI, add the following line to the end of your shell
profile ( .bashrc, .bash profile, and so on).

eval "$(register-python-argcomplete qq)"

5. Reload your shell profile.

source ~/.bashrc

You can now use the Tab key to autocomplete qq CLI commands. The qq CLI supports
autocomplete for all CLI arguments and Qumulo Core REST APl command arguments.

Enabling Autocomplete for gg CLI Command Aliases

To eliminate the need to repeatedly enter qq CLIflags (such as --host or --credentials-store),
for example when dealing with multiple Qumulo clusters, you can add aliases for qq CLI
commands to your shell profile. In the following example, we alias a complex gqq CLI command to
the simple alias qqcreds .

alias qqcreds='qq --host my.qumulo.com --credentials-store ~/.my creds'

When you reload your profile, you can append a parameter to the complex command by
appending it to the alias. For example:

gqcreds my credentials

To ensure that your argcomplete configuration works with qq CLI command aliases, you must
perform additional configuration and add a third-party helper script to your system.

A Important
Before you begin, review the source code of the complete-alias helper script. Qumulo doesn’t
contribute to, maintain, or take responsibility for this script.

To Enable Autocomplete for qgq CLI Command Aliases

1. Add a qq CLIcommand alias and the COMPAL AUTO UNMASK configuration parameter to
your shell profile ( .bashrc, .bash profile, and so on). For example:

98


https://github.com/cykerway/complete-alias/blob/master/complete_alias

#qq CLI Autocomplete

eval "$(register-python-argcomplete qq)"
COMPAL_AUTO_ UNMASK=1

source ~/.bash completion.d/complete alias

™ Tip
Don't reload your shell profile yet.

2. Create a directory for the complete-alias daemon and download the script to it.

mkdir ~/.bash completion.d

curl https://raw.githubusercontent.com/cykerway/complete-alias/master/complet
e alias \
> ~/.bash completion.d/complete alias

3. Addyour aliasto the complete alias file.

echo "complete -F complete alias qqcreds" >> ~/.bash completion.d/complete al
ias

4. Search for any conflicting complete entries.
complete | grep complete

If conflicting entries exist, remove them by specifying the entry name or path. For
example:

complete -r /my/path
5. Reload your shell profile.
source ~/.bashrc

You can now use the Tab key to autocomplete qq CLI command aliases.

99



Metadata

Managing User-Defined Metadata in Qumulo Core

This section explains how to create, retrieve, list, and delete user-defined metadata in Qumulo
Core by using the qq CLI.

How User-Defined Metadata Works in Qumulo Core

Qumulo Core lets you add user-defined metadata to any file type stored in its file system. User-
defined metadata comprises user-specified key-value pairs that have the following requirements:

- The key must be a Unicode string.
- The value must be a sequence of bytes.

- The total size of each key-value pair must be under 400 KB.

Keyspace Types and Functions

User-defined metadata in Qumulo Core is divided into GENERIC and S3 keyspaces. Keyspaces
work like containers for key-value pairs. The S3 keyspace primarily supports the S3 API, which
requires all files to have two sets of metadata in separate keyspaces.

Keyspaces can hold approximately 17 trillion key-value pairs and have the following requirements:

- All keys within a keyspace must be unique.

- The keyspace and key are required to create or access a user-defined metadata entry.

Managing User-Defined Metadata by Using the qqg CLI

This section explains how to create, retrieve, list, and delete user-defined metadata by using the
qq CLL

O Note

- All gq CLI commands default to using the GENERICkeyspace (page 100). For the S3
keyspace, use the --s3 flag.

In the following examples, you can specify the file path by using the - -path flag or the
file ID by using the --id flag.

Prerequisites

Managing user-defined metadata requires the following privileges:
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READ EA : Read the user-defined metadata from a file

WRITE EA :Write to, or delete, the user-defined metadata of a file
To Create a Generic User-Defined Metadata Entry for a File by Using the qq CLI

Run the fs set user metadata command and specify the path to the file, the key, and the value.
For example:

gqq fs set user metadata \
--path my-file \
--key my-key \
--value my-value

To specify a non-text value for the user-defined metadata, use the --base64-value or --hex-
value flag.

For more information, see qq fs set user metadata in the Qumulo gqq CLI Command Guide.
To Retrieve a Generic User-Defined Metadata Entry for a File by Using the qq CLI

Use fs get user metadata command and specify the path to the file and the key. For example:

qq fs get user metadata \
--path my-file \
--key my-key

- To specify a non-text value for the user-defined metadata, use the --base64-value or --
hex-value flag.

- To access the user-defined metadata within a file snapshot, use the --snapshot flag and
specify the shapshot ID.

For more information, see qq fs get user metadata in the Qumulo gq CLI Command Guide.
To List All Generic User-Defined Metadata Entries for a File by Using the qqg CLI

Runthe fs list user metadata command and specify the path to the file. For example:

qq fs list user metadata \
--path my-file

- To specify a non-text value for the user-defined metadata, use the --base64-value or --
hex-value flag.

- To access the user-defined metadata within a file snapshot, use the --snapshot flag and
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specify the shapshot ID.
For more information, see qq fs list user metadata in the Qumulo qq CLI Command Guide.
To Delete a Generic User-Defined Metadata Entry for a File by Using the qq CLI

Run the fs delete user metadata command and specify the path to the file and the key. For
example:

qq fs delete user metadata \
--path my-file \
--key my-key

For more information, see qq fs delete user metadata in the Qumulo qgq CLI Commmand Guide.

Managing User-Defined Metadata by Using the S3 API
S3 categorizes metadata as:
Metadata
o Immutable metadata that remains for the life of the object.
o Qumulo Core maps metadata to the S3 keyspace (page 100).
- Tags

o Mutable metadata that doesn’t impact the object’s entity tag.

A Important
Tag values that can't be encoded by using UTF-8 aren't visible to S3.

° Qumulo Core maps tags to the GENERIC keyspace (page 100).

In Qumulo Core 6.3.2 (and higher) the Qumulo S3 API (page O) supports user-defined metadata
fully. For more information about how to access metadata by using the S3 API, see the Amazon
Simple Storage Service API Reference.
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Snapshots

How Snapshots Work in Qumulo Core

This section explains snapshots, their storage usage, and their locking functionality in Qumulo
Core.

How Snapshots Work

Qumulo Core 2.5.0 (and higher) can take instant snapshots of the file system. A snapshotis an
entry for every version of file system elements such as files, directories, creation and modification
timestamps, permissions, and so on. Each new entry points only to changed data and, to allow
original and new entries to share data, Qumulo Core writes the entries alongside each other.

Taking a snapshot doesn’t consume storage or incur a performance penalty. There is only a
negligible performance penalty for reading and writing snapshotted file system data.

How Snapshots Grow Over Time

The following example shows how Qumulo Core allocates storage to data and links it to file
metadata as file system data changes.

In this scenario:
1. A user creates a file with 4 MB of data.
2. Qumulo Core takes a snapshot of the file.
3. Auser modifies 1 MB of data within the file.

4. Qumulo Core allocates a new 1 MB region to the modified data.

oMB 4 MB
Pre-Snapshot
Post-Snapshot 1 MB of New Data

o MB 4 MB
Snapshot Version

o MB 4 MB
Live Version
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Now, the following is true:
5 MB: The total storage that the file occupies
o 3 MB: Data shared between the original and new versions of the file
o 1MB: Original data that exists only in the saved (snapshotted) version of the file
o 1MB: New data that exists only in the live (latest) version of the file
Next, the following conditions take effect:

If the user rewrites that particular 1 MB of data, the system overwrites the existing live data
without allocating new space.

If the user rewrites a different region of the file, Qumulo Core allocates additional storage.

Determining Snapshots’' Storage Usage

When Qumulo Core tracks the difference between the saved (snapshotted) and live (latest)
versions of a file, it creates a lineage of snapshots independent from each other. To determine the
amount of data that a single snapshot references, run the qq

snapshot get capacity used per snapshot command and specify the snapshot ID. For example:

ggq snapshot get capacity used per snapshot \
--1id 1682119059

More than one snapshot can reference covered data. It isn't possible to release covered data until
you delete all covering snapshots that reference it.

- To determine the total covered data, including data no longer present in the snapshot, run
the qq snapshot get capacity used per snapshot command and specify multiple,
comma-separated snapshot IDs.

- To determine the total amount of data, including covered data that multiple snapshots
reference, run the qq snapshot get total used capacity command.

When you delete a snapshot, Qumulo Core removes the data which that snapshot references but
retains the data which any other snapshot references. This ensures a full file representation within
the remaining snapshots. Qumulo Core uses a background process to recover the storage that
the snapshot had consumed.

O Note
When you delete a snapshot, the background process might take some time. To track the
reclaimed storage, run the qq snapshot get total used capacity command.
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Example: Tracking Covering Snapshots and Data Changes

For example, if you run the qq snapshot get total used capacity command, Qumulo Core shows
that storage usage is 1,319,413,953,331 Bytes (1.2 TiB). This amount includes the total snapshot data
and the covering snapshots.

If you add up the usage for all snapshots currently in the file system (by using the qq

snapshot get capacity used per snapshot command), Qumulo Core shows that total snapshot
storage usage is 2,147,483,648 Bytes (2 GiB). This amount includes the data changes that each
snapshot stores but doesn't include the unchanged file portions within each snapshot.

Example: Tracking File Snapshot Changes Over Time
For example, you have a 1TiB file that you modify over time.
- Snapshot 1: This snapshot is 1,099,511,627,776 Bytes in size and contains the full 1 TiB file.
- Snapshot 2: This snapshot is 1,073,741,824 Bytes in size and contains 1 GiB of data changes.

- Snapshot 3: This snapshot is 1,073,741,824 Bytes in size and contains an additional 1 GiB of
data changes.

If you delete snapshot 1, only 1,023 GiB of data (covered by snapshots 2 and 3) remain. Qumulo
Core doesn't release this 1,023 GiB of data until you delete all snapshots that reference the original

file.

O Note
Without the data that snapshots 2 and 3 cover, no full file representation is possible.
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Managing Snapshots in Qumulo Core

This section explains how to create on-demand snapshots and snapshot policies, view and search
for existing snapshots, and delete snapshots by using the Qumulo Core Web Ul. It also explains
how to create snapshots on a schedule, create a snapshot with an expiration time, and modify a

snapshot's expiration time.

Managing Snapshots by Using the Qumulo Core Web Ul

This section explains how to create on-demand snapshots and snapshot policies, view and search

for existing snapshots, and delete snapshots by using the Qumulo Core Web Ul.

To Create an On-Demand Snapshot

1. Login to the Qumulo Core Web Ul.

2. Click Cluster > Saved Snapshots.

3. On the Saved Snapshots page, in the upper right, click Take Snapshot.

4. In the On Demand Snapshot dialog box, do the following.

a.
b.

C.

d.

Enter the Snapshot Name.
For Apply to Directory, enter the directory to snapshot.

For Delete Snapshot, specify whether Qumulo Core should never delete the
snapshot or delete it after a specified time period.

Click Save.

To Create a Snapshot Policy

1. Log in to the Qumulo Core Web Ul.

2. Click Cluster > Policy.

3. On the Snapshot Policies page, in the upper right, click Create Policy.

4. On the Create Snapshot Policy page:

a.

b.

C.

Enter the Policy Name.
For Apply to Directory, enter the directory to snapshot.

In the Run Policy on the Following Schedule section, specify the snapshot
frequency and when to delete snapshots.

Click Enable policy upon creation.

Click Create Policy.
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To View Existing Snapshots

The Snapshots page lets you navigate a large number of snapshots.
1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > Saved Snapshots.

3. In Qumulo Core version 4.3.3 (and higher), if you have more than 50 snapshots, use

to navigate the snapshot pages.

You can also use the controls at the bottom of the table to navigate to a specific page or
change the number of rows for each page.

To Find a Specific Snapshot

In Qumulo Core version 4.3.3 (and higher), you can search for a specific snapshot by name,
creation time, and so on.

1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > Saved Snapshots.
3. At the top of the table, click enable filters.
The Search... field appears.
4. Enter a search query.
The table rows match your query as you type.
5. (Optional) To turn off filtering, click disable filters.

To Delete a Single Snapshot
1. Log in to the Qumulo Core Web Ul.

2. Click Cluster > Saved Snapshots.
3. On the right side of a snapshot's row, click m )

To Delete Multiple Snapshots

In Qumulo Core version 4.3.3 (and higher), you can delete multiple snapshots at once.
1. Login to the Qumulo Core Web Ul.
2. Click Cluster > Saved Snapshots.
3. Onthe left side of the table, select every snapshot to delete.
When you select more than one row, the Bulk Delete button appears.

4. When you finish selecting snapshots, click Bulk Delete.
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O Note
Because all selection and deletion controls operate only on the current page, it isn't possible
to delete a snapshot accidentally if it isn't listed on the current page.

Managing Snapshots by Using the qqg CLI

This section explains how to create snapshots on a schedule, create a snapshot with an expiration
time, and modify a snapshot’s expiration time by using the qq CLI.

A Important
Creating and modifying snapshot policies with an associated lock requires the SNAPSHOT LOCK
permission in addition to policy permissions.

Creating Snapshots on a Schedule by Using a Snapshot Policy

Run the qq snapshot create policy command to create a snapshot policy and specify the
interval at which Qumulo Core takes and deletes snapshots.

In the following example, we create a policy named every day that takes a snapshot every
midnight in the Pacific time zone and retains the snapshot for two days. Every new snapshot that
this policy creates is locked with a key named my-key-name . For more information, see Locking
and Unlocking Snapshots in Qumulo Core (page 111).

O Note
The timezone flag uses values from the tz database. If you don't specify a time zone, the
snapshot policy uses UTC time.

qq snapshot create policy daily \
--name every day \
--days-of-week all \
--at 00:00 \
--timezone America/Los Angeles \
--time-to-live 7days
--lock-key my-key-name
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In the following example, we change a previously created policy with ID 1 to a policy named
hourly that takes a snapshot every hour, but only during business hours (Monday to Friday, 8am
to 6pm in the Pacific time zone), and retains snapshots for two days. Every new snapshot that this
policy creates is unlocked (previously created snapshots remain locked). For more information,

see Locking and Unlocking Snapshots in Qumulo Core (page 111).

qq snapshot modify policy change to hourly or less \
-1 1\
--name hourly \
--period lhours \
--days-of-week MON,TUE,WED,THU, FRI \
--start-time 08:00 \
--end-time 18:00 \
--timezone America/Los Angeles \
--time-to-live 2days
--clear-lock-key

Creating an On-Demand Snapshot with an Expiration Time

Run the qgq snapshot create snapshot command to specify an expiration date or expiration time
before Qumulo Core deletes the snapshot.

O Note
If you don't specify an expiration date or expiration time before deletion, Qumulo Core never
deletes the snapshot.

In the following example, the snapshot expires on December 31, 2030, at midnight, in UTC time.

qq snapshot create snapshot \
--expiration 2030-12-31T00:00:00Z

In the following example, Qumulo Core deletes the snapshot in one year from the snapshot’s
creation time.

gq snapshot create snapshot \
--time-to-live 12months
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Modifying a Snapshot’s Expiration Time

Run the qq snapshot modify snapshot command and specify the snapshot ID from the Saved
Snapshots page in the Qumulo Core Web Ul (for example, for the
1234567 replication from prod snapshot, the IDis 1234567 ).

In the following example, the snapshot with ID 1234567 never expires.

gq snapshot modify snapshot \
-1 1234567
_e [ |
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Locking and Unlocking Snapshots in Qumulo Core

This section explains how to lock or unlock a snapshot by using a key located in the Qumulo file
system key store and the qq CLI. In addition, it explains how to lock policy-created snapshots for
local policies and for policies that are part of a replication target relationship.

For more information, see Managing Security Keys in the Qumulo File System Key Store (page
125).

Locking and Unlocking Snapshots

A Important
Unlocking a snapshot requires a cryptographic signature. Before you lock a snapshot,

make sure that you have access to your private keys and that you understand the
unlocking procedure.

It isn't possible to delete or shorten the expiration time of a locked snapshot.
However, you can extend the expiration time of a locked snapshot.

Qumulo Core removes both locked and unlocked snapshots at their expiration time

automatically.

In Qumulo Core 6.1.0.3 (and higher), you can lock a snapshot by using a key located in the Qumulo
file system key store (page 125). You can also ensure that a snapshot policy locks all new snapshots
with a particular key (page 108) by associating the key with the snapshot policy.

In Qumulo Core 6.1.1 (and higher), you can ensure that a replication target relationship locks all
new policy snapshots with a specific key (page 113) by associating the key with the replication

target.

To Lock a Snapshot by Using the qq CLI

Run the qq snapshot lock snapshot command and specify the snapshot ID and either the key ID
or key name. For example:

qq snapshot lock snapshot \
--id 1682119059 \
--lock-key my-key-name
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To Unlock a Snapshot by Using the qq CLI

Unlocking a snapshot requires proving that you can sign a challenge by using the same key that
locked the snapshot. You can do this by using either of the following methods.

If You Have Direct Access to the Private Key

O Note
To use this method, you must install the Python cryptographylibrary.

Run the qq snapshot unlock snapshot command and specify the snapshot ID and the path to the
private key file. For example:

qq snapshot unlock snapshot \
--1id 1682119059 \
--private-key-file /path/to-my-file.pem

If You Don't Have Direct Access to the Private Key

If you can use the private key only to sign data, take the following steps.

1. To receive the unlock challenge, run the qq snapshot get unlock challenge command
and specify the snapshot ID. For example:

gq snapshot get unlock challenge \
--id 1682119059

A Important
If you change a snapshot's expiration time while the snapshot is locked, Qumulo Core
changes the unlock challenge for the snapshot.

2. To generate a verification signature, use the response from the challenge with your
private key.

For more information about creating a verification signature by using a private key or key
mManagement service, see Signing a Security Challenge by Using an ECDSA Private Key
(page 122).

3. To unlock the snapshot, run the qq snapshot unlock snapshot command and specify the
snapshot ID and the Base64-encoded unlock challenge that your private key signed. For
example:
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gqq snapshot unlock snapshot \
--id 1682119059 \
--signature "VGhpcyBpcyBteSBlbmxvY2sgY2hhbGxlbmdlLg=="

Associating a Lock Key with a Replication Target Relationship

To lock all policy-created snapshots by using a lock key, you can associate the key with a
replication target relationship. Consider the following system behavior:

Qumulo Core locks only policy-created snapshots that have an expiration time.

If you reverse the relationship by switching the source and target, the new target can’'t use
the existing key and you must set a key for the new target. However, if you revert the
relationship by returning the source and target to their original assignments, Qumulo
Core lets you use the key from the original source-target relationship.

If a target replication relationship uses a key, you can't disable or delete the key, unless you
reverse the relationship.

If you disable or delete a key while a target replication relationship is reversed and then
return the source and target to their original assignments, you must set a new key to be
able to lock future snapshots.

To Associate a Lock Key with a Replication Target Relationship

Run the qq replication set target relationship lock command and specify the relationship ID
and key name or ID. For example:

qq replication set target relationship lock \
--relationship-id 12345a6b-7c89-0d12-3456-78fe9012f345
--lock-key my-key-name

To Disassociate a Lock Key from a Replication Target Relationship

Run the qq replication set target relationship lock command and specify the relationship ID
and and --clear-lock-key flag. For example:

qq replication set target relationship lock \
--relationship-id 12345a6b-7c89-0d12-3456-78fe9012f345
--clear-lock-key
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Recovering Files by Using Snapshots
This section explains how to use snapshots to recover files.

In Qumulo Core 2.5.0 (and higher), you can recover files by accessing the hidden .snapshot
directory over SMB or NFS.

Inside the .snapshot directory, directories with snapshot IDs represent various snapshots. The
modified timestamp of a directory is the time at which Qumulo Core took the snapshot.
O Note

- When you use NFS on Linux and macOS (even if you configure your system to show
hidden files), the .snapshot directory doesn't appear when you list a directory's
contents. You must navigate to the .snapshot directory explicitly.

- When you use SMB, the .snapshot directory appears only at the root of the share in

Finder or File Explorer. In other directories, you must navigate to the .snapshot
directory explicitly.

To Recover Files on Linux or macOS by Using the Command Line

1. Navigate to the .snapshot directory. For example:

cd /Volumes/MyShareName/.snapshot

2. Locate the file or directory to recover and copy it to a new location.
™ Tip

To see the .snapshot directory at the root of the share, show hidden files by pressing 8 + Shift
+ .

To Recover Files on macOS by Using Finder

1. On the Finder menu, click Go > Go to Folder....

2. In the dialog box, enter the path to the .snapshot directory. For example:

/Volumes/MyShareName/.snapshot
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O Note
You must specify the .snapshot directory from the root of the share.

3. Locate the file or directory to recover and copy it to a new location.

To Recover Files on Windows by Using File Explorer

1. On Windows 7 (and higher), configure Windows Explorer (or File Explorer) as follows:

a. Disable Hide protected operating system files.
b. Enable Show hidden files, folders, and drives.
2. Navigate to the .snapshot directory.

3. Locate the file or directory to recover and copy it to a new location.
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Encryption and Data Security

Managing SMB3 Encryption in Transit in Qumulo Core

This section explains how to manage SMB3 encryption for individual shares or entire clusters in
Qumulo Core 2.14 (and higher).

To confirm the settings for your cluster from the Qumulo Core Web Ul, click Sharing > SMB Shares
> SMB Settings. By default, Qumulo Core supports AES-128-GCM and AES-128-CCM encryption,
sets cluster-level SMB encryption to None and share-level encryption to Unencrypted.

For all clusters created by using Qumulo Core 3.1.5 (and higher), Qumulo Core enables at-rest

encryption automatically (page O).

O Note

- Clients that connect to your cluster can send encrypted or unencrypted packets
when your cluster doesn't require encryption.

It isn't necessary to use signing as a share-level protection mechanism if you set
Require Encryption for a specific SMB share or if you configure cluster-level SMB

encryption.

How Cluster-Level and Share-Level Encryption Settings Interact in Qumulo
Core

The following table explains the possible levels of encryption of clusters and shares and the
relationships between them.

Cluster Encryption Level Unencrypted Share Encrypted Share

No Encryption Clients can send unencrypted

- Clients must send encrypt-
or encrypted packets VB

ed packets

Unencrypted clients are
disconnected

Prefer Encryption Client can send unencrypted

- Clients must send encrypt-
or encrypted packets. yP

ed packets

Unencrypted clients are
disconnected
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Cluster Encryption Level Unencrypted Share Encrypted Share

Require Encryption

- Clients must send encrypt- - Clients must send encrypt-
ed packets ed packets
Unencrypted clients are - Unencrypted clients are
disconnected disconnected

Configuring Cluster-Level and Share-Level Encryption

This section explains how to configure cluster-level encryption in Qumulo Core by using the Web
Uland qq CLI and how to configure share-level encryption by using the qq CLI.

To Configure Cluster-Level Encryption by Using the Qumulo Core Web Ul
1. Log in to the Qumulo Core Web Ul.
2. Click Cluster > SMB Settings.
3. Onthe SMB Settings page, select an encryption level.
The Web Ul shows any unencrypted shares on your cluster.
4. Click Configure SMB.
To Configure Cluster-Level and Share-Level Encryption by Using the qq CLI

For information about configuring cluster-level and share-level encryption by using the qq CLI,
see the following sections in the Qumulo qgq CLI Command Guide.

- Cluster-Level Encryption: qq smb_modify settings

- Share-Level Encryption: qq smb mod share

Disabling SMB3 Negotiation to Improve Workload Performance

Clients that connect to your cluster can send encrypted or unencrypted packets when your
cluster doesn’'t require encryption. In certain scenarios, compared to unencrypted configurations,
while workflows triggered by pipelines can experience a slight performance degradation,
synchronized operations can experience a more significant drop in performance.

To avoid potential performance impact, you can prohibit Qumulo Core from advertising its
encryption capabilities by turning off SMB3 negotiation.

For more information, see qq smb _modify settings in the Qumulo qgq CLI Command Guide.

Checking Encryption of SMB3 Session

To check whether an SMB23 client session is encrypted, run the Get-SmbConnection PowerShell
command. For example:
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Get-SmbConnection | Select-Object -property *

The following is example output.

SmbInstance : Default
ContinuouslyAvailable : False
Credential : SILENCE\jcage
Dialect : 3.0

Encrypted : False

NumOpens : 2

Redirected : False
ServerName : qq

ShareName : Files

Signed : True

UserName : SILENCE\jcage
PSComputerName :

CimClass : ROOT/Microsoft/Windows/SMB:MSFT SmbConnection
CimInstanceProperties : {ContinuouslyAvailable, Credential, Dialect, Encrypted...}
CimSystemProperties : Microsoft.Management.Infrastructure.CimSystemProperties
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Generating and Storing ECDSA Keys on a Qumulo
Cluster

This section explains how to generate Elliptic Curve Digital Signature Algorithm (ECDSA) keys and
ECDSA verification signatures that are compatible with the Qumulo file system key store.

In Qumulo Core 6.1.0 (and higher), you can store multiple ECDSA public keys in the Qumulo file
system key store and use these keys to protect file system resources.

A Important

- Currently, Qumulo Core supports only 256-bit ECDSA keys in .pem and .der formats.
Qumulo Core doesn't support storing ECDSA keys of other lengths and formats.

No KMS system shows the private key. To sign messages later, write down the key ID
in the responses from key generation commands.

Generating an ECDSA Private Key

This section explains how to generate a 256-bit ECDSA private key by using Linux CLI tools and
AWS, GCP, and Azure CLI or API.

To Generate a Private Key by Using Linux CLI Tools

To generate a key in the .pem format, run the openssl or ssh-keygen tools.

Run the openssl tool and specify the path to the private key. For example:

openssl ecparam \
-genkey \
-name prime256v1 \
-out /private-key-path

Run the ssh-keygen tool and specify the path to the private key. For example:

ssh-keygen \
-f /private-key-path \
-t ecdsa \
-m PEM

The following is an example private key.
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EXAMPLEabCDe8fghi8328K1B8m0+n0o93NOpBqrs/TUvWXYza4BCODefghiJklmNO
PQRsSTUVWXyZAbcODEFGhIJ//////////////7////7////7////////7///7/7///KL
MNOPQRSTUVwWXYZA5bcD++ef7gHIjKIMOnopQRst82u30VWxY8oZaBcdETfEg62hi j
k8LmNoP7/Q4RSTu9V7WXyzABCDeFOG/7HIJ4K\WMN/////////////////////0pq
30rsTUV7w9XyzAB2CDEFGHI jKLMNOPQ7r7S7t/uVwxY1zaB09c23Sd1EF3G3hijk
L1mN1OPQRSTUve2+X06YZABcD/eFGhIJ/K15MNOPQrsTuEXAMPLE

----- END EC PRIVATE KEY-----

Generating a Key Pair by Using the AWS Key Management Service (KMS)

Use the AWS Management Console, AWS CLI, or AWS KMS API. For more information, see the
following resources:

- Console: Creating asymmetric KMS keys
- AWS CLI: create-key in the AWS CLI Command Reference.
- AWS KMS API: CreateKey in the AWS Key Management Service API| Reference
When you create a key pair, specify the following details:
Key Type: Asymmetric key
Usage: Sign and verify
Key Specification: ECC_NIST_P256

Generating a Key Pair by Using the GCP Cloud Key Management Service (Cloud KMS)

Use the GCP Cloud Console, Cloud CLI, or Cloud API. For more information, see Create a key in the
Cloud Key Management Service documentation.

When you create a key pair, specify the following details:
Protection Level: software or HSM
Purpose: Asymmetric sign
- Algorithm: Elliptic Curve P-256 - SHA256 Digest

Generating a Key Pair by Using the Azure Key Vault

Use the Azure Key Vault and the Azure CLI. For more information, see az keyvault key create in
the Azure documentation.

When you create a key pair, specify the following details:
Key Type: EC
- Curve: P-256

Key Size: 256
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Extracting the Public Key from an ECDSA Private Key

After you create a 256-bit ECDSA private key, you can extract a public key from it by using Linux
CLI tools and AWS, GCP, and Azure CLI and API. You can store the public key in the Qumulo file

system key store (page 125).
To Extract the Public Key by Using Linux CLI Tools

1. Runthe openssl tool and specify the path to the private key and the path for saving the
public key. For example:

openssl pkey \
-in /private-key-path \
-pubout > /public-key-path

2. Ifyour private key is in OpenSSH format, export the public key into the .pem format. Run
the ssh-keygen tool and specify the path to the private key and the path for saving the
public key. For example:

ssh-keygen \
-e \
-f /private-key-path \
-m PEM > /public-key-path

3. To convert your private key to .pem format, run the ssh-keygen tool and specify the path
to the private key. For example:

ssh-keygen \
-p\
-f /private-key-path \
-m pem

The following is an example public key in .pem format.

EXAMPLEabCDefOGHIJKL4MNOPgRStUV5wXyz491abcld2efGijKklmNOPOqrsTUv
WXYzalBCAETGHIjKkOlMnOpqr1STUVW3XYzAB6c8DefghIJKEXAMPLE==
----- END PUBLIC KEY-----
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Extracting the Public Key by Using the AWS Key Management Service (KMS)

Use the AWS Management Console, AWS CLI, or AWS KMS API. For more information, see the
following resources:

- Console: Displaying KMS key details
- AWS CLI: get-public-key
- AWS API: GetPublicKey

Extracting the Public Key by Using the GCP Cloud Key Management Service (Cloud KMS)

Use the GCP Cloud Console, Cloud CLI, or Cloud API. For more information, see Retrieve the public
key in the Cloud Key Management Service documentation.

Extracting the Public Key by Using the Azure Key Vault

Use the Azure Key Vault and the Azure CLI. For more information, see az keyvault key download
in the Azure documentation.

Signing a Security Challenge by Using an ECDSA Private Key

When you perform actions such as adding a new key to the Qumulo file system key store,
replacing an existing key in the key store, or unlocking a snapshot, you must verify that you have
access to the private key by signing a security challenge.

You can use your private key to generate a verification signature and then provide this signature
to Qumulo Core in Baseb4 encoding.

O Note
- When you add a new key, the key name is the security challenge.

- When you replace an existing key or unlock a snapshot, the qq CLI commmand
provides the challenge.

To Sign a Security Challenge by Using Linux CLI Tools

1. Save the security challenge to be signed to a file. For example:

echo -n "This is my challenge." > /tmp/challenge.out

0 Note
The -n flag ensures that there are no newline characters following the challenge.
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2. Tosign the challenge, run the openssl tool and specify the path to the private key. For
example:

openssl dgst \
-sha256 \
_r\
-sign /path-to-private-key \
-out /tmp/signature.sha256 /tmp/challenge.out

3. To encode the signature in Baseb4 format, run the openssl tool. For example:

openssl base64 \
-in /tmp/signature.sha256 \
-out /tmp/key signature.b64

To Sign a Security Challenge by Using the AWS Key Management Service (KMS)

1. Sign a security challenge by using the AWS CLI or AWS KMS API. For more information,
see the following resources:

- AWS CLI: sign in the AWS CLI Command Reference
- AWS KMS API: Sign in the AWS Key Management Service AP| Reference
2. Specify the ECDSA SHA 256 algorithm.
The response returns a Base64-encoded verification signature.

To Sign a Security Challenge by Using the GCP Cloud Key Management Service (Cloud
CMS)

1. Sign a security challenge by using the GCP Cloud Console, Cloud CLI, or Cloud API. For
more information, see Creating a signature in the Cloud Key Management Service
documentation.

2. Specify the SHA256 digest algorithm.

3. Ifthe signature in the response is comprised of raw bytes (not a Base64-encoded string)
encode the signature file by using the base64 CLI tool on the signature file that the Cloud
CLI generates. For example:

base64 /gcp-output-path/signature.bytes
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To Sign a Security Challenge by Using the Azure Key Vault

A Important

The Azure API requires a security challenge as a UrlBasec4-encoded SHA-256 digest.

1. Sign a security challenge by using the Azure Key Vault and the
information, see sign in the Azure documentation.

Azure API. For more

2. Convert your plaintext challenge into the correct format. For example:

echo -n "This is my challenge." \
| sha256sum \
| cut -d' ' -f1 \
| xxd -r -p \
| baseb4d \
| tr '/+" ' -

3. Use the re-encoded challenge to call the Azure APL.
4, Specify ES256 as the algorithm.
The signature in the response is encoded in UrlBase64 format.

5. Encode the signature in Base64 format. For example:

echo $(echo -n VGhpcyBpcyBteSBzaWduYXRlcmUu | tr ' -

4+ ) ==
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Managing Security Keys in the Qumulo File System Key
Store

This section explains how to manage security keys in the Qumulo file system key store by using
the qq CLL

In Qumulo Core 6.1.0 (and higher), you can store multiple ECDSA public keys in the Qumulo file
system key store and use these keys to protect file system resources.

A Important

- Currently, Qumulo Core supports only 256-bit ECDSA keys in .pem and .der formats.
Qumulo Core doesn't support storing ECDSA keys of other lengths and formats.

- Qumulo Core retains only the public key. We strongly recommend storing the
corresponding private key safely, outside of your Qumulo cluster and according to
your organization's security policy.

For information about protecting your snapshots by using a key from the Qumulo file system key
store, see Locking and Unlocking Snapshots (page 111).

Adding a Public Key

This section explains how to add a public key to the Qumulo file system key store. To store a
public key in the key store, you must have a pair of asymmetric keys. For more information, see
Generating an ECDSA Private Key (page 119).

If You Have Access to the Private Key

O Note
To use this method, you must install the Python cryptographylibrary.

Run the qq fs security add key command and specify the key name, the path to the private key
file, and an optional comment. For example:

qq fs security add key \
--name my-key-name \
--private-key-file /path/to-my-file.pem \
--comment "This is an optional comment."
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If You Don't Have Direct Access to the Private Key

Run the qq fs security add key command and specify the key name, the public key contents,
the Baseb4-encoded verification signature (the key name signed with the private key), and an
optional comment. For example:

qq fs security add key \
--name my-key-name \
--public-key "VGhpcyBpcyBteSBwdWJsaWMga2V5IGNvbnRlbnRzLg==" \
--verification-signature "VGhpcyBpcyBteSBlbmxvY2sgY2hhbGxlbmdlLg==" \
--comment "This is an optional comment."

For more information, see Extracting the Public Key from an ECDSA Private Key (page 121) and
Signing a Security Challenge by Using an ECDSA Private Key (page 122).

Retrieving Public Key Information

- To retrieve information for a single public key, run the qq fs security get key command
and specify the key identifier or name.

- To retrieve information for all public keys, run the qq fs security list keys command.

The output displays information in a table format. To view the output in JSON format, use
the --json flag.

Retrieving Public Key Usage Information

Run the qq fs security get key usage command and specify the key identifier or name.

The output displays information in a table format. To view the output in JISON format, use the --
json flag.

Modifying a Public Key

To modify the name or comment for a public key, run the qq fs security modify key command
and specify the key identifier or name and the flags for the fields to modify.

O Note
The response of the qq fs_security add key command includes the key identifier. When you

use qq fs security commands, you can specify either the key identifier (by using the --id
flag) or the key name (by using the - -name flag).
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Rotating a Public Key

This section explains how to rotate a public key in the Qumulo file system key store.

O Note

Key rotation doesn't affect the resources that the key protects or change the
identifier or name of the public key.

- When the key rotation is complete, only the replacement public key can unlock the
protected resources.

- The response of the qq fs security add key commmand includes the key identifier.
When you use qq fs _security commands, you can specify either the key identifier
(by using the --id flag) or the key name (by using the - -name flag).

If You Have Access to the Existing and Replacement Private Keys

O Note
To use this method, you must install the Python cryptographylibrary.

Run the qq fs security replace key command and specify the key identifier or name, the path
to the existing private key, and the path to the replacement private key. For example:

qq fs security replace key \
--name my-key-name \
--old-private-key-file /path/to-existing-key.pem \
--replacement-private-key-file /path/to-replacement-key.pem

If You Don't Have Direct Access to the Existing and Replacement Private Keys

1. To receive the key replacement challenge, run the qq
fs security get key replace challenge command and specify the identifier or name of
the key to replace.

2. To generate a verification signature, use the response from the challenge with the
existing private key and another verification signature by using the challenge and the
replacement private key.

For more information, see Signing a Security Challenge by Using an ECDSA Private Key
(page 122).
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3. Torotate the key, run the qq fs security replace key command and specify the key
identifier or name, the replacement public key contents, the replacement key verification
signature (Baseb4-encoded key replacement challenge signed with the replacement

private key), and the existing key verification signature (Basec4-encoded key replacement
challenge signed with the existing private key). For example:

qq fs security replace key \
--name my-key-name \

--replacement-public-key "VGhpcyBpcyBteSByZXBsYWNTlbWVudCBwdWJsaWMga2V5Lg=="
\

--replacement-key-verification-signature "UmVwbGFjZW1lbnQga2V5IHZlcmlmaWNhdG
lvbiBzaWduYXR1lcmU=" \

--old-key-verification-signature "RXhpc3Rpbmcga2V5IHZlcmlmaWNhdGlvbiBzaWduYX
R1lcmu="

For more information, see Extracting the Public Key from an ECDSA Private Key (page 121).

© Note

Because the key version is part of the challenge message, and this version changes
when a user writes or modifies the key, any change to the key name or comment
after you receive the challenge message makes the message stale.

Disabling a Public Key
When you add a key to the Qumulo file system key store, Qumulo Core enables it automatically.

- To disable a key, run the qq fs security modify key command and specify the key
identifier or name and the --disable flag.

- Tore-enable a key, use the --enable flag.
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O Note

It isn't possible to lock a Qumulo file system resource with a disabled key. However,
you can still unlock resources that this key locked previously.

It isn't possible to disable a key that Qumulo Core uses to create new resources. For
example, you can't disable a key associated with a snapshot policy when the
snapshot policy creates new snapshots by using the key. In this scenario, you must
disassociate the key from the snapshot policy before you can disable it. For more
information, see Retrieving Public Key Usage Information (page 126).

- The response of the qq fs security add key commmand includes the key identifier.
When you use qq fs security commands, you can specify either the key identifier
(by using the --id flag) or the key name (by using the - -name flag).

Deleting a Public Key

Run the qq fs security delete key command and specify the key identifier or name.

O Note

It isn't possible to delete a key that a Qumulo file system resource uses. For more
information, see Retrieving Public Key Usage Information (page 126).

- The response of the qq fs security add key commmand includes the key identifier.
When you use qq fs_security commands, you can specify either the key identifier
(by using the --id flag) or the key name (by using the --name flag).
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Installing a Sighed SSL Certificate on a Qumulo Cluster
This section explains how to install a signed SSL certificate from your certificate authority (CA) on
your Qumulo cluster.
Requirements

An SSL certificate based on your certificate signing request (CSR) file from your certificate

authority (CA)
- A CA-bundle PEM chain in the following order:

° Your certificate
o The intermediate CA

o The root CA

To Install a Signed SSL Certificate on a Qumulo Cluster from the Command
Line

1. Verify that your certificate and the CA-bundle are in the PEM format by running the file

* command.

The following is example output.

certbundle.pem: PEM certificate
private.key: PEM RSA private key

2. (Optional) If your file isn't an RSA key, run the openssl rsa command to convert your key.

For example:

openssl rsa \
-in original.key \
-out private.key

3. Runthe qq login command to log in to your Qumulo cluster as an administrator. For

example:

gq login \
-u admin \
--host 203.0.113.0
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Run the qq ssl modify certificate command to install your certificate. For example:

qq ssl modify certificate \
--host 203.0.113.0 \
-c certbundle.pem \
-k private.key.insecure

To Import a Certificate Authority (CA) Certificate on macOS

1.

2.

Press 8 + Space, enter Keychain Access, and press Enter.

When prompted, click Open Keychain Access.

In the Keychain Access window, on the left panel, under Default Keychains, click login.
On the right, click Certificates.

Copy your CA certificate file to the list of certificates.

Right-click your certificate and then click Get Info.

On the window with the certificate information, expand the Trust section and When using
this certificate: select Always Trust.

O Note
To ensure your certificate is installed correctly, restart your browser.
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Data Replication

Creating and Managing a Continuous Replication
Relationship in Qumulo Core

This section explains how to create, authorize, modify, and delete a replication relationship by
using the Qumulo Core Web UL.

How Continuous Replication Works

A Important
Qumulo Core supports replication between different versions only if either the source or

target cluster is running Qumulo Core 2.12.0 (or higher). For more information, see
Replication Version Requirements (page 23)

Continuous replication takes a snapshot of the data in a directory on the source cluster and
transfers it to a directory on the target cluster. While continuous replication runs, Qumulo Core
scans modified files for any changed regions and transfer only these changes to the target
cluster.

Continuous replication uses snapshots to generate a consistent point-in-time copy of the source
directory on the target cluster. To ensure that a directory contains only the most recent snapshot,
Qumulo Core deletes previous snapshots automatically. Administrators can view the snapshots
used for replication and any other policy-based snapshots.

Prerequisites

The following privileges are required for continuous replication.

O Note

We don't recommend granting the following privileges to specific users because they
grant administrative access to your cluster.

- The following privileges grant user access to Qumulo Core functionality beyond
replication relationship management:

o PRIVILEGE REPLICATION SOURCE WRITE: Grants the permission to access any
data on a cluster, regardless of file or directory permissions

°© PRIVILEGE REPLICATION TARGET WRITE: Grants the permission to authorize
replication relationships to any target directory on a cluster

Creating a replication relationship
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o SOURCE WRITE : For the user on the source cluster to initiate the creation of the
relationship

o TARGET WRITE : For the user on the target cluster to authorize the relationship
- Viewing the replication relationship status
o PRIVILEGE REPLICATION SOURCE READ

o PRIVILEGE REPLICATION TARGET READ

To Create a Replication Relationship

A Important
A replication job doesn’t begin until you authorize the relationship on the target cluster.

1. Log in to the Qumulo Core Web Ul on the source cluster.

2. Click Cluster > Replication.

3. On the right side of the Replication Relationships page, click Create Relationship.
4. On the Create Replication Relationship page:

a. For Source Directory Path, enter the existing directory from which to replicate
data.

b. For Target Directory Path, enter the existing directory to which to replicate data.

c. For Target Address, enter one of the IP addresses from a node on the target

cluster.

™ Tip
We recommend using a floating IP address.

d. For Port Number, click Default (3712) or enter a custom port.

O Note
Your organization'’s firewall might require a custom port.

5. Click Add Blackout Window and then select the days of the week and time when
replication suspends.

6. (Optional) To add another blackout window, click Add Blackout Window.
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O Note
You can add up to ten blackout windows. For more information, see Replication:
Blackout Windows on Qumulo Care.

7. To replicate files by using locally-owned NFS IDs, under Map Local User/Group IDs to
Associated NFS IDs, click Enabled.

For more information, see Replication: NFS ID Mapping on Qumulo Care.
8. Under Enable Replication, click Enabled.

9. Click Save Relationship.

To Authorize a Replication Relationship

O Note

If your cluster is currently in a blackout window or if continuous replication for the replication
relationship is disabled, replication doesn’'t begin. For more information, see Replication:
Blackout Windows on Qumulo Care.

1. Log in to the Qumulo Core Web Ul on the target cluster.
A notification banner informing you of a new relationship authorization request appears.
2. On the banner, click See details.

3. On the Replication Relationships page, click Accept.

To View the Status of a Replication Relationship

1. Log in to the Qumulo Core Web Ul on the source cluster.
2. Click Cluster > Replication.

The Replication Relationships page shows a list of source and target clusters. The
following table explains the icons that appear between the Source and Target columns.

Icon | Description

>?

The replication is running or is ready to run.

The replication is awaiting authorization from the target cluster's administrator.
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The replication relationship is disconnected and the target directory is writable.

The replication relationship is in a blackout window.

Continuous replication is disabled.

The target directory is reverting to the last recovery point before becoming

writable.

The replication job is incomplete and will retry soon.

A progress bar in the Status column indicates the replication process.

O Note

The replication process percentage considers the number of files to be replicated and
the amount of data to be transferred.

3. Toreview the throughput, run time, and data statistics for the replication job in progress,
click Details.

To Modify a Replication Relationship

O Note

It isn't possible to edit the source and target directory paths. To make these changes, you
must create a new replication relationship.

1. Login tothe Qumulo Core Web Ul.

2. Click Cluster > Replication.

3. On the Replication Relationships page, next to the relationship to modify, click ﬂ > Edit
Relationship...

4. Make changes to your replication relationship (for more information, see To Create a
Replication Relationship (page 133)) and then click Save Relationship.
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To Delete a Replication Relationship

1.

2.

Log in to the Qumulo Core Web Ul.

Click Cluster > Replication.

On the Replication Relationships page, next to the relationship to delete, click ﬂ > Delete
Relationship...

In the Delete relationship dialog box, review the source and target clusters and then click
Yes, Delete.

Known Continuous Replication Limitations in Qumulo Core

Continuous Replication: Depending on applications in use while a replication job runs,
continuous replication increases the load on the cluster and can cause latency delays.

Local Users and Groups: Continuous replication doesn't support replicating local user or

group information and fails when it encounters a file associated with local users or groups.

- Target Directory Permissions When you create a replication relationship, Qumulo Core

updates these permissions from read-write to read-only. When you delete the
relationship, the permissions revert to read-write automatically.
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Using Qumulo Shift-To to Copy Objects to Amazon S3

This section explains how to use Shift-To to copy objects from a directory in a Qumulo cluster to a
folder in an Amazon Simple Storage Service (Amazon S3) bucket and how to manage Shift
relationships.

For more information about copying objects from S3 to Qumulo, see Using Qumulo Shift-From
for Amazon S3 to Copy Objects (page 0).

Prerequisites

- A Qumulo cluster with:

o Qumulo Core 3.2.1 (and higher) for the CLI and 3.2.5 (and higher) for the Qumulo
Core Web Ul

o HTTPS connectivity to s3.<region>.amazonaws.com though one of the following
means:

m Public Internet
m VPC endpoint
m AWS Direct Connect
For more information, see AWS IP address ranges in the AWS General Reference.
Membership in a Qumulo role with the following privileges:

o PRIVILEGE REPLICATION OBJECT WRITE : This privilege is required to create a Shift
relationship.

° PRIVILEGE REPLICATION OBJECT READ :This privilege is required to view the status
of a Shift relationship.

O Note

o For any changes to take effect, user accounts with newly assigned roles must
log out and log back in (or their sessions must time out).

o Use special care when granting privileges to roles and users because certain
privileges (such as replication-write privileges) can use system privileges to
overwrite or move data to a location where a user has greater permissions.
This can give a user access to all directories and files in a cluster regardless of
any specific file and directory settings.

- An existing bucket with contents in Amazon S3
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- AWS credentials (access key ID and secret access key) with the following permissions:
o s3:AbortMultipartUpload
o s3:GetObject
o s3:PutObject
o s3:PutObjectTagging
o s3:ListBucket

For more information, see Understanding and getting your AWS credentials in the AWS
General Reference

Example IAM Policy

In the following example, the IAM policy gives permission to read from and write to the my-
folder folder in the my-bucket . This policy can give users the permissions required to run Shift-To
jobs.

{
"Version": "2012-10-17",
"Statement": [
{

"Action": "s3:ListBucket",

"Effect": "Allow",

"Resource": "arn:aws:s3:::my-bucket"”

b
{

"Action": [
"s3:AbortMultipartUpload",
"s3:GetObject",

"s3:PutObject",
"s3:PutObjectTagging"

]

"Effect": "Allow",

"Resource": "arn:aws:s3:::my-bucket/my-folder/*"

}
]
}

How Shift-To Relationships Work

Qumulo Core performs the following steps when it creates a Shift-To relationship.

1. Verifies that the directory exists on the Qumulo cluster and that the specified S3 bucket
exists, is accessible by using the specified credentials, and contains downloadable objects.

2. Creates the Shift-To relationship.
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Starts a job by using one of the nodes in the Qumulo cluster.

O Note
If you perform multiple Shift operations, Qumulo Core uses multiple nodes.

. To ensure that the copy is point-in-time consistent, takes a temporary snapshot of the
directory (for example, named replication to bucket my bucket ).

Recursively traverses the directories and files in the snapshots and copies each object to a
corresponding object in S3.

Preserves the file paths in the local directory in the keys of replicated objects.

For example, the file /my-dir/my-project/file.text,where my-dir isthe directory on
your Qumulo cluster, is uploaded to S3 as the following object, where my-folder isthe
specified S3 folder.

https://my-bucket.s3.us-west-2.amazonaws.com/my-folder/my-project/file.txt

O Note

This process doesn’'t encode or transform your data in any way. Shift-To replicates only
the data in a regular file's primary stream, excluding alternate data streams and file
system metadata such as access control lists (ACLs). To avoid transferring data across
the public Internet, a server-side S3 copy operation also copies any hard links to files
in the replication local directory to S3 as full copies of objects, with identical contents
and metadata.

Checks whether a file is already replicated. If the object exists in the remote S3 bucket,
and neither the file nor the object are modified since the last successful replication, its
data isn't retransferred to S3.

O Note
Shift never deletes files in the remote S3 folder, even if the files are removed from the
local directory since the last replication.

Deletes the temporary snapshot.
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Storing and Reusing Relationships

The Shift-To relationship remains on the Qumulo cluster. You can monitor the completion status
of a job, start new jobs for a relationship after the initial job finishes, and delete the relationship
(when you no longer need the S3-folder-Qumulo-directory pair). To avoid reuploading objects that
a previous copy job uploaded, relationships take up approximately 100 bytes for each object. To
free this storage, you can delete relationships that you no longer need.

If you repeatedly copy from the same Qumulo directory, you can speed up the upload process
(and skip already uploaded files) by using the same relationship.

A new relationship for subsequent uploads doesn’t share any tracking information with previous
relationships associated with a directory and might recopy data that is already uploaded.

How Entities in the Qumulo File System are Represented in an S3 Bucket

This section explains which entity types Qumulo Core doesn'’t copy to an S3 bucket and how an S3
bucket represents the entities that Qumulo Core copies to an S3 bucket.

Entity Types that Qumulo Core Doesn't Copy

- Access control list (ACL)
- Alternate data stream

Directory

O Note
For objects created for files, the system preserves the directory structure in the object
key.

Hard link to a non-regular file

- SMB extended file attribute

- Symbolic link

- Timestamp (mtime, ctime, atime, btime)
UNIX device file

Entity Types that Qumulo Core Copies

Entity in the Qumulo File Representation in an Amazon S3 Bucket

System

Hard link to a regular file Copy of the S3 object

Generic user metadata S3 tags
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Entity in the Qumulo File Representation in an Amazon S3 Bucket

System

Hole in sparse files Zero

O Note
The system expands any holes.

Regular file S3 object

O Note
The object key is the file system path and the object value is
the metadata.

S3 Metadata Object metadata

Using the Qumulo Core Web Ul to Copy Files and Manage Relationships

This section describes how to use the Qumulo Core Web Ul 3.2.5 (and higher) to copy files from a
Qumulo cluster to Amazon S3, review Shift relationship details, stop a running copy job, repeat a
completed copy job, and delete a relationship.

To Copy Files to Amazon S3
1. Login to the Qumulo Core Web Ul.

2. Click Cluster > Copy to/from S3.
3. On the Copy to/from S3 page, click Create Copy.
4. On the Create Copy to/from S3 page, click Local = Remote and then enter the following:
a. The Directory Path on your cluster ( / by default)
b. The S3 Bucket Name
c. The Folder in your S3 bucket
d. The Region for your S3 bucket
e. Your AWS Region ( / by default)
f. Your AWS Access Key ID and Secret Access Key.
5. (Optional) For additional configuration, click Advanced S3 Server Settings.

6. Click Create Copy.
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7.

In the Create Copy to S3? dialog box, review the Shift relationship and then click Yes,

Create.

The copy job begins.

To View Configuration Details and Status of Shift Relationships

1.

2.

Log in to the Qumulo Core Web UL.

Click Cluster > Copy to/from S3.

The Copy to/from S3 page lists all existing Shift relationships.

To get more information about a specific Shift relationship, click i > View Details.

The Copy to/from S3 Details page displays the following information:

- Throughput: average

Run Time

Data: total, transferred, and unchanged

Files: total, transferred, and unchanged

To Stop a Copy Job in Progress

1.

2.

Log in to the Qumulo Core Web UL.
Click Cluster > Copy to/from S3.
To stop a copy job for a specific relationship, click i > Abort.

In the Abort copy from? dialog box, review the Shift relationship and then click Yes, Abort.

The copy job stops.

To Repeat a Completed Copy Job

1.

2.

Log in to the Qumulo Core Web UL.

Click Cluster > Copy to/from S3.

To stop a copy job for a specific relationship, click & > Copy Again.

In the Copy again? dialog box, review the Shift relationship and then click Yes, Copy Again.

The copy job repeats.

To Delete a Shift Relationship

1.

Log in to the Qumulo Core Web Ul.

2. Click Cluster > Copy to/from S3.

3. To stop a copy job for a specific relationship, click & > Delete.
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4. In the Delete copy from? dialog box, review the Shift relationship and then click Yes,
Delete.

The copy job is deleted.

Using the Qumulo CLI to Copy Files and Manage Relationships

This section describes how to use the Qumulo CLI 3.2.5 (and higher) to copy files from a Qumulo
cluster to Amazon S3, review Shift relationship details, stop a running copy job, repeat a
completed copy job, and delete a relationship.

Copying Files from Amazon S3

To copy files, run the qq replication create object relationship command and specify the
following:

Local directory path on Qumulo cluster
- Copy direction (copy-to)
- S3 object folder
- S3 bucket
- AWS region
- AWS access key ID
- AWS secret access key

The following example shows how to create a relationship between the directory /my-dir/ ona
Qumulo cluster and the S3 bucket my-bucket and folder /my-folder/ inthe us-west-2 AWS
region. The secret access key is associated with the access key ID.

qq replication create object relationship \
--source-directory-path /my-dir/ \
--direction COPY TO OBJECT \
--object-folder /my-folder/ \
--bucket my-bucket \
--region us-west-2 \
--access-key-id AKIAIOSFODNN7EXAMPLE \
--secret-access-key wlalrXUtnFEMI/K7MDENG/bPxRfiCYEXAMPLEKEY

The CLI returns the details of the relationship in JISON format, for example:
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"access key id": "ABC",

"bucket": "my-bucket",

"object store address": "s3.us-west-2.amazonaws.com",
"id": "1c23b4ed-5c67-8f90-1e23-a4f5f6ceff78",

"object folder": "my-folder/",

"port": 443,

"ca certificate": null,

"region": "us-west-2",

"source directory id": "3",

"direction": "COPY _TO OBJECT",

Viewing Configuration Details and Status of Shift Relationships

- To view configuration details for all Shift relationships, run the qq
replication list object relationships command.

- To view configuration details for a specific relationship, run the qq
replication get object relationship command followed by the --id and the Shift
relationship ID (GUID), for example:

qq replication get object relationship --id 1c23b4ed-5c67-8f90-1e23-a4f5f6cef
78

- To view the status of a specific relationship, run the qq
replication get object relationship status command followed by the --id and the
Shift relationship ID.

- To view the status of all relationships, run the qq
replication list object relationship statuses command.

The CLI returns the details of all relationships in JISON format, for example:
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"direction": "COPY TO OBJECT",
"access key id": "AKIAIOSFODNN7EXAMPLE",
"bucket": "my-bucket",
"object store address": "s3.us-west-2.amazonaws.com",
"id": "1c23b4ed-5c67-8f90-1e23-a4f5f6ceff78",
"object folder": "my-folder/",
"port": 443,
"ca certificate": null,
"region": "us-west-2",
"source directory id": "3",
"source directory path": "/my-dir/",
"state": "REPLICATION RUNNING",
"current job": {
"start time": "2020-04-06T17:56:29.659309904Z",
"estimated end time": "2020-04-06T21:54:33.2440955937",
"job progress": {
"bytes transferred": "178388608",
"bytes unchanged": "0",
"bytes remaining": "21660032",
"bytes total": "200048640",

"files transferred": "17",
"files unchanged": "0",
"files remaining": "4",

"files total": "21",
"percent complete": 89.0368314738253,
"throughput current": "12330689",
"throughput overall": "12330689"
}
I
"last job": null

}

The state field shows the REPLICATION RUNNING status and the current job field shows
the job's progress. When Qumulo Core copies files from S3, details for the most recently
completed job become available in the last job field, the state field changes to
REPLICATION NOT RUNNING, and the current job field revertsto null.

0 Note
If you already ran a job for a relationship, it is possible for both the current job and
last _job fields to be non-null while you run a new job.
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The bytes total and files total fields represent the total amount of data and number
of files to be transferred by a Shift job. The bytes remaining and files remaining fields
show the amount of data and number of files not yet transferred. The values of these four
fields don't stabilize until the work estimation for the job is complete.

The percent complete field displays the overall job progress and the estimated end time
field displays the time at which the job is estimated to be complete. The values of these
two fields are populated when the work estimation for the job is complete.

Stopping a Copy Job in Progress

To stop a copy job already in progress, run the qq replication abort object replication
command and use the --id flag to specify the Shift relationship ID.

Repeating a Completed Copy Job

To repeat a completed copy job, run the qq replication start object relationship command
and use the --id flag to specify the Shift relationship ID.

This command begins a new job for the existing relationship and downloads any content that
changed in the S3 bucket or on the Qumulo cluster since the time the previous job ran.

Deleting a Shift Relationship

After your copy job is complete, you can delete your Shift relationship. To do this, run the
replication delete object relationship command and use the --id flag to specify the Shift
relationship ID.

O Note
You can run this command only against a relationship that doesn’t have any active jobs
running.

This command removes the copy job's record, leaving locally stored objects unchanged. Any
storage that the relationship used to track downloaded objects becomes available when you
delete the relationship.

Troubleshooting Copy Job Issues

Any fatal errors that occur during a copy job cause the job to fail, leaving a partially copied set of
files in the directory in your S3 bucket. However, to let you review the Shift relationship status any
failure messages, the Shift relationship continues to exist. You can start a new job to complete the
copying of objects to the S3 bucket—any successfully transferred files from the previous job aren’t
retransferred from your Qumulo cluster.

Whenever Qumulo Core doesn't complete an operation successfully and returns an error from
the APl or CLI, the error field within the last job field (that the

replication list object relationship statuses command returns) contains a detailed failure
message. For more troubleshooting details, see qumulo-replication.log on your Qumulo cluster.
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Best Practices for Shift-to-S3
We recommend the following best practices for working with Qumulo Shift-To for Amazon S3.

Bucket Lifecycle Policy: To abort any incomplete uploads older than several days and
ensure the automatic clean-up of any storage that incomplete parts of large objects (left
by failed or interrupted replication operations) use, configure a bucket lifecycle policy. For
more information, see Uploading and copying objects using multipart upload in the
Amazon Simple Storage Service User Guide.

- VPC Endpoints: For best performance when using a Qumulo cluster in AWS, configure a
VPC endpoint to S3. For on-premises Qumulo clusters, we recommend AWS Direct
Connect or another high-bandwidth, low-latency connection to S3.

Unique Artifacts: To avoid collisions between different data sets, specify a unique object
folder or unique bucket for each replication relationship from a Qumulo cluster to S3.

Object Versioning: To protect against unintended overwrites, enable object versioning. For
more information, see Using versioning in S3 buckets in the Amazon Simple Storage
Service User Guide.

- Completed Jobs: If you don't plan to use a Shift relationship to download updates from S3,
delete the relationship to free up any storage associated with it.

Concurrent Replication Relationships: To increase parallelism, especially across distinct
datasets, use concurrent replication relationships to S3. To avoid having a large number of
concurrent operations impact client 1/O to the Qumulo cluster, limit the number of
concurrent replication relationships. While there is no hard limit, we don't recommend
creating more than 100 concurrent replication relationships on a cluster (including both
Shift and Qumulo local replication relationships).

User Metadata Limits: Amazon S3's limits on object metadata (up to 2 kB across key bytes
and value bytes) and tagging (10 entries with a key size of 128 bytes and a value size of 256
bytes) are more restrictive than those of Qumulo Core. When a metadata entry exceeds
one of these limits, Qumulo Core omits the entry from a replication job. For more
information, see User Defined Object Metadata and Categorizing your storage using tags
in the Amazon Simple Storage Service User Guide.

Shift-to-S3 Restrictions

Object-Locked Buckets: You can't use buckets configured with S3 Object Lock and a
default retention period for Shift-To. If possible, either remove the default retention period
and set retention periods explicitly on objects uploaded outside of Shift or use a different
S3 bucket without S3 Object Lock enabled. For more information, see How S3 Object Lock
works in the Amazon Simple Storage Service User Guide.

File Size Limit: The size of an individual file can’t exceed 5 TiB (this is the maximum object
size that S3 supports). There is no limit on the total size of all your files.
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File Path Limit: The length of a file path must be shorter than 1,024 characters, including
the configured object folder prefix, excluding the local directory path.

Hard Links: Qumulo Core 3.2.3 (and higher) supports hard links, up to the maximum
object size that S3 supports.

Objects Under the Same Key: Unless an object contains Qumulo-specific hash metadata
that matches a file, any object that exists under the same key that a new relationship
replicates is overwritten. To retain older versions of overwritten objects, enable versioning
for your S3 bucket. For more information, see Using versioning in S3 buckets in the
Amazon Simple Storage Service User Guide.

- Object Checksums: All files replicated by using S3 server-side integrity verification (during
upload) use a SHA256 checksum stored in the replicated object's metadata.

S3-Compatible Object Stores: S3-compatible object stores aren’t supported. Currently,
Qumulo Shift-To supports replication only to Amazon S3.

HTTP: HTTP isn't supported. All Qumulo connections are encrypted by using HTTPS and
verify the S3 server’s SSL certificate.

- Anonymous Access: Anonymous access isn't supported. You must use valid AWS

credentials.

Replication without Throttling: Replication provides no throttling and might use all
available bandwidth. If necessary, use Quality of Service rules on your network.

- Amazon S3 Standard Storage Class: Qumulo Shift-To supports uploading only objects
stored in the Amazon S3 Standard storage class. You can't download objects stored in the
Amazon S3 Glacier or Deep Archive storage classes and any buckets that contain such
objects cause a copy job to fail.

Content-Type Metadata: Because all objects are stored in S3 using the default binary/
octet-stream content type, they might be interpreted as binary data if you download
them by using a browser. To attach content-type metadata to your objects, use the AWS
Console.
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Using Qumulo Shift-From to Copy Objects from Amazon
S3

This section explains how to use Shift-From to copy objects from a folder in an Amazon Simple
Storage Service (Amazon S3) bucket (cloud object store) to a directory in a Qumulo cluster and

how to manage Shift relationships.

For more information about copying objects from Qumulo to S3, see Using Qumulo Shift-To for
Amazon S3 to Copy Objects (page 0) on Qumulo Care.

O Note
From Qumulo Core 4.3.4, Shift-From estimates the work that a copy job performs.

Prerequisites
- A Qumulo cluster with:
o Qumulo Core 4.2.3 (or higher)

o HTTPS connectivity to s3.<region>.amazonaws.com though one of the following

means:
m Public Internet
m VPC endpoint
m AWS Direct Connect

For more information, see AWS |IP address ranges in the AWS General Reference.

Membership in a Qumulo role with the following privileges:

° PRIVILEGE REPLICATION OBJECT WRITE : This privilege is required to create a Shift
relationship.

o PRIVILEGE REPLICATION OBJECT READ:This privilege is required to view the status
of a Shift relationship.
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O Note

o For any changes to take effect, user accounts with newly assigned roles must
log out and log back in (or their sessions must time out).

o Use special care when granting privileges to roles and users because certain
privileges (such as replication-write privileges) can use system privileges to
overwrite or move data to a location where a user has greater permissions.
This can give a user access to all directories and files in a cluster regardless of
any specific file and directory settings.

- An existing bucket with contents in Amazon S3

- AWS credentials (access key ID and secret access key) with the following permissions:
o s3:GetObject
o s3:GetObjectTagging
o s3:ListBucket

For more information, see Understanding and getting your AWS credentials in the AWS
General Reference

Example IAM Policy

In the following example, the IAM policy gives permission to read from and write to the my-
folder folderin the my-bucket . This policy can give users the minimal set of permissions required
to run Shift-From jobs. (Shift-To jobs require a less-restrictive policy. For more information and an
example, see Using Qumulo Shift-To for Amazon S3 to Copy Objects (page 0).)
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{
"Version": "2012-10-17",

"Statement": [

{
"Action": "s3:ListBucket",
"Effect": "Allow",
"Resource": "arn:aws:s3:::my-bucket"
I
{
"Action": [
"s3:GetObject",
"s3:GetObjectTagging"
1,
"Effect": "Allow",
"Resource": "arn:aws:s3:::my-bucket/my-folder/*"
}

How Shift-From Relationships Work
Qumulo Core performs the following steps when it creates a Shift-From relationship.

1. Verifies that the directory exists on the Qumulo cluster and that the specified S3 bucket
exists, is accessible by using the specified credentials, and contains downloadable objects.

2. Creates the Shift-From relationship.

3. Starts a job by using one of the nodes in the Qumulo cluster.

O Note
If you perform multiple Shift operations, Qumulo Core uses multiple nodes.

4, Lists the contents of the S3 folder and downloads the objects to the specified directory on
your Qumulo cluster.

5. Forms the full path of the file on the Qumulo cluster by appending the path of the object
(relative to the S3 folder) to the directory path on the Qumulo cluster.

For example, the following object is downloaded to /my-dir/my-project/file.text, where
my-folder isthe specified S3 folder and my-dir is the directory on your Qumulo cluster.

https://my-bucket.s3.us-west-2.amazonaws.com/my-folder/my-project/file.txt
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O Note
This process doesn’'t encode or transform your data in any way. Shift-From attempts
only to map every S3 object in the specified folder to a file on your Qumulo cluster.

6. Avoids redownloading an unchanged object in a subsequent job by tracking the
information about an object and its replicated object.

0 Note
If you rename or move an object or local file between jobs, or if there are any
metadata changes in S3 or Qumulo, the object is replicated again.

Storing and Reusing Relationships

The Shift-From relationship remains on the Qumulo cluster. You can monitor the completion
status of a job, start new jobs for a relationship after the initial job finishes, and delete the
relationship (when you no longer need the S3-folder-Qumulo-directory pair). To avoid
redownloading objects that a previous copy job downloaded, relationships take up approximately
100 bytes for each object. To free this storage, you can delete relationships that you no longer
need.

If you repeatedly download from the same S3 folder, you can speed up the download process
(and skip already downloaded files) by using the same relationship.

A new relationship for subsequent downloads doesn’t share any tracking information with
previous relationships associated with a directory and might recopy data that is already
downloaded.

Using the Qumulo Core Web Ul to Copy Files and Manage Relationships

This section describes how to use the Qumulo Core Web Ul 4.2.5 (and higher) to copy files from
Amazon S3 to a Qumulo cluster, review Shift relationship details, stop a running copy job, repeat a
completed copy job, and delete a relationship.

To Copy Files from Amazon S3

1. Login to the Qumulo Core Web Ul.

2. Click Cluster > Copy to/from S3.

3. On the Copy to/from S3 page, click Create Copy.

4. On the Create Copy to/from S3 page, click Local & Remote and then enter the following:
a. The Directory Path on your cluster ( / by default)
b. The S3 Bucket Name

c. The Folder in your S3 bucket
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d. The Region for your S3 bucket

e. Your AWS Region ( / by default)

f. Your AWS Access Key ID and Secret Access Key.
5. (Optional) For additional configuration, click Advanced S3 Server Settings.
6. Click Create Copy.

7. In the Create Copy from S3? dialog box, review the Shift relationship and then click Yes,
Create.

The copy job begins and Qumulo Core estimates the work to be performed. When the
estimation is complete, the Qumulo Core Web Ul displays a progress bar with a
percentage for a relationship on the Replication Relationships page. The page also
displays the estimated total work, the remaining bytes and files, and the estimated time
to completion for a running copy job.

O Note

For work estimates, Shift-From jobs calculate the total number of files and bytes in a
job's bucket prefix. This requires the job to use the ListObjectV2S3 action once for
every 5000 objects (or 200 times for every 1 million objects).

To View Configuration Details and Status of Shift Relationships
1. Log in to the Qumulo Core Web Ul.

2. Click Cluster > Copy to/from S3.
The Copy to/from S3 page lists all existing Shift relationships.

3. To get more information about a specific Shift relationship, click i > View Details.
The Copy to/from S3 Details page displays the following information:

- Throughput: average

Run Time

Data: total, transferred, and unchanged

Files: total, transferred, and unchanged

To Stop a Copy Job in Progress
1. Login tothe Qumulo Core Web UI.

2. Click Cluster > Copy to/from S3.

3. To stop a copy job for a specific relationship, click § > Abort.

4. In the Abort copy from? dialog box, review the Shift relationship and then click Yes, Abort.
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The copy job stops.

To Repeat a Completed Copy Job

1.

2.

Log in to the Qumulo Core Web UL.
Click Cluster > Copy to/from S3.
To stop a copy job for a specific relationship, click & > Copy Again.

In the Copy again? dialog box, review the Shift relationship and then click Yes, Copy Again.

The copy job repeats.

To Delete a Shift Relationship

1.

2.

Log in to the Qumulo Core Web UL.
Click Cluster > Copy to/from S3.
To stop a copy job for a specific relationship, click i > Delete.

In the Delete copy from? dialog box, review the Shift relationship and then click Yes,

Delete.

The copy job is deleted.

Using the Qumulo CLI to Copy Files and Manage Relationships

This section describes how to use the Qumulo CLI to copy files from Amazon S3 to a Qumulo
cluster, review Shift relationship details, stop a running copy job, repeat a completed copy job, and

delete a relationship.

Copying Files to Amazon S3

To copy files, run the qq replication create object relationship command and specify the

following:

Local directory path on Qumulo cluster

- Copy direction (copy-from)

- S3 object folder

S3 bucket

- AWS region
- AWS access key 1D

- AWS secret access key

The following example shows how to create a relationship between the directory /my-dir/ ona
Qumulo cluster and the S3 bucket my-bucket and folder /my-folder/ inthe us-west-2 AWS
region. The secret access key is associated with the access key ID.
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qq replication create object relationship \
--local-directory-path /my-dir/ \
--direction COPY FROM OBJECT \
--object-folder /my-folder/ \
--bucket my-bucket \
--region us-west-2 \
--access-key-id AKIAIOSFODNN7EXAMPLE \
--secret-access-key wlalrXUtnFEMI/K7MDENG/bPxRfiCYEXAMPLEKEY

The CLI returns the details of the relationship in JISON format, for example:

"access key id": "ABC",

"bucket": "my-bucket",

"object store address": "s3.us-west-2.amazonaws.com",
"id": "1c23b4ed-5c67-8f90-1e23-a4f5f6ceff78",

"object folder": "my-folder/",

"port": 443,

"ca certificate": null,

"region": "us-west-2",

"local directory id": "3",

"direction": "COPY FROM OBJECT",

Viewing Configuration Details and Status of Shift Relationships

- To view configuration details for all Shift relationships, run the qq
replication list object relationships command.

- To view configuration details for a specific relationship, run the qq
replication get object relationship command followed by the --id and the Shift
relationship ID (GUID), for example:

qq replication get object relationship --id 1c23b4ed-5c67-8f90-1e23-a4f5f6cef
78

- To view the status of a specific relationship, run the qq
replication get object relationship status command followed by the --id and the
Shift relationship ID.

- To view the status of all relationships, run the qq
replication list object relationship statuses command.

The CLI returns the details of all relationships in JISON format, for example:
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"direction": "COPY FROM OBJECT",
"access key id": "AKIAIOSFODNN7EXAMPLE",
"bucket": "my-bucket",
"object store address": "s3.us-west-2.amazonaws.com",
"id": "1c23b4ed-5c67-8f90-1e23-a4f5f6ceff78",
"object folder": "my-folder/",
"port": 443,
"ca certificate": null,
"region": "us-west-2",
"local directory id": "3",
"local directory path": "/my-dir/",
"state": "REPLICATION RUNNING",
"current job": {
"start time": "2020-04-06T17:56:29.659309904Z",
"estimated end time": "2020-04-06T21:54:33.2440955937",
"job progress": {
"bytes transferred": "178388608",
"bytes unchanged": "0",
"bytes remaining": "21660032",
"bytes total": "200048640",

"files transferred": "17",
"files unchanged": "0",
"files remaining": "4",

"files total": "21",
"percent complete": 89.0368314738253,
"throughput current": "12330689",
"throughput overall": "12330689"
}
I
"last job": null

}

The state field shows the REPLICATION RUNNING status and the current job field shows
the job's progress. When Qumulo Core copies files from S3, details for the most recently
completed job become available in the last job field, the state field changes to
REPLICATION NOT RUNNING, and the current job field revertsto null.

0 Note
If you already ran a job for a relationship, it is possible for both the current job and
last _job fields to be non-null while you run a new job.
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The bytes total and files total fields represent the total amount of data and number
of files to be transferred by a Shift job. The bytes remaining and files remaining fields
show the amount of data and number of files not yet transferred. The values of these four
fields don't stabilize until the work estimation for the job is complete.

The percent complete field displays the overall job progress and the estimated end time
field displays the time at which the job is estimated to be complete. The values of these
two fields are populated when the work estimation for the job is complete.

Shift-From performs a single task that estimates the amount of content to copy by listing
all files and summing up their contents. Until this task is complete, the percent complete
field issetto "None" and the estimated end time fieldissetto "".To list the bucket
prefix content in sets of 5,000 objects, this task uses the ListObjectV2 S3 action.

Stopping a Copy Job in Progress

To stop a copy job already in progress, run the qq replication abort object replication
command and use the --id flag to specify the Shift relationship ID.

Repeating a Completed Copy Job

To repeat a completed copy job, run the qq replication start object relationship command
and use the --id flag to specify the Shift relationship ID.

This command begins a new job for the existing relationship and downloads any content that
changed in the S3 bucket or on the Qumulo cluster since the time the previous job ran.

Deleting a Shift Relationship

After your copy job is complete, you can delete your Shift relationship. To do this, run the
replication delete object relationship command and use the --id flag to specify the Shift
relationship ID.

O Note
You can run this command only against a relationship that doesn’t have any active jobs
running.

This command removes the copy job's record, leaving locally stored objects unchanged. Any
storage that the relationship used to track downloaded objects becomes available when you
delete the relationship.

Troubleshooting Copy Job Issues

Any fatal errors that occur during a copy job cause the job to fail, leaving a partially copied set of
files in the directory on your Qumulo cluster. However, to let you review the Shift relationship
status any failure messages, the Shift relationship continues to exist. You can start a new job to
complete the copying of objects from the S3 bucket—any successfully transferred files from the
previous job aren't retransferred to your Qumulo cluster.
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Whenever Qumulo Core doesn't complete an operation successfully and returns an error from
the APl or CLI, the error field within the last job field (that the

replication list object relationship statuses command returns) contains a detailed failure
message. For more troubleshooting details, see qumulo-replication.log on your Qumulo cluster.

Best Practices for Shift-from-S3
We recommend the following best practices for working with Qumulo Shift-From for Amazon S3.

Inheritable Permissions: Because the system user creates the files that Shift-From for S3
copies, the system owns these files. By default, everyone is granted read permissions and
administrators always have full access to the files.

0 Note

To ensure that the copied files and subdirectories have the correct permissions, you
must assign the necessary inheritable permissions to the root directory of the
relationship before you create a Shift-From S3 relationship. To edit directory
permissions, you can use the Windows Security Dialog or the qq fs modify acl
command. For more information, see Qumulo File Permissions Overview on Qumulo
Care.

- VPC Endpoints: For best performmance when using a Qumulo cluster in AWS, configure a
VPC endpoint to S3. For on-premises Qumulo clusters, we recommend AWS Direct
Connect or another high-bandwidth, low-latency connection to S3.

Repeated Synchronization: If you need to repeatedly synchronize an S3 folder with a
Qumulo directory, we recommend reusing the same relationship. This lets you avoid
repeated downloading of unchanged objects that already exist locally.

Completed Jobs: If you don't plan to use a Shift relationship to download updates from S3,
delete the relationship to free up any storage associated with it.

Concurrent Replication Relationships: To increase parallelism, especially across distinct
datasets, use concurrent replication relationships from S3. To avoid having a large number
of concurrent operations impact client 1/O to the Qumulo cluster, limit the number of
concurrent replication relationships. While there is no hard limit, we don’'t recommend
creating more than 100 concurrent replication relationships on a cluster (including both
Shift and Qumulo local replication relationships).

Shift-from-S3 Restrictions

S3-Compatible Object Stores: S3-compatible object stores aren't supported. Currently,
Qumulo Shift-From supports replication only from Amazon S3.

HTTP: HTTP isn't supported. All Qumulo connections are encrypted by using HTTPS and
verify the S3 server’s SSL certificate.

158


https://docs.qumulo.com/qq-cli-command-guide/fs/fs_modify_acl.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_modify_acl.html
https://care.qumulo.com/hc/en-us/articles/115008211868
https://docs.aws.amazon.com/vpc/latest/privatelink/vpc-endpoints.html
https://docs.aws.amazon.com/whitepapers/latest/aws-vpc-connectivity-options/aws-direct-connect.html
https://docs.aws.amazon.com/whitepapers/latest/aws-vpc-connectivity-options/aws-direct-connect.html

- Anonymous Access: Anonymous access isn't supported. You must use valid AWS
credentials.

Replication without Throttling: Replication provides no throttling and might use all
available bandwidth. If necessary, use Quality of Service rules on your network.

- Amazon S3 Standard Storage Class: Qumulo Shift-From supports downloading only
objects stored in the Amazon S3 Standard storage class. You can’'t download objects
stored in the Amazon S3 Glacier or Deep Archive storage classes and any buckets that
contain such objects cause a copy job to fail.

Disallowed Amazon S3 Paths in Qumulo Clusters: Certain allowed Amazon S3 paths can't
be copied to Qumulo clusters and cause a copy job to fail. Disallowed paths contain:

o Atrailing slash ( /) character (with non-zero object content length)
o Consecutive slash ( /) characters

o Single and double period (., .. ) characters

o The path component .snapshot

Disallowed Conflicting Types: When content in an S3 bucket or Qumulo directory changes
over time, a conflict related to type mismatches might arise, the Shift-from job fails, and
an error message gives details about the conflict. For example, a conflict might occur
when a remote object maps to a local file system directory entry which:

o Is aregular file with two or more links
o Isn't a regular file (for example, a directory or a special file)

Disallowed Amazon S3 Path Configurations: Because of conflicting type requirements,
Qumulo Core can't recreate certain allowed Amazon S3 path configurations on Qumulo
clusters. For example, if an S3 bucket contains objects a/b/c and a/b, then path a/b
must be both a file and directory on a Qumulo cluster. Because this isn't possible, this
configuration causes a copy job to fail.

Directories in Multiple Relationships: A directory on a Qumulo cluster for one Shift
relationship can't overlap with a directory used for another Shift relationship, or with a
remote directory for a Qumulo-to-Qumulo replication relationship. This causes the
relationship creation to fail.

Changes to S3 Folder During Copy Job: Currently, Shift-From assumes that the S3 folder
remains unchanged throughout the copy job. Any changes (deleting, archiving, or
modifying an object) during the copy job might cause a copy job to fail.

Read-Only Local Directory: When the Shift-From copy job begins, the local directory on
the Qumulo cluster becomes read-only. While no external clients can modify anything in
the directory or its subdirectories, all content remains readable. When the copy job is
complete, the directory reverts to its previous permissions.
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Partially Downloaded Files: If a copy job is interrupted or encounters a fatal error (that
can't be resolved by retrying the operation), Qumulo Core attempts to delete partially
downloaded files. Because this is a best-effort process, certain interruptions can prevent

the cleanup of partially downloaded files.

160



File System Changes

How File System Change Notifications Work in Qumulo
Core

This section describes how file system change notifications work in Qumulo Core and explains
request filtering, recursion, and the three configuration modes for notification requests.

Qumulo Core can stream file system change notifications to a client whenever someone modifies
a file or directory. The client can specify for which directories in the file system to receive
notifications and what notification types Qumulo Core sends for these directories.

Qumulo Core supports two protocols for streaming file system change notifications. Both
protocols provide roughly the same functionality.

SMB: For more information, see Watching for File Attribute and Directory Changes by
Using SMB2 CHANGE_NOTIFY (page 165)

REST: For more information, see Watching for File Attribute and Directory Changes by
Using REST (page 169).

The Qumulo Core notification system guarantees that:
- The system never misses a notification.
- The system sends notifications in real time.

- Aclient connected to any node in a cluster receives a notification which might originate
from any node in the cluster.

- The system sends notifications in accurate chronological order. (For example, the system
doesn'tsend a child file added event aftera child file removed event.)

In case a client can't keep up with the amount of events that the system emits, the cluster
stops queuing events and produces an error the next time the client attempts to contact
the cluster.

How Request Filtering Works

A client can request Qumulo Core to filter notifications. Although available filters differ between
protocols, they work in a similar way.

™ Tip

We recommend using a filter whenever you have an idea of the kind of events for which you
want to receive notifications. Filtering notifications reduces back-end and front-end load and
helps your client keep up with the data the cluster streams to it.
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For example, you want to configure a client to receive notifications only about files being created
but not deleted. In this scenario, you can make a notification request with the child file added
filter for your protocol.

How Recursion Works

A Important

When you don't use recursion, the system sends notifications for changes that occur immediately

Because recursive notification lets you monitor large regions of the file system tree
without having to "walk" through these regions to look for changes, recursive
notification is a powerful feature. Use this feature carefully: Watching too large a file
tree can lead to the system sending too many notifications.

In case a client can't keep up with the amount of events that the system emits, the
cluster stops queuing events and produces an error the next time the client attempts
to contact the cluster.

When Qumulo Core sends too many messages, there can also be a slight
performance impact for your cluster. For example, thousands of recursive watches at
the file system root can have a measurable performance impact on a write-heavy
IOPS workload.

In the Windows implementation, recursive notifications over SMB require
permissions only for the directory that the system watches. The system doesn't check
permissions anywhere below the directory. Before you enable recursive notification,
consider whether this policy is appropriate for your organization.

within a target directory (changes to files that are children of the watched directory).

Consider the following example with recursion disabled:

1. You watch the /a/b directory.

2. You create the /a/b/f file.

3. You receive a notification that a user created the /a/b/f file.
4. You create the /a/b/c/f file.

In this example, you receive no additional notifications.

When you use recursion, the system sends notifications for changes that occur in the sub-tree

below the target directory. Both protocols let you use recursion.

If you repeat the previous example scenario with recursion enabled, you receive two notifications:

You receive a notification that a user created the /a/b/f file.
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- You receive a notification that a user created the /a/b/c/f file.

Configuration Modes for Notification Requests

Qumulo Core has three global configuration modes that affect all recursive notification requests
for both protocols.

DISABLED ERROR: Recursive change notification requests return errors immediately.

DISABLED IGNORE : The system accepts recursive change notification requests but sends
notifications only for the top directory that it watches. (The system behaves as if the user
doesn't specify the recursive flag.)

Use this mode to improve compatibility with applications that request recursive behavior
but don't depend on it.

A Important

For scenarios that require recursive behavior, this mode can cause an application to
become unresponsive or exhibit other unexpected behavior.

ENABLED : This is the default mode. This mode provides full support for recursive change

notification requests. The system pushes notifications for all descendants of the watched
directory to the watcher.

A Important
This mode can affect system performance. For example, thousands of recursive

watches at the file system root can have a measurable performance impact on a
write-heavy IOPS workload.

To select the configuration mode, use the /vl/file-system/settings/notify REST APl or the qq
fs set notify settings command.

Supported Functionality

Functionality Supported from Qumulo

Core Version

Fully featured REST API for streaming file system notifications 6.0.2
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Functionality

Full support for SMB CHANGE NOTIFY
Parity with Windows Server

Full support for recursion

No limit on maximum directory size

- Configuration options for controlling recursive behavior

Improved compatibility with Windows applications

- Configuration options for controlling behavior of unsupported
features

- Support for all possible SMB CHANGE NOTIFY types except for
Alternate Data Streams (ADS)

SMB2 CHANGE NOTIFY support for adding and removing files and
directories

Supported from Qumulo
Core Version

6.0

533

531

5.3.0
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Watching for File Attribute and Directory Changes by
Using SMB2 CHANGE_NOTIFY

This section lists the completion filters that an SMB client can request and the corresponding
actions that Qumulo Core returns for a matched change.

O Note

Qumulo provides REST access to the same change notification system (page 161) that backs
SMB2 CHANGE NOTIFY. Because the notification interface and types are easier to work with
compared to SMB2, we recommend programming by using REST rather than SMB

CHANGE _NOTIFY.

Qumulo Core can watch for changes in file attributes and directory entries with a combination of
SMB2 CHANGE NOTIFY filters. Depending on the requested filter—and activity in the file
system—an SMB client or an application remains current by receiving a variety of notifications.

Commonly, these requests help limit the amount of traffic required to keep a current cache of
entries for an open directory. The requests also help operating system applications such as
Windows Explorer and macOS Finder update automatically when changes take place. It is also
possible to make requests programmatically. For more information about language bindings, see
the Windows Protocol documentation, such as ReadDirectoryChangesW function (winbase.h) for
Win32 and FileSystemWatcher Class for .NET.

Completion Filter Types

Each request uses a completion filter to specify the events to watch for. When events occur, the
system batches them into a NOTIFY response that contains a list of FILE ACTION items, each
tagged with the names of changed entries. As long as the handle for the watched directory
remains open, events queue up on the server, so that no events are lost between NOTIFY
requests.

- Watching for Name Changes: A name change can include four event types.
o Renaming
o Deleting
o Moving into watched directory
> Moving out of watched directory

The returned action specifies to your application whether an entry has been added,
renamed, or removed.

- Watching for Metadata Changes: A metadata change can include six supported attribute
types.
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o File attributes

o File size

o Last-write time

o Last-access time

o Creation time

o Security (the permissions or access control list for the file or directory)

© Note

Qumulo doesn't support mutating extended attributes (EA). If the system requests

only the FILE NOTIFY CHANGE EA filter, no events propagate.

Completion Filters and Corresponding Actions

The following table shows the requested completion filters (grouped by the number of inode
reads required to support them), the changes they watch for, and the actions that correspond to

them.

The following filters watch for - FILE ACTION ADDED
name changes ( readdir-without-
attrs) - FILE ACTION MODIFIED

. FILE_NOTIFY CHANGE DIR NAME » FILE_ACTION_REMOVED

. FILE_NOTIFY CHANGE FILE NAME » FILE_ACTION_RENAMED_NEW_NAME

- FILE_ACTION RENAMED OLD NAME

When Qumulo Core
watches names, it no-
tifies the client when
there is an added, re-
moved, or renamed
file or directory in the
watched directory.

A rename event
sends separate, con-
secutive events for
OLD and NEW names,
for example:

[REMOVED, file ol
d name],

[ADDED, file ne
w_name]
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FILE ACTION MODIFIED

The following filters watch for When one of the
metadata changes ( readdir-with- watched attributes
attrs). changes for an entry

of the watched direc-

- FILE NOTIFY CHANGE ATTRIBUTES tory and the filter is

- FILE_NOTIFY_CHANGE CREATION requested, the client
receives a MODIFIED
. FILE NOTIFY_CHANGE SECURITY event.
. FILE NOTIFY_CHANGE SIZE
O Note
. FILE NOTIFY CHANGE LAST ACCESS :
- - - - In Microsoft ter-
- FILE_NOTIFY_CHANGE LAST WRITE minology, attrib-

utes are flags. For
more informa-
tion, see File At-
tributes in the
Open Specifica-
tion documenta-

O Note

Qumulo doesn'’t support mu-
tating extended attributes
(EA). If the system requests on-
ly the FILE_NOTIFY CHANGE EA

. tion.
filter, no events propagate.
The following filters watch for alter- - FILE ACTION ADDED STREAM Consider the follow-
native data stream (ADS) changes ing example com-
. - FILE ACTION REMOVED STREAM
( readdir-attrs-and-stream-names ). - - - mand.

. FILE NOTIFY CHANGE STREAM NAMg [ TLE_ACTION_MODIFIED STREAM

echo "data" > wat
ched dir/file0:st

- FILE NOTIFY CHANGE STREAM WRITE e

- FILE NOTIFY CHANGE STREAM SIZE

This command gen-
erates the following
event.

[ADDED STREAM, fi
leO:stream]
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O Note
If you don't supply a filter, the SMB server accepts the request but doesn’t send any
notifications.

Re-Enumerating Changes after the STATUS_ENUM_DIR Error

If the SMB client can’'t keep up with the notification stream from the server, the server returns the
STATUS ENUM DIR error code to the client and stops sending notifications.

In this scenario, the client must re-enumerate any changes that concern it directly, by opening
and inspecting files, rather than relying on notifications. This scenario can happen because the
request is too broad, for example, a recursive watch on the file system root.

Configuring Full Recursion for the WATCH_TREE Flag

By default, when a client supplies the WATCH TREE flag, the server sends an error to the client
immediately. In this scenario, you can configure your Qumulo cluster to support full recursion
(page 161).
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Watching for File Attribute and Directory Changes by
Using REST

This section describes how to configure Qumulo Core and watch for file attribute and directory
changes by using REST.

O Note

Qumulo provides REST access to the same change notification system (page 161) that backs
SMB2 CHANGE NOTIFY. Because the notification interface and types are easier to work with
compared to SMB2, we recommend programming by using REST rather than SMB

CHANGE _NOTIFY.

Qumulo Core streams notifications to the client by using HTML server-sent events (SSE). For more

information about the SSE syntax, see Server-sent events in the HTML Living Standard
documentation.

- The comment syntax—any line that begins with a colon ( : )— shows that the call has
registered successfully for notifications and periodic keep-alive connections.

- The data syntax (data: payload ) shows the event content.

Qumulo Core continues to stream events until the client closes the connection.

A Important

Standard file system permissions apply to API requests for non-recursive watching:
The system compares the authenticated user that makes the API request with the
defined access control list (ACL) permissions for the file and grants or denies access
access. The authenticated user must have permission to read a directory in order to
request notifications for its changes.

Because of the complexity of representing and enforcing a permissions model for an
arbitrary subtree of the file system, recursive notification requests require an
authenticated API user to have the DATA ADMINISTRATOR privilege. This requirement
remains true even if you configure your Qumulo cluster to ignore the recursive
notification mode.
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How SSE Event Payloads are Structured for Recursive Notification
Requests

An SSE event payload is a JSON-encoded list of notification objects. The following is a format
example of the SSE event payload.

{
"type": "<type>",
"path": "<path>",
"spine": ["<file id 1>", "<file id 2>", ...1,
"stream name": "<optional stream name>"
e
{
}

type : One of the possible notification types (page 170).
path : The path to the file for which the notification occurred.
This path is relative to the watched directory.

spine : A representation of the file path that uses Qumulo file IDs (rather than path
components).

o The first file ID in the spine is the oldest ancestor in the path.
o The last file ID in the spine is the file for which the system sends the notification.
stream name : The name of an alternate data stream (ADS) for the file.

When this value is null, the notification is for the file's default stream. Otherwise, the
notification is for the listed stream.

SSE Payload Notification Types

The following is a list of available notification types in SSE event payloads (page 169).
- The type field shows a single notification type.

- The filter field shows multiple notification types in comma-separated format.

child acl changed The ACL for the listed or directory has been modified.
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Notification Type

child atime_ changed

child btime changed

child mtime changed

child data written
child dir added
child dir removed

child dir moved from

The atime (access time) of the listed file or directory has been
modified.

O Note

When a client modifies the atime field for a file directly,
Qumulo Cores sends atime notifications for the file.

If you have enabled atime monitoring on your Qumulo
Cluster, Qumulo Core sends atime notifications automat-
ically. To configure atime monitoring, use the /vl/file-
system/settings/atime REST API or run the qq

fs set atime settingscommand.

The btime (creation time) of the listed file or directory has been
modified.

The mtime (modification time) of the listed file or directory has
been modified.

Data has been written to the listed file.
The listed directory has been created.

The listed directory has been removed.

A directory has been moved from the listed location.

0 Note
The combination of the * moved to and * moved from notifi-
cation type constitutes the renaming of the listed directory.

171


https://docs.qumulo.com/qq-cli-command-guide/fs/fs_set_atime_settings.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_set_atime_settings.html
https://docs.qumulo.com/qq-cli-command-guide/fs/fs_set_atime_settings.html

child dir moved to . . .
A directory has been moved to the listed location.

O Note
The combination of the * moved toand * moved from notifi-
cation type constitutes the renaming of the listed directory.

child extra attrs changed o . ) ) .
The additional attributes for the listed file or directory have been
modified.

O Note

The additional attributes are Windows-specific extra file at-
tributes which include HIDDEN, READ ONLY, and so on. For

more information, see File Attributes in the Microsoft Open
Attributes documentation.

child file added The listed file has been created.

child file removed The listed file has been removed.

child file moved from . . .
- - - A file has been moved from the listed location.

O Note

The combination of the * moved to and * moved from notifi-
cation type constitutes the renaming of the listed file.

child file moved to ) ) )
- - . A file has been moved from the listed location.

O Note
The combination of the * moved toand * moved from notifi-
cation type constitutes the renaming of the listed file.

child group changed The group for the listed file or directory has been changed.
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child owner changed
child size changed

child stream added

child stream data written
child stream moved from
child stream moved to

child stream removed

child stream size changed

self removed

The owner for the listed file or directory has been changed.
The size of the listed file has been changed.

The listed alternate data stream (ADS) has been added to the
listed file or directory.

Data has been written to the listed ADS.
The listed ADS has been moved to the listed file or directory.
The listed ADS has been moved from the listed file or directory.

The listed ADS has been removed from the listed file or directo-
ry.

The size of the listed ADS for the listed file or directory has been
changed.

The directory from which then system streams notifications has
been removed from the file system.

O Note
No notifications follow a self removed notification.

Streaming Change Notifications by Using the gqqg CLI

Runthe gq fs notify command and specify the path to a directory. For example:

qq fs notify --path /my/directory

In this example, Qumulo Core streams all notification types (page 170) for files immediately under

the /my/directory directory.

To terminate the stream, send a SIGQUIT signal.

Streaming Change Notifications by Using the Qumulo Core REST API

Make a GET request to the REST endpoint in the following format:
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/vl/files/<ref>/notify&filter=<filter>&recursive=<recursive>

In the following example:
ref : An absolute path or a numeric file ID for the directory to watch.
filter : Acomma-separated list of notification types (page 170).

recursive : When set to true, enables recursive change notifications.

/vl/files/my/directory/notify&filter=child file added,child dir removed&recursive=tr
ue
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NFS

Creating and Managing an NFS Export in Qumulo Core

This section explains how to create, modify, and delete an NFS export by using the Qumulo Core

Web UlI.

To Create an NFS Export

1.

2.

5.

Log in to the Qumulo Core Web UL.
Click Sharing > NFS Exports.
On the right side of the NFS Exports page, click Create Export.
On the Create NFS Export page:
a. Enter the File system path from the root of your file system.
b. To create a new directory, click Create new directory if it doesn't exist.
c. Enter the Export path.
d. Enter the Description for the export.
e. Under Host Access Rules, enter Allowed Hosts and specify:
- Whether the host has Read-only access

- The User Mapping

O Note

Qumulo Core enforces host access rules in the order of appearance, top to
bottom. We recommend adding rules specific to IP addresses and hosts to
the top of the list and rules specific to subnets and host wildcards to the
bottom. For more information see Configuring and Troubleshooting Host
Access Rules (page 192).

To add a host, click Add a Host Access Rule.

To delete an existing host, click m

Click Save.

To Modify an NFS Export

1.

Log in to the Qumulo Core Web Ul.
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2. Click Sharing > NFS Exports.

3. For an NFS Export, in the Actions column, click ﬁ

4. Make changes to your NFS Export (for more information, see To Create an NFS Export
(page 175)) and then click Save.

To Delete an NFS Export

1. Log in to the Qumulo Core Web Ul.
2. Click Sharing > NFS Exports.

3. For an NFS Export, in the Actions column, click m

4. In the Delete Export dialog box, click Yes, Delete Export.
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Enabling and Using NFSv4.1 on a Qumulo Cluster

This section explains how to configure your cluster for a supported export configuration and
enable or disable NFSv4.1 on your cluster.

For more information about NFSv4.1 and file access permissions, see Managing File Access
Permissions by Using NFSv4.1 Access Control Lists (ACLs) (page 184).

A Important

- Currently, Qumulo Core 4.3.0 (and higher) supports only NFSv4.1. Mounting with
version 4.0 or 4.2 isn't supported.

- The NFSv4.1 protocol requires clients to provide the server with globally unique
identifiers. By default, the NFSv4.1 client for Linux uses the machine's hostname as
co_ownerid. Because the NFSv4.1 protocol requires a unique identifier for every client,
an unpredictable failure can occur if two clients have the same hostname. To
configure unique identification for your NFS clients, set the nfs4 unique id value for
them. For more information, see The nfs4_unique_id parameter in the Linux kernel
user's and administrator's guide.

Configuring and Using Exports for NFSv4.1

Qumulo’s NFS exports can present a view of your cluster over NFS that might differ from the
contents of the underlying file system. You can mark NFS exports as read-only, restricted (to allow
access only from certain IP addresses), or configure specific user mappings. For more
information, see Create an NFS Export on Qumulo Care.

While NFSv3 and NFSv4.1 share each cluster’s NFS export configuration, exports behave
differently when you access them by using NFSv4.1. This section explains these differences and
the new requirements for export configurations with NFSv4.1.

Differences Between NFSv3 and NFSv4.1 Exports

In the following example, a Qumulo cluster has the following export configuration.

File System Path Read-Only
No

/home /home
/files /home/admin/files No
/read_only/home /home Yes
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File System Path Read-Only

/read only/files /home/admin/files  Yes

NFSv3 lets you mount one of these exports by specifying the full export name, for example:

mount -o nfsvers=3 \

cluster.example.com:/read only/home \
/mnt/cluster/home

This command gives read-only access to the /home directory on the cluster by using the path

/mnt/cluster/home . However, the following command fails with the No such file or directory
message.

mount -o nfsvers=3 \

cluster.example.com:/read only \
/mnt/cluster/read only

NFSv4.1 still lets you mount exports by specifying the full export name. However, NFSv4.1 also

supports navigating above exports, as if they are part of the file system. The following command
succeeds.

mount -o nfsvers=4.1 \

cluster.example.com:/read only \
/mnt/cluster/read only

At the mount, the exports under /read only are visible: /mnt/cluster/read only displays virtual

directories named files/ and home/ with the contents of the corresponding directories in the
file system, for example:

/mnt/cluster/read only/

| --- files/<file system contents>
| --- home/

[------ admin/files/<file system contents>
[------ <other file system contents>
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This presentation of exports lets you view existing exports by using the file system’s own interface.
It also lets you view new exports as soon as someone creates or modifies them without
remounting.

Preparing Export Configurations for NFSv4.1

Qumulo’s implementation of NFSv4.1 distinguishes between navigating above exports and inside
an export. To avoid confusion between paths that refer to a virtual directory above an export or a
real file system directory inside an export, no export name can be a prefix of another export name
when NFSv4.1 is enabled.

In the following example, a Qumulo cluster has the following export configuration.

File System Path

/ /

/admin /home/admin

Because / isa prefix of /admin,you can't enable NFSv4.1 with this export configuration. This
restriction prevents the situation where the path /admin can refer to both the export of /home/
admin or the actual file system path /admin .

To prepare this configuration for NFSv4.1, you can do one of the following:
Delete the / export and use NFSv4.1 presentation of exports when mounting /.
Delete the /admin export.

GCive the / export a name that doesn't use other exports as a prefix, for example:

File System Path

/root /

/admin /home/admin

Visibility of IP-Address-Restricted Exports

O Note
The names of exports are public to all NFSv4.1 clients, regardless of |IP address restrictions.
You can't disable this behavior.

NFSv4.1 respects IP address restrictions on exports: Only clients with allowed IP addresses can
access the contents of an export. However, clients without access to an export can still view the
export as a directory when they traverse above exports. The restrictions apply only when a client
attempts to access the contents of the export.
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32-Bit Sanitization

In NFSV3, you can configure specific exports to return 32-bit sanitized data for individual
fields. NFSv3 converts any data larger than 32 bits in configured fields to 32-bit data and
returns the data. For example, it can sanitize file size to 32-bit format. This truncates the
field to max uint32 whenever the NFSV3 server returns the attribute.

NFSv4.1 doesn’t support 32-bit sanitization and ignores any sanitization configured for an

export.

Enabling NFSv4.1 on a Qumulo Cluster

O Note
Currently, you can enable NFSv4.1 only by using the qq CLI.

You can enable NFSv4.1 on your Qumulo cluster by using a single cluster-wide configuration
command, for example:

ggq nfs modify settings --enable-v4

When you enable NFSv4.], all NFS exports are accessible through NFSv3 and NFSv4.1.

Specifying the NFS Mount Option

0 Note
In Qumulo Core 7.0.0 (and higher), to greatly improve throughput, use the nconnect=16 option
to enable cross-connection write combining.

Typically, NFS clients find and use the highest version of the protocol that both the client and
server support. For example, the following command mounts by using NFSv4.1 (if it is enabled) or
by using NFSv3 otherwise.

mount -t nfs \
-0 nconnect=16 \
your.example.cluster:/mount path \
/path/to/mount point

Because Qumulo’s NFSv4.1 implementation currently doesn't have full feature parity with NFSv3,
you must provide the nfsvers=3 option for any mounts that require features (such as snapshot
access) that only NFSv3 supports, for example:
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mount -t nfs \
-0 nfsvers=3,nconnect=16 \
your.example.cluster:/mount path \
/path/to/mount point

O Note
We recommend specifying the nfsvers=4 or nfsvers=4.1 option for any mounts that use
NFSv4.1.

Checking Whether NFSv4.1 is enabled

To check whether NFSv4.1 is enabled on your cluster, run the following qq CLI command:

qq nfs get settings

Disabling NFSv4.1 on a Qumulo Cluster

A Important
Disabling NFSv4.1 makes any NFSv4.1 mounts unusable immediately. We recommend
switching any NFSv4.1 mounts to NFSv3 before disabling NFSv4 1.

To disable NFSv4.1 on an entire Qumulo cluster, run the following gq CLI command:

gqq nfs modify settings --disable-v4

Configuring Floating IP Addresses for Nodes

Each Qumulo node supports a limited number of clients connected through NFSv4.1
simultaneously (for more information, see Known Limits (page 19)). To account for nodes going
offline, and to prevent a node failover event from overloading the nodes to which clients
reconnect, we recommend balancing the number of client connections across your nodes by
configuring a sufficient number of floating IP addresses for each node.

For example, if you configure a single IP address for each node on a cluster with 600 clients
connected to each node, with all clients configured with the nconnect=8 mount option, a single
node failure can overload one of the remaining nodes, preventing 200 clients from connecting. If
you assign multiple floating IP addresses to each node, the client connections are distributed
across multiple nodes.
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Listing NFSv4.1 Byte-Range Locks

Rather than lock an entire file, byte-range locking lets you lock specific portions of a file or an
entire file in use. This feature is available in Qumulo Core 5.1.3 (and higher). It doesn’t require client

mount configuration.

The NFSv4.1 implementation in Qumulo Core has a non-configurable lease of one minute. During
each lease period, clients send a heartbeat to your Qumulo cluster. The cluster uses this heartbeat
to detect lost client connections and to revoke the client leases. When the cluster revokes a lease,
it releases any byte-range locks and makes them available to other clients.

A Important

NFSv4.1 byte-range locks are interoperable with NLM (NFSv3) byte-range locks.
NFSv4.1 clients view and respect locks that NFSv3 clients hold (the opposite is also

true).

NFSv4.1 and NLM locks aren't interoperable with SMB locks.
To list NFSv4.1 byte-range locks in your cluster, run the following qq CLI command:

gqq fs list locks \
--protocol nfs4 \
--lock-type byte-range

O Note

- Currently, Qumulo Core doesn't support revoking NFSv4.1 byte-range locks by using
the CLI.

- The time to acquire or release a lock scales linearly with the number of locks that the
system already holds on a specific file. If a file has a very large number of locks,
system performance can degrade.

Supported and Unsupported Features in Qumulo’'s Implementation of
NFSv4.]

Qumulo’'s implementation of NFSv4.1 currently supports:
- Authentication with Kerberos (page 198)
- General file system access (reading, writing, and navigating files)

Unstable writes
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Full use of the NFS exports configuration shared with NFSv3
Navigation in the pseudo-file system above your exports
NFSv3-style AUTH SYS authentication (also known as AUTH UNIX)
Fine-grained control over file permissions by using access control lists (ACLs)
File locking (for example, by using the fcntl command)

- Snapshots through NFSv4.1 (Qumulo Core 5.2.4 and higher)

- Quotas through NFSv4.1 (Qumulo Core 5.2.5.1 and higher)

Qumulo Core doesn't currently support the following NFSv4.1 features:

Delegations
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Managing File Access Permissions by Using NFSv4.]
Access Control Lists (ACLSs)

This section explains how to use Qumulo Core's implementation of NFSv4.1 with access control
lists (ACLs) to manage access permissions for files.

The Qumulo Core implementation supports using AUTH SYS credentials (also known as

AUTH UNIX), AUTH NONE (which actsas AUTH SYS but mapsincoming UIDs and GIDs to nobody ),
and AUTH KRB5, AUTH KRB5P,or AUTH KRB5I credentials. You can use the CLI toolsin the nfs-acl-
tools Linux package to allow or deny various operations.

For more information about NFSv4.1, see Enabling and Using NFSv4.1 on a Qumulo Cluster (page
0).

Using the NFSv4.1 CLI Commands to Manage ACLs

In most Linux distributions, the nfs-acl-tools package contains the NFSv4.1 commands that let
you manage ACLs for files.

Showing the ACL of a File

To show the ACL of a file, run the nfs4 getfacl command. In the following example, we create
the file my-file and then show the ACL for it.

$ touch /mnt/qumulo/my-file

$ nfs4 getfacl /mnt/qumulo/my-file
A::userl@domain.example.com: rwatTnNcy
A:g:groupl@domain.example.com: rwatTnNcy
A: :EVERYONE@: rtncy

The entries in the ACL have four parts separated by colons ( : ). For more information, see the
nfs4_acl in the Linux documentation.

The ACL in this example corresponds to 664 mode: The owner (userl)and group ( groupl ) of the
file are allowed to read and write, while others ( EVERYONE@ ) are allowed to only read. To check the
current mode, run the stat command, for example:

$ stat -c %a /mnt/qumulo/my-file
664

Editing the ACL of a File

To edit the ACL of a file (by using the text editor specified in the $EDITOR environment variable),
run the nfs4_editfacl command (or the nfs4_setfacl coommand with the -e flag).
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Setting the ACL of a File

To set the ACL of a file, you can use one of the following commmands:
- Add a Single ACE: nfs4 setfacl -a <ace>
- Set an Entire ACL: nfs4 setfacl -s <acl>

Configuring Access Control Entries (ACEs) and Trustee Representation

0 Note
The following guidance applies to all nfs4 acl scenarios, including getting, editing, and
setting the ACL.

There are four fields in the nfs4 acl syntax, separated by colons ( : ):
- The ACE type
- Additional ACE flags
- The trustee to which the ACE applies

- The access types to which the ACE applies
ACE Type

In the example of the file ACL (page 184), all three ACEs are setto A (allow).

0 Note
Qumulo Core supports only A and D ACEs.

- A Allow
D: Deny
U: Audit
L: Alarm

Additional ACE Flags

In the example of the file ACL (page 184), the second ACE has the flag g that shows that the ID in
the following part represents a group (rather than a user).

O Note
Qumulo Core doesn't support The S and F flags.

The Trustee to Which the ACE Applies

You can use the following trustee representation formats.
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A Important

Be careful when you copy local users and groups across different Qumulo clusters
manually. Aside from UIDs and GIDs, local users and groups are the only identity
types in this table that aren't globally unique (because a user or group name
represents them). If the destination cluster interprets the named user or group
differently, the permissions you set might be unexpected.

- This consideration doesn't apply to replication copies of local user or group trustees.

<user>@<domain>

<group>@<domain>

userl@domain.example.com

groupl@domain.example.com

A Kerberos principal that repre-
sents a user in the domain to
which a Qumulo cluster is joined.
You can use this format regardless
of client mount security, but only
when the cluster is joined to AD.
For this trustee in the ACE, the sys-
tem stores the corresponding AD
SID for this user principal on disk.
For more information about con-
figuring your clients and Qumulo
cluster for Kerberos, see the How
NFSv4.1 Works with Kerberos in
Qumulo Core (page 198).

A Kerberos principal that repre-
sents a group in the domain to
which that a Qumulo cluster is
joined. You can use this format re-
gardless of client mount security,
but only when the cluster is joined
to AD. The group flag isn't neces-
sary to show that this is a group.
For this trustee in this ACE, the sys-
tem stores the corresponding AD
SID for this group principal on disk.
For more information about con-
figuring your clients and Qumulo
cluster for Kerberos, see How
NFSv4.1 Works with Kerberos in
Qumulo Core (page 198).
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<S-R-X-Y1-Y2-Yn-1-Yn>

<numeric_uid>

<numeric gid>

qumulo local/<username>

S-1-5-32-544

1234

5678

qumulo local/localuserl

A raw SID. For more information,
see Security Identifiers in the Mi-
crosoft documentation. To store a
SID on disk for this trustee, you can
use this format in place of a Ker-
beros principal. An AD SID must be
a user or a group, but can't be
both. However, the group flag isn't
necessary for showing whether
the SID represents a user or group.
This can be useful if you have SIDs
in a foreign domain (that is, a do-
main that the cluster isn't joined
to). You can use this representation
when the cluster isn't joined to a
domain at all. When you retrieve
an ACL by using nfs4 getfacl, the
presentation for joined domain
SIDs is <group>@<domain> and the
presentation for foreign SIDs is <S-
R-X-Y1-Y2-Yn-1-Yn>.

A numerical UID for an AUTH SYS
user. For this trustee in the ACE,
the system stores this UID on disk.

A numerical GID for an AUTH_SYS
user. To avoid having the group in-
terpreted as a user, you must spec-
ify the group flag (page 185). For
this trustee in the ACE, the system
stores the GID on disk.

A user local to a Qumulo cluster
(that is, a user that created by us-
ing Qumulo Core Web Ul or the

qq CLI. For the trustee in this ACE,
the system stores this user as a lo-
cal user.
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qumulo local/<groupname> qumulo local/localgroupl

EVERYONE@ —
GROUP@ =

OWNER@ —

A group local to a Qumulo cluster
(that is, a group created by using
the Qumulo Core Web Ul or the

qq CLI. Because local Qumulo
users and groups can't share a
name, the group flag isn't neces-
sary to show this is a group. For the
trustee in this ACE, the system
stores this group as a local group,
on disk.

Any user of the file system.
The group owner of a file.

The owner of a file.

You you can use all trustee representations interchangeably, even within a single ACL. For

example, the following ACL is possible for a file:

nfs4 getfacl /mnt/qumulo/my-file
::userl@domain.example.com: rwatTnNcy
:g:groupl@domain.example.com: rwatTnNcy
::1234: rwatTnNcy

:9:5678: rwatTnNcy
::5-1-5-8-9:rwatTnNcy

:9:5-1-5-32-544: rwatTnNcy

::qumulo local/localuserl:rwatTnNcy
:g:qumulo local/localgroupl:rwatTnNcy
: :EVERYONE@: rtncy</code>

> > > > > > > > >N

The Access Types to Which the ACE Applies

For example:
r : Read
t : Read attributes

w: Write

The nfs4 setfacl command also lets you use the following shorthand:

R : Generic read
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W : Generic write

X : Execute permissions

Managing NFSv4.1 Permissions with ACLs and POSIX-Style Modes

You can manage NFSv4.1 access permissions by using ACLs, POSIX-style modes, or a combination
of both.

If you set an ACL on a file and then also set a mode on it, the restrictions that the mode
expresses also apply to the ACL. These restrictions change or remove ACEs that apply to
the owner, group, or other users.

If you use the OWNER@ or GROUP@ identifiers in an ACL that allows read, write, or execute
permissions, the identifiers appear in the owner or group bits of the mode when you read
the file’s mode.

O Note

Because the EVERYONE@ identifier includes the owner and group of a file and the other bits of
a mode don't apply to the owner or group, the permissions you grant to the EVERYONE@
identifier are more broad than a mode’s other bits.

Using NFSv4.1 ACLs with SMB Access Control

NFSv4.1 ACLs are interoperable with SMB access controls. You can write and read by using both
protocols. When you edit over NFS, the system represents SMB SIDs Kerberos principals.

Changing File Owners

When you change the owner of a file, the ACEs that refer to the owner change to the new owner,
for example:

nfs4 getfacl /mnt/qumulo/my-file
::userl@domain.example.com: rwatTnNcy
:g:groupl@domain.example.com:rwatTnNcy
: :EVERYONEQ@: rtncy

> > >

“r

sudo chown user2 /mnt/qumulo/my file

nfs4 getfacl /mnt/qumulo/my-file
::user2@domain.example.com: rwatTnNcy
:g:groupl@domain.example.com: rwatTnNcy
: :EVERYONEQ@: rtncy

> > > -
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Using Equivalent NFSv4.1 and Qumulo ACL Commands

The syntax for the nfs4 setfacl command is <type>:<flags>:<principal>:<permissions>, for
example A:fd:GROUP@: rwaDdxtTnNcCoy . You can use equivalent NFS ( nfs4 setfacl ) and Qumulo
(g fs modify acl) CLI commands to set ACL permissions.

The following tables compare elements of NFS and Qumulo ACL permissions.

NFSv4.1 ACL Type | Qumulo ACL Type

A Allowed

D Denied

d Container inherit
f Object inherit

a Extend file

c Read ACL

C Write ACL

d Delete

n Read EA

o} Take Ownership

r Read contents

R Read, Synchronize

t Read attr

T Write attr

w Write data

W Read ACL, Read attr, Synchronize, Write ACL, Write file
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NFSv4.1 Rights | Qumulo Rights

X Execute/Traverse
X Execute/Traverse, Read ACL, Read attr, Synchronize
y Synchronize

The following table gives examples of permissions and equivalent NFS and Qumulo CLI

commands.

NFSv4.1 Command Qumulo Command

Add Read Permis-
sion to File

Add Read and Ex-
ecute Permissions
to File

Add Read, Write,
and Execute Per-
missions to File

Add Full Access to
File

Remove Write and
Execute Permis-
sion to File

Add Full Access to
Group File and Di-
rectory Inheri-

tances to Directory

nfs4 setfacl -a "A::0WN-
ER@:R" myfile.ext

nfs4 setfacl -a "A::EVERY-
ONE@: rtRX" myfile.ext

nfs4 setfacl -a
"A::GROUP@: rtwRWX" my-
file.ext

nfs4 setfacl -a
"A::GROUP@: rtwRWX" my-
file.ext

nfs4 setfacl -a "D::0WN-
ER@:wx" myfile.ext

nfs4 setfacl -a
"A:fd:GROUP@: rwaDdxtTnNcCoy"
mydirectory

gqq fs modify acl --path /myfile.ext
add entry -y Allowed -t "File Owner"
-r Read

qq fs modify acl --path /myfile.ext
add entry -y Allowed -t "EVERYONE"
-r Execute/Traverse, Read

gq fs modify acl --path /myfile.ext
add _entry -y Allowed -t "File Group
Owner" -r Execute/Traverse, Read,
Write ACL, Write file

qq fs modify acl --path /myfile.ext
add _entry -y Allowed -t "File Group
Owner" -r Execute/Traverse, Read,
Write ACL, Write file

qq fs modify acl --path /myfile.ext
add _entry -y Denied -t "File Owner"
-r Execute/Traverse, Write data

gq fs modify acl --path /mydirecto-
ry add entry -y Allowed -t "File
Group Owner" -r All -f 'Container in-
herit' 'Object inherit'
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Configuring and Troubleshooting Host Access Rules for
NFS Exports in Qumulo Core

This section explains how host access rules work in Qumulo Core and how to configure and
troubleshoot them.

In Qumulo Core 6.2.0.1, you can add a host access rule to an NFS export to restrict the export by IP

address or hostname.
The following examples show the elements that a host access rule can include.
Hostnames
o Without a wildcard ( name.example.com)
o With a wildcard ( *.example.com)
IP Addresses
o Single IP addresses (203.0.113.0)
o |P addressrange (203.0.113.0-203.0.113.10 or 203.0.113.0-10)
Network Segment
o Without a subnet mask (203.0.113.0/24)
o With a subnet mask ( 203.0.113.0/255.255.255.0)
- Allowed Kerberos Security Flavors

To restrict access to NFSv4.1 clients that use only specific Kerberos security flavors (page
198), add the following special strings to the list of host access rules. For example:

o KRB5P@ : Allow only encrypted access for the specified export.

° KRB5@, KRB5I@,and KRB5P@: Allow any Kerberos-authenticated access, but not
AUTH SYS access.

A Important
If you don't specify a host access rule, Qumulo Core allows access to all IP addresses.

Prerequisites
To be able to use hostnames, you must:

Enable and configure reverse look-ups on your DNS server,
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Use fully qualified domain names (FQDNSs).

Use wildcards carefully because they match only one hostname level. For example,
*,accounting.example.com matches userl.accounting.example.com but not

machine.userl.accounting.example.com.

- Optimize your system for reverse-dns look-ups. (page 196)

Adding a Host Access Rule to an Existing NFS Export

This section explains how you can add a host access rule to an existing NFS export by using the

Qumulo Core Web Ul or the qq CLI.

To Add a Host Access Rule by Using the Qumulo Core Web Ul
1. Log in to the Qumulo Core Web Ul.
2. Click Sharing > NFS Exports.

3. For an NFS export, in the Actions column, click ﬁ )

4. Onthe NFS Export page, in the Host Access Rules section:
a. For Allowed Hosts, enter a comma-separated host access rule. (page 192)

b. (Optional) To ensure that the allowed hosts have limited access to the NFS export,

click Read-only.
c. (Optional) For User mapping select one of the following:

No mapping: Qumulo Core doesn't apply a user mapping when it accesses the NFS
export and relies on default NFS protocol behavior.

Map root to.... Qumulo Core associates the root user that accesses the NFS export
with a specific user in your Qumulo cluster.

Map all to.... Qumulo Core associates all users that access the NFS export with a

specific user in your Qumulo cluster.

d. To add a new rule, click + Add a Host Access Rule.
e. Click Save.
Qumulo Core applies the host access rule to the NFS export.

To Add a Host Access Rule by Using the qq CLI

1. Prepare a list of host access rules in JISON format. The following is an example of the

contents of root restrictions.json.
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"restrictions": [{

"host restrictions": [
"userl.accounting.example.com",
"*.eng.example.com",
"203.0.113.0"

}

2. Runthe qq nfs mod export command and specify the export path and the file with the

host access rules. For example:

ggq nfs mod export \
--export-path / \
--restrictions root restrictions.json

The following is example output.

"description": "",
"export path": "/",
"fields to present as 32 bit": [],
"fs path": "/",
“id": "1v,
"restrictions": [{
"host restrictions": [
"userl.accounting.example.com",
"*_ eng.example.com",
"203.0.113.0"
1,
"read only": false,
"require privileged port": false,
"user mapping": "NFS MAP NONE"
H,
"tenant id": 1

}

To Troubleshoot Host Access Rules for an NFS Export

This section describes the troubleshooting steps for a scenario in which an NFS client can't mount

or access an NFS export.
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O Note
Currently, if you use multiple DNS servers, the dns_resolve hostnames and dns resolve ips
commands aren't tenant-aware and might not return the same results as the DNS resolution

mechanism in NFS.

1. Toview the NFS export's host access rules, run the qq nfs get export command and
specify the export path. For example:

gq nfs get export --export-path /

The following is example output.

ID:

Export Path:
Tenant ID:
FS Path:
Description:
32bit-mapped fields: None

Host Access:

ID Hosts Access Options

~ =~ =

1 userl.accounting.example.com rw, insecure, no_root squash

In this example, only the machine userl.accounting.example.com can access the NFS
exportat /.

2. Tofind the client’s IP address, we recommend viewing your Qumulo cluster logs. For
example:

Client 203.0.113.2 is not authorized to use export ExportId(1)

To find the client's hostname, run the qq dns resolve ips command and specify the
client's IP address. For example:

qq dns resolve ips --ips 203.0.113.2

The following is example output.
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[{

"hostname": "user2.accounting.example.com",
"ip address": "203.0.113.2",
"result": "OK"

}

In this example, the 203.0.113.2 IP address mapsto user2.accounting.example.com.
4. To troubleshoot the NFS client, you can take one or more of the following steps:
Ensure the NFS client configuration entry is correct.

Run the dns resolve ips (page 195) command to verify that the IP address maps to the
correct name.

Update the host access rules for user2.accounting.example.com.

Ensure that your Qumulo cluster’s DNS cache isn't out of date, for example, if 203.0.113.2
should resolve to userl.accounting.example.com.

To reset your Qumulo cluster’'s DNS cache, run the qq dns clear cache command.

Run the gq dns resolve hostnames command and specify the hostname to perform a

lookup for userl.accounting.example.com.

The following is example output.

[{
"hostname": "user2.accounting.example.com",
"ip addresses": ["203.0.113.1"],
"result": "OK"

1

Runthe gq dns resolve ips command to find the hostname for your client’s IP address

and:

If the NFS client can’t access a share, but should be able to, add the IP address to the NFS
export's host access rules.

If the NFS client can access a share, but shouldn’t be able to, remove the IP address from the
NFS export's host access rules.
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Optimizing Your System for Reverse-DNS Look-Ups

Qumulo Core checks hostnames by performing a reverse-DNS lookup on the cluster. Because
continuous reverse-DNS look-ups can affect system performance, Qumulo Core caches the
results on the cluster. Because Qumulo Core’s cache abides by the DNS TTL, a low TTL can cause
cache entries to expire frequently, which might require a new query.

By increasing TTL, you can reduce the number of DNS requests that your cluster makes. However,
this might cause your cluster to keep outdated results for a longer time. For the most optimal
configuration, list your organization’'s DNS servers first in your DNS configuration.

To bypass DNS, you can set explicit IP-host mappings for your cluster by using the qq
dns set lookup overrides command. If Qumulo Core finds an override for an IP address or host,
it uses the override instead of the DNS cache.

In the following JISON example, the IP address 203.0.113.2 binds to the host
user3.accounting.qumulo.com explicitly.

{
"lookup overrides": [{
"aliases": ["user3.accounting.example.com"],
"ip address": "203.0.113.2"
}
}
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NFSv4.1 with Kerberos

How NFSv4.1 Works with Kerberos in Qumulo Core

This section provides an overview of how NFSv4.1 works with Kerberos in Qumulo Core.

Kerberos is a network authentication protocol that works by using a three-way trust between a
key distribution center (KDC), a service server (for example, NFSv4.1 on Qumulo Core), and a client
system (for example, a Linux system). This section explains how to configure and use the three
entities involved in the trust and provides troubleshooting directions. For more information, see
Kerberos on Wikipedia and the MIT Kerberos documentation.

Active Directory (AD) simplifies Kerberos requirements by providing a globally unique security
identifier for every user and group (SID) and a KDC implementation with a ticket-granting service
(TGS) and an authentication service (AS).

Choosing a Kerberos Security Flavor

Qumulo Core supports three flavors of Kerberos security that NFSv4.1 clients can use by specifying
the following mount options:

sec=krb5 : Provides user authentication only.

sec=krb51i : Provides authentication and message integrity by performing message
signing for protection against man-in-the-middle attacks and message tampering.

sec=krb5bp : Provides privacy by encrypting all traffic between the client and server. This is
the most secure mount option.

Configuring Kerberos for Qumulo Core

Qumulo Core 5.1.5 (and higher) supports Kerberos for authenticating AD users over NFSv4.1. The
following is an overview of the Kerberos configuration process following the configuration of your
AD domain.

1. Join your Qumulo cluster to your AD domain.
2. Join Linux systems to your AD domain.
3. Loginto a Linux system and mount the Qumulo cluster by using one of the available

mount options (page 198).

Known Kerberos Limitations for Qumulo Core

Qumulo Core supports only the following features:
NFSv4.1

Linux clients
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- AES-128 and AES-256 encryption algorithms—for more information, see Network security:

Configure encryption types allowed for Kerberos in the Microsoft documentation

Microsoft Windows Active Directory (Windows Server 2008 and higher)
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Prerequisites for Joining a Qumulo Cluster to Active
Directory

This section describes the prerequisites for joining a Qumulo Cluster to Active Directory for using
NFSv4.1 with Kerberos.

To join your cluster to Active Directory, log in to the Qumulo Core Web Ul and click Cluster >
Active Directory.

Using Active Directory (AD) for POSIX Attributes (RFC 2307)

While using AD for POSIX attributes is optional, it helps avoid issues with Linux ID mapping. We
recommend enabling RFC 2307 to match your client's functionality.

Enabling RFC 2307 might simplify AUTH SYS -based Linux clients that access the cluster by
using known UIDs and GIDs. In this way, the cluster can map the UIDs and GIDs to the
user or group objects on the AD server and enforce the appropriate permissions.

If you configure sssd on Kerberos-mounted Linux clients for mapping by SID, disabling
RFC 2307 can help avoid ascribing special meaning to randomly assigned Linux UIDs and
GIDs.

Specifying the Base Distinguished Name (Base DN)

Qumulo uses LDAP to query the AD domain for users and groups. For this functionality, a Base
DN must cover any identities intended for use with Kerberos. For example, if multiple
organizational units (OUs) contain users, you must include them all in the Base DN (separated
with semicolons).

Alternatively, a parent container can hold all nested containers of interest. It is possible to set a
top-level domain (TLD) as the Base DN (however, this can cause queries to perform poorly in
certain scenarios). We recommend using as specific a Base DN as possible. If you don't configure
the Base DN correctly, Linux clients might present permissions such as nobody or 65534 .

In the following example, there is an OU with the AD domain my.example.com.The TLD Base DN
for this domain is as follows.

DC=my,DC=example,DC=com

If a Users container holds users and a Computers container holds machine accounts, you can set
the Base DN as follows.
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CN=Users,DC=my,DC=example,DC=com; CN=Computers,DC=stuff,DC=example,DC=com

O Note
This example is a very common configuration for user and computer objects in AD.

Using the Active Directory Domain Controller as the NTP Server

Kerberos is very sensitive to clock skew. It is important for all systems involved in a Kerberos
relationship—the KDC, your Qumulo cluster, and any Linux clients—to have as little clock skew as
possible. We recommend using the same NTP server for all three components.

- You can use your AD domain controller as an NTP server. In the Qumulo Core Web Ul, on
the Active Directory page, for Use Active Directory as your primary time server, click Yes.

- To configure any other NTP server in the Qumulo Core Web U, click Cluster > Date & Time.
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Configuring Active Directory for Use With Kerberos

This section describes the Active Directory Domain Controller (DC) configuration changes
necessary for enabling NFSv4.1 with Kerberos.

Configuring DNS in Active Directory

Kerberos relies on DNS to identify machines involved in authentication. NFS clients and servers
require DNS A records for forward-DNS look-ups and PTR records for reverse-DNS look-ups.

You can use a variety of DNS implementations with Kerberos. In some cases, for example, it might
be convenient to use the DNS server that the AD DC provides. For this reason, this section
discusses DNS configuration in general terms.

Modifying the Default DNS Configuration

By default, the Qumulo domain-join operation creates a machine account on the domain in the
organizational unit (OU)—that you specify during the join process—automatically. This machine
account represents all nodes in the cluster, not a single machine.

By default, this machine account has a single, automatically created DNS A record that refers to
the node on which the system performs the domain-join operation. This DNS record exists on the
AD DC used for the domain-join operation and the record refers to a single, public IP address for
the node.

The default DNS configuration is generally not useful without additional modifications because:

It applies to the DNS server for the DC: If the environment doesn't use this DNS server, you
must create the entry on the DNS server manually.

It creates only a DNS A (forward) record: You must create the PTR record (a reverse record
that maps an IP address to a hostname) manually. This can require creating a reverse zone
for the subnet and then adding the specific PTR record to the zone.

- We don't recommend assigning a single IP address to an entire cluster: In such a
configuration, any client that mounts the cluster points at the same node.

Configuring DNS for Distributing Workflows Across Nodes

The Qumulo distributed file system works best when you spread the workload evenly across
multiple nodes. We recommend configuring round-robin DNS in Active Directory.
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This approach provides a list of IP addresses which refer to different nodes in the cluster.
Successive DNS queries for the single cluster hostname return different IP addresses. From the
perspective of Kerberos, all nodes that comprise a Qumulo cluster act as one host and have the
same Kerberos key table. In this way, the Kerberos experience is the same regardless of the
selected node.

Unless you need direct access to a specific node through a DNS fully qualified domain name
(FQDN), it isn't necessary to use individual DNS A records for each node in the cluster (for

example, qumulol.example.com, qumulo2.example.com, qumulo3.example.com,and so on). Instead,

we recommend creating a DNS A record for the cluster and then duplicating this A record for
each IP address in the cluster (for example, qumulo.example.com — 203.0.113.0,
qumulo.example.com — 203.0.113.1,and soon).

To Configure Round-Robin DNS

1. Join your Qumulo cluster to AD (page 200).
2. Find the DNS entry for the cluster on the DNS server.

Unless you renamed the cluster after joining it to AD, this entry is generally the cluster’s
name. To find the machine account name in the Qumulo Core Web Ul, click Cluster >
Active Directory and write down the name under Machine Account.

3. Update the list of IP addresses for this host record. Include the |IP addresses for all nodes.

To find the IP addresses in the Qumulo Core Web Ul, click Cluster > Network
Configuration.

4, Configure the DNS resolver to point to the DNS server.

To find the IP addresses, look up the hostname for the DC. For example:

nslookup stuff.example.com

5. Confirm that successive ping <cluster name> requests connect to a different IP address

every time.

Configuring the Service Principal Name (SPN) for NFS

The SPN is a string that identifies the Kerberos services that a particular host provides. We

recommend configuring the Qumulo cluster to provide the NFS service. When you configure the

SPN, clients can enumerate the cluster and the NFS service as part of a service-ticket-granting
request.
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To Configure the SPN for NFS by Using the Windows Server Attribute Editor

O Note
To maximize compatibility with Linux, we recommmend formatting SPN entries in lowercase.

1. Use RDP to log in to the DC for your AD domain.
2. Open Active Directory Users and Computers.
3. Find the machine account for your Qumulo cluster.

To find the machine account name in the Qumulo Core Web Ul, click Cluster > Active
Directory and write down the name under Machine Account.

4. Right-click the account and then click Properties > Attribute Editor.

5. On the Attribute Editor tab, find the servicePrincipalName attribute and edit its value to
include a new SPN in the nfs/<machine account>.<domain fqdn> format, for example:

nfs/<qumulo-cluster>.ad.eng.example.com

™ Tip
You can use the other, automatically generated entries as syntax examples.

To Configure the SPN for NFS by Using the Windows Server Command Prompt

O Note

- To maximize compatibility with Linux, we recommend formatting SPN entries in
lowercase.

- The SPN formatting in the following example is generally sufficient for Linux service
ticket requests. However, depending on your environment and client configuration,
additional entries might be necessary.

1. Open acommand prompt with administrative privileges.
2. Use RDP or SSH to connect to your AD domain.

3. Runthe setspn command with the machine account (in this example, <qumulo-
cluster> ) followed by a period ( . ) and the FQDN (in this example, ad.eng.example.com ).
For example:
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setspn -s nfs/<qumulo-cluster>.ad.eng.example.com

4, Confirm the configuration by using the setspn command with the machine account
name. For example:

setspn <qumulo-cluster>

To Troubleshoot Your SPN Configuration

If your SPN is configured incorrectly, a client is likely to display the following error:

mount.nfs: access denied by server while mounting <qumulo-cluster>.ad.eng.qumulo.co
m:/

1. Take a client-side packet capture and find the logs for the client and AD Kerberos.
2. Search the logs forthe S PRINCIPAL UNKNOWN error.

3. Add the required client parameters to the SPN configuration.

Configuring SPN with DNS

For Kerberos authentication to work correctly, SPN entries must correspond to DNS A records
exactly. Although the machine account is sometimes the same as the DNS A record created
during the domain-join process, depending on your the DNS environment, this might not always
be true.

In the following example, a Qumulo cluster has a machine account with the SPN nfs/
qumulo.example.com and two DNS A records that point to the same Qumulo cluster IP,
203.0.113.0:

qumulo.example.com
storage.example.com

Because the storage.example.com doesn't have a corresponding SPN, you can perform Kerberos
authentication by using the qumulo.example.com record. However, if you add the second SPN
(nfs/storage.example.com) to the machine account account SPN list, the account can
authenticate by using either of the two hostnames.
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CNAME (alias) records are an exception to this arrangement. CNAME records that point to a
correctly-configured A record, and which have a corresponding SPN entry in the machine
account, don't require the CNAME host to be added to the SPN. For example, the CNAME record
storage-alias.example.com that pointsto storage.example.com requires the SPN list to contain
only nfs/storage.example.com to authenticate against storage-alias.example.com.
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Performing Additional Cluster Configuration after
Joining Active Directory

This section describes additional Qumulo cluster configuration that can affect the behavior of
NFSv4.1 with Kerberos.

When your Qumulo cluster is joined to AD (page 200), you must configure the NFSv4.1 server

(page 177) and NFSv4.1 security settings.

To Configure Security Settings by Using the qqg CLI

Qumulo provides configuration for the permitted NFSv4.1 authentication flavorsin the qq CLI or
directly through the Qumulo Core REST API.

1. Runthe qq nfs get settings command to get the current settings.

The following is example output.

$ qq nfs get settings

{
"auth sys enabled": true,
"krb5 enabled": true,
"krb5p _enabled": true,
"krbi enabled": true,
"v4 enabled": false

}

This is the default configuration:
NFSv4.1is disabled by default.

AUTH SYS, AUTH KRB5, AUTH KRB5P,and AUTH KRB5I are enabled by default (however,
Qumulo Core doesn't support Kerberos configuration on NFSv3).

2. To harden security, configure your cluster to use only Kerberos by disabling AUTH SYS
(without changing AUTH KRB5 ). For example:

A Important

Because it uses authentication based on a simple UID and GID passed over the wire

in plain text, RPC AUTH_SYS is inherently insecure. In a trusted environment, AUTH_SYS

might be sufficient for enforcing basic permissions and preventing good-faith actors
from making mistakes. In all other cases, you must treat AUTH SYS as if it provides no

security whatsoever.
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$ qq nfs modify settings --disable-auth-sys
"v4 enabled": false,
"auth sys enabled": false,
"auth krb5 enabled": true,

"auth krb5p enabled": true,
"auth krb5i enabled": true

3. (Optional) You can also run the following commands.

gqq nfs modify settings

--enable-auth-sys Enables AUTH SYS without changing AUTH KRB5

qq nfs modify settings

--enable-krb5 Enables AUTH KRB5 without changing AUTH SYS

gqq nfs _modify settings

--enable-krb5p Enables AUTH KRB5P without changing AUTH SYS
qq nfs modify settings

--enable-krb5i Enables AUTH KRB5I without changing AUTH SYS
qq nfs modify settings

--enable-v4 Enables NFSv4.1

qq nfs modify settings

--disable-v4 Disables NFSv4.1

gq nfs _modify settings

--disable-krb5 Disables AUTH KRB5 without changing AUTH SYS

qq nfs modify settings

--disable-krb5p Disables AUTH KRB5P without changing AUTH SYS

gqq nfs modify settings
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--disable-krb5i Disables AUTH KRB5I without changing AUTH SYS

O Note

Security configuration options apply to all versions of NFS (NFSv3 and NFSv4.1). Thus,
disabling AUTH_SYS also disables NFSv3, because AUTH_SYS is the only Kerberos security
flavor (page 198) that NFSv3 supports by design.

In a secure environment, where Kerberos is required, AUTH_SYS NFSv3 connections
aren't allowed.

- These configuration options apply cluster-wide to all NFS exports and files.

Configuring Export Configuration
You can use NFSv4.1 exports (page 177) to configure access to the Qumulo file system.

The user-mapping portion of the export configuration has no effect on Kerberos configuration.
Specifying root or any user mapping for a particular export applies only to AUTH SYS mounts
that access this export.

Otherwise, exports and |P address restrictions (that you specify in exports) behave identically for
all Kerberos security flavors (page 198): AUTH SYS, AUTH KRB5, AUTH KRB5P,and AUTH KRB5I .
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Using Kerberos Permissions in the Qumulo File System

This section describes how NFSv4.1 interacts with the secure file permissions that Kerberos
enables for the Qumulo Core file system.

For more information, see Qumulo File Permissions Overview on Qumulo Care.

Listing Permissions for Files

O Note

- This section uses the Kerberos term trustee and Qumulo term identity (or auth_id)
interchangeably.

- The term file in the Qumulo file system can refer to:
o Afile
o Adirectory
o Asymbolic link

o A special block device

All files in the Qumulo file system have the following fields associated with them:
Owner
Group owner
- Access control list (ACL)—a list of access control entries (ACESs)

These fields, stored in the metadata for a file or directory, determine the access permissions that a
trustee or identity has to files.

For any file operation, the system checks the authenticated user against file permissions to
determine whether the operation should be allowed. When you create a new file, the
authenticated user becomes the owner of the new file.

In the following example, we create a file in a mount over NFS.
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O Note

Because this example uses an AUTH SYS mount, it has UID and GID identity values set

to 1000.

- We recommend becoming familiar with the following commmands to better
understand the various elements for permissions types that the system stores on

disk.

touch /mnt/mount point/filename

To view the exact permissions metadata for this file, run the qq fs file get attr command. For

example:

$ qq fs file get attr --path /filename

{

"group details": {

"id type": "NFS GID",
"id value": "1000"

}

"owner details": {
"id type":

"NFS _UID",

"id value": "1000"

b

To view the permissions configured in an ACL, run the qq fs get acl command. For example:

$ qq fs get acl --path /filename

Control: Present

Posix Special Permissions: None

Permissions:

Position Trustee Type Rights

1 uid:1000 Allowed Delete child, Read, Write file
2 gid:1000 Allowed Delete child, Read, Write file
3 Everyone Allowed Read
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Listing Security Identifiers (SIDs)

The SID is a globally unique identifier for a user or group object in a domain. For more
information, see Security identifiers in the Microsoft documentation.

Because Qumulo’s Kerberos implementation requires AD, every user is also an Active Directory
user. The domain controller (DC) has an equivalent mapping for AD users and SIDs. Qumulo uses
LDAP to determine the AD-user « SID mapping. For this reason, it is important to configure the
Base DN for your cluster correctly.

Qumulo’s Kerberos implementation stores SIDs on disk for files that have Kerberos identities in
the user, group, or ACL. When a user authenticates by using Kerberos and creates a file, Qumulo
Core configures the user, group, and ACL automatically.

To set the identity for an AD user, you can modify the permissions for an existing file by using the
chown or nfs4 setfacl command.

In the following example, the Kerberos-authenticated AD domain user AD\myusername creates a
file over NFSv4.1 and the system gives an ACL response from the Qumulo Core REST API. The
response contains an ACE entry for the owner and group owner of the user AD\myusername , with
corresponding SIDs for both.

$ gqq fs get acl --path /filename --json

{
"aces": [{
"trustee": {
"name": "AD\\myusername",
"sid": "S-1-5-21-1234567890-4567890123-9876543210-13507",
}
oA
"trustee": {
"name": "AD\\Domain Users",
"sid": "S-1-5-21-1234567890-4567890123-9876543210-513",
Y
11
}

Using Kerberos Principals

Although Qumulo stores SIDs on disk, SIDs appear rarely when you use NFSv4.1 on Linux systems.

Instead, the system represents Kerberos identities as Kerberos principals. A Kerberos principal, a
string in the <user@domain> or <group@domain> format, is easier to read.
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O Note
There is an equivalent mapping between AD users, SIDs and Kerberos principals. Each of
these representations is unique (a primary key to the AD identity database).

Qumulo’s implementation of the SID « Kerberos principal mapping uses the sAMAccountName
field, which is always present and unique for all AD users and groups. The system forms the
Kerberos principal by concatenating the name and domain in the <sAMAccountName>@<domain>
format.

AD has fields with similar content but without the guarantee of uniqueness (such as the name,
distinguishedName, CN, and servicePrincipalName ). However, AD permits setting these fields to
unrelated values. For this reason, it is unlikely but possible that certain environments use special
values in these fields. Qumulo's Kerberos implementation ignores these fields and uses only the
value in the sAMAccountName field.

O Note
The fields can diverge significantly if an administrator edits them.

The following example shows how the system represents the SIDs from the previous example as
Kerberos principals.

$ nfs4 getfacl filename
A::test2@ad.eng.qumulo.com: rwatTnNcy
A:g:Domain Users@ad.eng.qumulo.com:rtncy
A: :EVERYONE@: rtncy

Although the system stores raw SIDs on disk, the nfs getfacl command displays users and
groups as Kerberos principals. This format is valid for setting identities on a file by using
commands such as nfs4 setfacl, chown,and soon.

Understanding Kerberos Principal Caveats
This section explains some of the caveats of working with Kerberos principals.
Machine Account Object Names

When you work with machine accounts, AD stores the sAMAccountName as the object name and
appends $ toit.If aclient named myclient isjoined to the domain stuff.example.com, the
name of the machine account object in Active Directory Users or Computers appears as
myclient while the Kerberos principal representation over NFS appears as
myclient$@stuff.example.com.

This functionality is different from other account types in AD, where the object name usually
matches the sAMAccountName exactly.
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ID Mapping on Linux systems

Linux systems perform their own ID mapping separately from the Qumulo cluster ID mapping.
Linux systems also use sAMAccountName as the AD user primary key when joined to an AD domain.
However, Linux systems use CN when looking up groups. Thus, in groups where the
sAMAccountName and CN don't match (possibly due to edits by an administrator), a Linux system
and Qumulo Core might understand differently the group that the Kerberos principal refers to.

Ensure the two fields are in sync to prevent the following possible scenarios:
- An error appears when you configure the group.
Group configuration succeeds but the configured group is incorrect.

Unicode Characters in Kerberos Principals

For most standard Linux tools, Qumulo Core supports all arbitrary Unicode characters in Kerberos
principals. However, we don't recommend using the period ( . ) character in principals, except in
the domain name.

Using the chown Tool With Kerberos

chown is a Linux tool that changes the owner or group owner for a file. You can generally use
chown with Kerberos principals. On most Linux systems, chown requires the root user ( sudo
chown ).

The AUTH_SYS Root User

AUTH SYS has the concept of the root user. Using sudo on a Linux NFS client fillsin 0 for the UID
and GID. As long as the mounted export doesn’'t root squash—maps a client's UID 0 (root) to
65534 (nobody) or to another non-root user—the Linux client receives root permissions on the
Qumulo file system, where the client can perform chown operations.

The Kerberos Root User

Kerberos doesn’'t have the concept of the root user. However, you can still use it to run chown
operations under the following conditions.

- The ACL for the file must grant the CHANGE OWNER privilege to an authenticated user.

- The currently authenticated user must be a member of the destination group (if provided)
or a member of the current group (if the group isn't being modified).

If both conditions are true, a chown operation on files performed as a Kerberos user over NFSv4.1
succeeds. For example:

$ chown user3:group4 filename
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O Note
Including @<domain> for the destination user and group is optional.

Viewing the Owner and Group

The following examples show how to display user and group membership by using the 1s -1
and stat -c commands.

$ ls -1 filename
-rw-r--r-- 1 user3 group4 0 Jun 9 23:18 filename

$ stat -c 'sU, %G' filename
user3, group4

0 Note
The Kerberos restrictions for chown also apply to other Linux tools that use the chown system
call, such as cp and rsync, when you run them in ownership-preserving modes.

Using the Linux ACL Editor

The Linux ACL Editor consists of the following tools:
nfs4 editfacl
nfs4 getfacl
nfs4 setfacl

You can use the editor to read and write ACLs on a Qumulo cluster that uses NFSv4.1 with

Kerberos. For more information, see Managing File Access Permissions by Using NFSv4.1 Access

Control Lists (ACLs) (page 184).
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Configuring a Linux Client for NFSv4.1 with Kerberos

This section describes how to configure a Linux client for using NFSv4.1 with Kerberos.

O Note
Qumulo Core supports only Linux for using NFSv4.1 with Kerberos.

Linux systems implement Kerberos support as a series of loosely related packages and
configuration files. For this reason, configuration depends on the Linux distribution and version.
This section refers to tools, packages, deemons, configuration files, and other elements in Ubuntu
18.04 LTS.

Joining a Linux Client to a Domain

There are two common ways of joining a Linux client to an Active Directory (AD) domain
automatically, by using samba or realmd.Both methods require creating the /etc/krb5.conf
configuration file and defining a default domain and the relationships between domains and
realms.

Configuring the /etc/krb5.conf File

The following is an example configuration for joining a domain.

[libdefaults]
default realm = MY-DOMAIN.EXAMPLE.COM

[realms]
MY -DOMAIN.EXAMPLE.COM = {
kdc = my-domain.example.com:88
admin_server = my-domain.example.com:749

}

[domain realm]
my-domain.example.com = MY-DOMAIN.EXAMPLE.COM
.my-domain.exmaple.com = MY-DOMAIN.EXAMPLE.COM

To Join a Linux Client to a Domain by using samba

samba is a suite of Linux tools that provides Windows-like functionality on Linux. The net ads
join command creates a machine account on the domain.

1. To specify how the domain-join process behaves, edit the /etc/samba/smb.conf file. For
example:

216


https://web.mit.edu/kerberos/krb5-1.12/doc/admin/conf_files/krb5_conf.html
https://web.mit.edu/kerberos/krb5-1.12/doc/admin/conf_files/krb5_conf.html
https://www.samba.org/samba/docs/current/man-html/net.8.html

workgroup = my-domain

server role = member server
realm = my-domain.example.com
kerberos method = system keytab

2. Tojoin the domain, run the net ads join command. For example:

$ net ads join my-domain.example.com -U Administrator

3.
For more information, see Mapping External Identities to Linux Identities (page 218).

To Join a Linux Client to a Domain by using realmd

realmd is a tool that allows managing realm-based authentication. It can be somewhat more

difficult to use than samba . However, it creates a more complete configuration. For example, it
configures the sssd tool during the domain-join process.

1. Tojoin adomain, runthe realm join command. For example:

$ realm join my-domain.example.com -U Administrator

2. Configure the sssd and idmapd tools manually. For more information, see Mapping
External Identities to Linux Identities (page 218).

To Configure DNS and Service Principal Name (SPN)

Kerberos relies on DNS to identify machines involved in authentication. NFS clients and servers
require DNS A records for forward-DNS look-ups and PTR records for reverse-DNS look-ups.

1. After you configure DNS, check DNS resolution from your client. For example:

$ nslookup my-client-machine.my-domain.example.com

2. In addition to DNS configuration, Linux clients require a standard host SPN on the

machine account created while joining the domain. We recommend configuring the SPN

by using the setspn command on the domain controller after the join procedure. For
example:

samba doesn’'t create configuration files. Configure the sssd and idmapd tools manually.
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O Note
Running this command resets the SPN to the default value for your machine.

setspn -r my-client machine

Mapping External Identities to Linux Identities

During the ID mapping process, a Linux system converts external identities to Linux identities.
For Qumulo Core, external identities are equivalent to Kerberos principals.

For Linux, identities are simple integers: UIDs and GIDs.

O Note
Because Linux can't use complex external identities in system calls, a Linux system must

perform identity conversion before operating on files.

ID mapping is bidirectional. A system call, such as chown , that takes a UID or GID as input requires
mapping the UID or GID be mapped to a domain user or group before passing it to your Qumulo

cluster over NFS.

A system call, such as stat, that returns a UID or GID, requires that the domain user or group

that returned from your Qumulo cluster over NFS be converted to a UID or GID before the system

can present it to the user.
Configuring Active Directory Authentication by using sssd

sssd (System Security Services Daemon) is a tool responsible for managing authentication with
external providers in Linux. To use NFSv4.1 with Kerberos, you must configure sssd with AD as

the identity provider.
If you join domains by using samba , you must create the /etc/sssd.conf file.

If you join domains by using realmd , you might already have a /etc/sssd.conf file. For
detailed configuration information, see sssd-ldap in the Linux documentation.

In the following example, the sssd.conf file configures basic ID mapping for AD.
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[sssd]

domains = my-domain.example.com
config file version = 2
services = nss, pam

[domain/my-domain.example.com]

ad domain = my-domain.example.com
krb5 realm = MY DOMAIN.EXAMPLE.COM
cache credentials = True

id provider = ad

krb5 store password if offline = True
default shell = /bin/bash
ldap id mapping = False

use fully qualified names = False
fallback homedir = /home/%u@%sd
access provider = ad

Configuring LDAP Queries against the Domain Controller (DC) by using sssd

Like Qumulo clusters, Linux systems can resolve details about user and group objects by querying
the DC over LDAP. In particular, a Linux system looks for an object with a matching
sAMAccountName (user) or CN (group)

1. Totoggle RFC 2307 for mappings in the sssd.conf file, configure the ldap_id_mapping
field.

When you set the field to False, the client checks whether the RFC 2307 uidNumber or
gidNumber are set on an object.

o Ifthe number is set, it becomes the Linux UID or GID for the operation.

A Important

AD doesn't prevent duplicate UID or GID numbers from being added to RFC 2307 values.
For this reason, incorrect configuration can lead or UID or GUID collisions. When a Linux
system determines that a collision has occurred, it chooses the first UID or GID it finds.

o Otherwise, the UID or GID becomes nobody or nogroup (65534 ).

O Note

In mMost cases, an owner or group becomes 65534 as a result of incorrect user mapping
configuration in the client. To understand which LDAP queries run and why they have
trouble finding the correct information, check your logs.

When you set the field to True, the client assigns locally a new unique UID or GID to each
objectSID that it finds on the DC.
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O Note
This is a more flexible approach than requiring RFC 2307. However, this also means that

UIDs and GIDs aren't the same across different Linux systems within the same domain.

In both cases, the client communicates with the DC by using its machine account.
2. To pick up changes tothe /etc/sssd.conf file on a live system, restart the sssd service.
Configuring the Conversion of Local Identities to NFS Representations by Using idmapd

idmapd (or nfsidmap), is a tool that lets you convert local identities to their on-the-wire NFS
representations. Although idmapd works with sssd, it has additional configuration options.

In the following example, the /etc/idmapd.conf file configures a Linux client joined to AD:

[General]
Domain = my-domain.example.com

Verbosity = 0
Pipefs-Directory = /run/rpc_pipefs

[Mapping]
Nobody-User = nobody
Nobody-Group = nogroup

O Note
Depending on your Linux distribution and configuration, you might have to add the Domain

field to the default configuration file.

Authenticating as an AD User and Mounting Your Qumulo Cluster

Qumulo Core supports three methods of authenticating as an AD user and mounting your cluster
over NFSv4.1 as the AD user. These methods, from least to most complex, and in an increasing

order of utility, are:
By using a machine account

By using manual authentication with the kinit tool

By using the autofs tool
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To Authenticate as an AD User by Using a Machine Account and Mount Your Qumulo
Cluster

Machine account authentication uses one AD user for each Linux system. This machine account
useris the same as the machine account created on the domain during the domain-join
operation. Any user on the Linux system who has access to the machine account mount point
can operate as the machine account user on a Qumulo cluster.

Machine account authentication can be useful for simple scenarios in which trusted users on
trusted Linux machines require a secure mechanism for communicating with a Qumulo cluster.
Because this is also the easiest authentication method to configure, it can be a good starting
point for administrators who configure NFSv4.1 with Kerberos for the first time.

O Note
Both machine account authentication and kinit have limited usefulness because they limit

the mount point to a single authenticated user. Between the two authentication options,
kinit has an advantage because of the way it handles ID mapping.

1. Confirm that your /etc/nfs.conf file, contains the following flag.

[gssd]
use-machine-creds=true

The use-machine-creds flag specifies whether authentication uses machine credentials
when sudo mount is invoked for NFSv4.1 with Kerberos. When you set the flag to true,
gssd authenticates as the machine account for the system on behalf of the NFS client. (It
performsa kinit operation as the machine account). The credential cache that results

from the kinit is usually located in /tmp . To search for the cache, run the 1s
/tmp/*krb5* command.

O Note

In versions of Ubuntu lower than 22.04 (and possibly on other Linux distributions), you
can't use the /etc/nfs.conf file to configure gssd. If this is the case for your system,
we recommend starting the rpc.gssd service by using the -n flag.

2. Mount your cluster by using the krb5 security mechanism. For example:

$ sudo mount -0 vers=4.1,sec=krb5 my-cluster.my-domain.example.com:/ /mnt/poin
t

3. Use the Qumulo file system.
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$ cd /mnt/point
$ touch filename
$ ls -1 filename

-rw-r--r-- 1 MY MACHINES$ domain computers 0 Jun 9 23:18 filenam
e

A Important
The machine account is the owner of any new files.

If the machine name isn't visible, make sure that the AD container holds this machine in the
Qumulo cluster’s Base DN configuration (typically, CN=Computers,DC=... ). If the machine name is
still not visible, configure the Linux client ID mapyper to provide local mappings when no RFC
2307 mapping is available. It is uncommon for machine accounts to have RFC 2307 mappings.

To Authenticate as an AD User Manually by Using kinit and Mount Your Qumulo Cluster

kinit authentication is very similar to machine account authentication. The main difference is that
you must create the credentials for the mount manually. You can use any user in the AD domain.
However (this is also true for machine accounts), any local Linux user that can access the mount
point can operate on the Qumulo cluster as this single user.

O Note

Both machine account authentication and kinit have limited usefulness because they limit
the mount point to a single authenticated user. Between the two authentication options,
kinit has an advantage because of the way it handles ID mapping.

In environments where Linux systems map exactly to end users that have kinit -based Kerberos
mounts on their Qumulo clusters, kinit might be sufficient.

1. Authenticate by using kinit . For example:

$ sudo kinit my-user

2. When prompted for a password, use the AD domain password for the user.
3. To confirm the result of the authentication operation, run the sudo klist command.

4. Confirm that the /etc/nfs.conf file contains the following flag:
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[gssd]
use-machine-creds=false

The use-machine-creds flag specifies whether authentication uses machine credentials
when sudo mount is invoked for NFSv4.1 with Kerberos. When you set the flag to false,
gssd searches for an existing credential cache (which you created by running kinit)in
/tmp/krb5cc 0 for authenticating with the Qumulo cluster.

5. Mount your cluster by using the krb5 security mechanism. For example:

$ sudo mount -0 vers=4.1,sec=krb5 my-cluster.my-domain.example.com:/ /mnt/poin
t

6. Use the Qumulo file system.

$ cd /mnt/point

$ touch filename

$ 1s -1 filename

-rw-r--r-- 1 my-user domain users © Jun 9 23:18 filename

A Important
The kinit user is the owner of any new files.

To Authenticate as an AD User Manually by Using autofs and Mount Your Qumulo
Cluster

autofs is a deemon that manages mount points for individual Linux users. For this reason, Linux

users have different views of a mount point. autofs can authenticate an AD user through ssh,
the Linux file system, or a Qumulo cluster mounted on a Linux system.

A Important
When you use autofs, the Linux system maps the root user to the machine account user for
the Linux system on the Qumulo cluster. However, the machine account user doesn’'t have all

the privileges of the root user, such as special permissions for the Qumulo cluster. You must
specify all permissions in ACLs.

1. Logintoan AD domain and configure sssd to authenticate with this domain. For
example:
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$ sudo login my-domain-user

Alternatively, you can run the following command.

$ ssh my-domain user@my-linux-system

2. Configure the autofs mappings. For more information, see auto.master in the Linux
documentation. The following is an example of a simple configuration that provides a
single (direct) mount point which authenticates AD users automatically.

a. To define a mount point and the path to its map file, add the following line to the
/etc/auto.master file.

/- /etc/auto.kerberos nfs mount example --timeout 60

For more information, see Autofs in the Ubuntu documentation.

b. Add the following line to the /etc/auto.kerberos nfs mount example map file.

/mnt/qumulo mount point -vers=4.1,sec=krb5 <qumulo-cluster>.my-domain.e
xample.com:/

3. Restart autofs.

$ sudo systemctl restart autofs

autofs createsthe /mnt/qumulo mount point directory and mounts it as necessary for
any user. For example:

$ ssh domain user 1l@my-linux-system touch /mnt/qumulo mount point/userl file
$ ssh domain user 2@my-linux-system touch /mnt/qumulo mount point/user2 file
$ ssh domain user 3@my-linux-system ls -1 /mnt/qumulo _mount point

-rw-r--r-- 1 userl domain users © Jun 9 23:18 userl file
-rw-r--r-- 1 user2 domain users © Jun 9 23:18 user2 file
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A Important
The user you logged in to the AD domain with is the owner of any new files.

Network Time Protocol (NTP) Server

Kerberos is very sensitive to clock skew. It is important for all systems involved in a Kerberos
relationship—the KDC, your Qumulo cluster, and any Linux clients—to have as little clock skew as
possible. We recommend using the same NTP server for all three components.

- You can use your AD domain controller as an NTP server. In the Qumulo Core Web Ul, on
the Active Directory page, for Use Active Directory as your primary time server, click Yes.

- To configure any other NTP server in the Qumulo Core Web Ul, click Cluster > Date & Time.

There are many NTP daemons for Linux. For example, Ubuntu uses the NTP functionality in

systemd ( timedatectl and timesyncd ).
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Configuring Cross-Domain Active Directory Trusts

This section describes how the configuration of cross-domain Active Directory (AD) trusts
supports NFSv4.1 with Kerberos.

Trusts are relationships between different AD domains. For more information, see Trust
Technologies in the Microsoft documentation.

NFSv4.1 with Kerberos and the general AD configuration in Qumulo Core support the same forms
of trust relationships.

Child or parent trusts can:

o Authenticate as a user from the child domain against the parent domain's AD
domain controller (DC).

o Authenticate as a user from the parent domain against the child domain’'s AD DC.

- Transitive trusts can authenticate as a user from any of the domains in the transitive trust,
against any of the other trusted domains' AD DC.

Configuring the Base DN

For identity mapping to work, you must configure LDAP Base DNs correctly on your Qumulo
cluster and on your client. This helps avoid nobody or 66534 identity responses that occur when
you inspect files that contain trusted users (stored as identities) from other domains. For more
information about configuring the Base DN, see Using Active Directory for POSIX Attributes in
Qumulo Core.

The following example has trust between between parent.example.com and child.example.com.
In order for both domains' identities to authenticate against a Qumulo cluster, you must
configure the cluster and your client with the following Base DN.

CN=Users,DC=parent,DC=example,DC=com;CN=Users,DC=child,DC=parent,DC=example,DC=com

O Note

AD doesn't prevent duplicate UID or GID numbers from being added to RFC 2307 values.
Such improper configuration can cause UID and GID collisions across trusted domains. On
Linux, if any collisions occur, the system chooses the first UID or GID that it finds.

Enabling More Secure Trust Encryption Types

While Linux systems disallow deprecated encryption types for Kerberos, Windows prefers RC4 for
cross-domain traffic (which Linux systems consider to be deprecated).
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For certain trust configurations, you must enable a more secure encryption type for trusted
traffic. To enable AES-128 (or SHAT) and AES-256 (or SHAI) for a particular trust, run the ksetup
command in a Windows Administrator console. For example:

$ ksetup /getenctypeattr <domain>

$ ksetup /setenctypeattr <domain> RC4-HMAC-MD5 AES128-CTS-HMAC-SHA1-96 AES256-CTS-HM
AC-SHA1-96

O Note
This example doesn't disable RC4. Instead, it enables new encryption types in addition to
RC4. When working with Windows systems, we recommmend making additive changes

whenever possible. We also recommmend staging changes in a safe environment before
applying them to a production environment.
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Troubleshooting NFSv4.1 with Kerberos

This section describes common troubleshooting procedures for configuring NFSv4.1 to work with
Kerberos.

Following General Debugging Techniques
This section lists common debugging techniques.
To Turn Up Logging Levels for Client-Side Tools

1. Inthe /etc/sssd.conf file, set debug level = 9.

2. Inthe /etc/idmapd.conf file, set Verbosity = 9.

3. Inthe [gssd] section of the /etc/nfs.conf file, set verbosity=9 and rpc-verbosity=9.

0 Note

In versions of Ubuntu lower than 22.04 (and possibly on other Linux distributions), you
can't use the /etc/nfs. conf file to configure gssd. If this is the case for your system,
we recommend starting the rpc.gssd service by using the -n flag.

4. Turnon rpcdebug, for example:

rpcdebug -m nfs -s all && rpcdebug -m rpc -s all

Taking a Client-Side Packet Capture

Normally, there should be:
Kerberos and LDAP traffic between the client and the domain controller
DNS traffic between the client and DNS server
RPC or NFS traffic between the client and the Qumulo cluster

Because a Kerberos mount requires the client to perform a series of steps, in most cases, the last
traffic that the client issues indicates the source of failure. To view encrypted Kerberos traffic, use
Wireshark with a Kerberos keytab file. For more information, see Kerberos in the Wireshark
documentation.

For help with interpreting logging and metrics from your Qumulo cluster and for insights from
the telemetry of our Kerberos implementation, contact the Qumulo Care team.
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Resolving Incorrect Display of Users or Groups

Under certain conditions, users or groups display as nobody when you run the 1s -1 or stat
command.

Differentiating Client and Cluster Issues

To resolve this issue, determine whether it is with the client or with the cluster by running the
nfs4 getfacl command on a file. If the presentation in the ACL editor appears correct, the issue
is with the client. Otherwise, the issue is with the cluster.

O Note
The ACL editor doesn't perform any ID mapping. It only passes ACE trustees through, in
plaintext.

Resolving Client-Side Issues

If the issue is with the client, it is most often an ID mapping issue. Confirm that your mappings
are configured correctly. For more information, see User-Defined |dentity Mappings on Qumulo
Care.

If the issue persists, investigate logging and packet captures.

Resolving Cluster-Side Issues

If the issue is with the cluster, confirm that your cluster’s Active Directory settings include the
Base DNs that contain the expected users. For more information, see Prerequisites for Joining a
Qumulo Cluster to Active Directory (page 200).

Diagnosing Mount-Failed Errors

Under certain conditions, you might receive mount-failed errors from mount.nfs . To diagnose this

type of error, you can try the following procedures.
1. Confirm that the rpc.gssd service is running.

2. Confirm that the cluster and client both resolve from the client. It should be possible to
reach the cluster and client through a fully qualified domain name (FQDN), such as my-
machine.my-domain.example.com.

3. Confirm that reverse DNS works for the IP addresses on both the client and the cluster.

4. Confirm that the client has a host service principal name (SPN) and that the cluster has
an nfs SPN that matches the DNS records.

5. Do one of the following:

If you use a machine account or kinit authentication, confirm that the credentials are
correct. You can run the keytab ktutil command or the credential cache klist command
to list the encryption methods.
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Confirm that Kerberos tickets use AES-128 or AES-256 for service encryption by examining a
packet capture or your Active Directory Kerberos settings.

6. If you use domain trusts, confirm that trust has AES-128 or AES-256 enabled.

7. Confirm that the clocks on the client, cluster, and domain controller are synchronized to

the same time.

8. Inspect logs and packet captures.
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SMB

Creating and Managing an SMB Share in Qumulo Core

This section explains how to create, modify, and delete an SMB share by using the Qumulo Core

Web UlI.

To Create an SMB Share
1. Log in to the Qumulo Core Web Ul.

2. Click Sharing > SMB Shares.

3. On the right side of the SMB Shares page, click Create Share.

4. On the Create SMB Share page:

a.

b.

C.

g.

Enter the File system path from the root of your file system.

To create a new directory, click Create new directory if it doesn't exist.
Enter the Share name (for example, \\203.0.113.0\my-share ).

Enter the Description for the share.

To display only the files and directories to which the user has read access, click
Enable access-based enumeration.

To force users to connect over SMB3 (and higher) by using encryption-enabled
clients, click Require encryption.

Under Share Permissions, enter trustees and specify their:

Permission type: Click Add allow or Add deny.

O Note

To ensure that Qumulo Core processes users to whom it explicitly denies access
before processing users to whom it grants access, Deny entries appear at the top
of the list and Allow entries at the bottom.

Permissions: Click Read, Write, or Change Permissions.

h.

To delete a trustee, click m

Under Advanced Options:
a. Enter the Default file create mode ( 0644 by default).

b. Enter the Default directory create mode ( 0755 by default).
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5. Click Create Share.

To Modify an SMB Share
1. Login to the Qumulo Core Web Ul.
2. Click Sharing > SMB Shares.

3. For an SMB share, in the Actions column, click E .

4. Make changes to your SMB share (for more information, see To Create an SMB Share
(page 231)) and then click Save.

To Delete an SMB Share
1. Login to the Qumulo Core Web Ul.

2. Click Sharing > SMB Shares.

3. For an SMB share, in the Actions column, click @ )

4. In the Delete Share dialog box, click Yes, Delete Share.
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Managing Qumulo Core File Shares by Using the Shared
Folders MMC Snap-In

By connecting the Shared Folders Microsoft Management Console (MMC) Snap-In to your
Qumulo cluster, you can manage file shares centrally.

O Note
To perform the following operations, you must use a Qumulo Core account with the
Administrators or Data Administrators role.

Prerequisites
Windows 7, Windows Server 2008 R2 (or higher)

To Connect a Windows Machine to the SMB Shares on Your Qumulo
Cluster

1. In Command Prompt, run the net use command to connect to your Qumulo cluster. For
example:

net use \\mycluster.example.com /user:admin

2. When prompted, enter your credentials.
3. In MMC, click File > Add/Remove Snap-in...

4. In the Add or Remove Snap-ins dialog box, under Available snap-ins, click Shared Folders,
and then click Add.

5. In the Shared Folders window, in the left pane, right-click Shared Folders (<JSMITH-
WORK-DESKTOP>), and then click Connect to another computer...

6. Inthe Shared Folders dialog box:

a. Under This snap-in will always manage, click Another computer and enter your
cluster’s hostname, for example mycluster.example.com.

A Important

Don't place a slash (/) after your cluster’s hostname. Although the Shared
Folders snap-in doesn't display an error message in case of failure, adding the
slash after the hostname causes the operation to fail.

b. Under View, click All.
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c. Click Finish.
MMC adds the Shared Folders snap-in to its left pane, under Console Root.
7. (Optional) To view the existing shares on your Qumulo cluster, expand Shared Folders

(\MYCLUSTER.EXAMPLE.COM) and then click Shares.

To Connect Your Qumulo Cluster to a Share on Your Windows Machine

O Note
Shared folder permissions are unrelated to NTFS access control lists (ACLS).

1. In MMC, click Shared Folders (<JSMITH-WORK-DESKTOP>) and then on the menu bar
click Action > New Share...

2. In the Create a Shared Folder Wizard: Folder Path dialog box, for Folder path, specify the
path for the SMB share (for example C:\Users\Jennifer\Reports )and then click Next.

0 Note
If you click Browse..., you might see the g$ parent item in the directory tree. The is the
root (/) of the file system.

3. In the Create a Shared Folder Wizard: Name, Description, and Settings dialog box:
a. Enter the Share name, for example jennifer-reports.
b. Enter the Share path, for example \\JSMITH-WORK-DESKTOP\jennifer-reports .
c. Click Next.

4. In the Create a Shared Folder Wizard: Shared Folder Permissions dialog box, select one of
the following permissions for the shared folder:

- All users have read-only access
- Administrators have full access; other users have read-only access
- Administrators have full access; other users have no access
- Customize permissions
™ Tip
We recommend clicking Customize permissions and then, in the dialog box, giving Full

Control to the group Everyone.

5. Click Finish.
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6. To confirm that your SMB share is visible to your Qumulo cluster, log in to the Web Ul and
click Sharing > SMB Shares.

To Change the Configuration for an Existing Share on Your Windows
Machine

1. In MMC, click Shared Folders (<JSMITH-WORK-DESKTOP>) and then in the right pane
right-click an existing share and then click Properties.

2. In the File Properties dialog box, on the General tab, you can edit properties such as Share
name, Folder path, Description, and User Limit.

© Note

- The settings of the User limit and Offline Settings... properties have no effect on
your Qumulo cluster.

- The path C:\ represents the root (/) of your Qumulo file system.

3. On the Share Permissions tab, ensure that the permissions for various users and groups
are correct.

© Note

It is possible to add local users and groups from your Qumulo cluster by prefixing
them with the name of your cluster followed by a backslash (\). For example:
accounting\admin

Because, if you don't select Full Control, there is a minor mismatch between the
rights that Windows Change Permissions grants and the Qumulo Core Web Ul
Write permissions. For this reason, share permissions configured by using the
MMC appear with an asterisk (*) in the Qumulo Core Web Ul. We recommend
using Qumulo Core to configure share permissions.

4, On the Security tab, ensure that the file permissions for the directory subtree under the
share are connected.

5. To save changes, click Apply.lt is possible to add local users and groups from your Qumulo
cluster by prefixing them with the name of your cluster followed by a backslash (\ ). For
example: accounting\admin

A Important
For a Qumulo cluster with default settings, applying changes results in an error for
the .snapshots meta-directory. It is safe to click Continue each time this error occurs.
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S3 API
Configuring and Using the S3 API in Qumulo Core

This section explains how to configure and get started working with the S3 API. This API lets
clients and applications interact with the Qumulo file system natively, by using the Amazon S3
API.

Prerequisites

To use the S3 API, you must install the aws and qq CLI (page 95).

A Important
The following instructions are for Ubuntu 18.04 (and higher).

Step 1. Configure HTTPS

The Qumulo Core S3 API accepts only HTTPS requests by default. To enable HTTPS support for
your Qumulo cluster, you must install a valid SSL certificate on it.

Every Qumulo cluster is preconfigured with a self-signed SSL certificate. However, because
certain applications don't accept the default certificate, we recommend installing your own.

For information about configuring HTTPS for your cluster, see Installing the Qumulo Core Web Ul

SSL Certificate on Qumulo Care.

Enabling and Disabling Plaintext HTTP Connections

A Important
If you configure the S3 API service to accept only plaintext HTTP connections, no requests
made through the S3 API are encrypted.

- To enable HTTP connections, run the qq s3 modify settings command and use the --
insecure flag.

- Torevert to encrypted HTTPS requests, run the qq s3 modify settings command and use

the --secure flag.

Step 2: Enable the S3 API for Your Qumulo Cluster

To let your Qumulo cluster accept S3 traffic, you must enable the S3 API by using the qq
s3 modify settings --enable command.
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After you run the command, all nodes in your cluster begin to accept S3 API traffic on TCP port
9000.

Step 3: Create an Access Key Pair

To create and manage S3 buckets you must have a valid S3 access key pair associated with a
specific user in your Qumulo cluster or in a connected external identity provider (such as Active
Directory). For more information, see Creating and Managing S3 Access Keys (page 241).

Use the qq s3 create access key command and specify the username. For example:

$ qq s3 create access key my-username

O Note

After Qumulo Core initially creates your secret access keys, it never logs or displays them

again. If you lose your secret access key, it isn't possible to recover it and you must create a
new access key pair.

Step 4. Configure the AWS CLI for Use with Qumulo Core

To create and manage S3 buckets, you must configure AWS CLI to work with your Qumulo
cluster.
O Note

- We recommend configuring a dedicated profile for Qumulo in your AWS CLI S3
Configuration.

- Qumulo Core listens for S3 API traffic on TCP port 9000. It isn't possible to change this
setting.

- Currently, Qumulo Core supports only path-style bucket addressing. For more
information, see Bucket Addressing Style (page 289).

1. Configure the AWS CLI to use path-style bucket addressing by using the aws configure
command and specify your profile.
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2.

3.

4.

$ aws configure \
--profile my-qumulo-profile set s3.addressing style path

Use the access key pair that you have created earlier (page 237) and the aws configure
command to:

a. Specify your profile and access key ID (page 241). For example:

$ aws configure
--profile my-qumulo-profile set aws access key id \
000000000001 fEXAMPLE

b. Specify your profile and secret access key (page 241). For example:

$ aws configure
--profile my-qumulo-profile set aws secret access key \
TEIT41iMZ8A32iI7JXmqIilWp5co/jmkjEXAMPLE

Because it isn't possible to specify your cluster’s URI persistently, create a shell alias to
specify your cluster’s URI, in the following format:

$ alias aws="aws --endpoint-url https://<qumulo-cluster>:9000 --profile my-qum
ulo-profile"

O Note
If you haven't installed an SSL certificate, append --no-verify-ssl to the end of the
command.

(Optional) If you haven't configured your machine to trust the SSL certificate installed on
your Qumulo cluster, to configure the path to the trusted SSL certificate bundle that you

have created and installed earlier (page 236) manually, run the aws configure command.

For example:

$ aws configure \
--profile my-qumulo-profile set ca bundle MySpecialCert.crt
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5. To test your configuration, send an S3 API request to your Qumulo cluster by using the
aws s3api list-buckets command.

A successful response includes an empty JSON array named Buckets .

{
"Buckets": []

}

Step 5: Create an S3 Bucket

O Note
Creating buckets requires the PRIVILEGE S3 BUCKETS WRITE role-based access control (RBAC)
(page 59) privilege and permission to create a directory under the cluster’s root directory.

Run the aws s3api create-bucket command and specify the bucket name. For example:

$ aws s3api create-bucket \
--bucket my-bucket

The S3 API creates the new directory /my-bucket/ . All of the bucket’'s objects are located under
this directory. For more information, see Creating and Working with S3 Buckets in Qumulo Core
(page 251).

Step 6: Test Writing and Reading S3 Objects

1. To test writing data to your Qumulo cluster, performm a PutObject S3 APl action by using
the aws s3api put-object command. For example:

$ aws s3api put-object \
--bucket my-bucket \
--key archives/my-remote-file.zip \
--body my-local-file.zip

The S3 API uploads the contents of my-local-file.zip into an object named my-remote-
file.zip.

2. To test reading read data from and S3 bucket, perform a GetObject S3 APl action by using
the aws s3api get-object command. For example:
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$ aws s3api get-object \
--bucket my-bucket \
--key archives/my-remote-file.zip local-file.zip

The S3 API downloads the contents of the my-remote-file.zip objectinto local-
file.zip and returns the object metadata. For example:

"AcceptRanges": "bytes",

"LastModified": "Wed, 14 Dec 2022 20:42:46 GMT",
"ETag": "\"-gUAAAAAAAAAAWAAAAAAAAA\"",
"ContentType": "binary/octet-stream",
"Metadata": {}
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Creating and Managing S3 Access Keys in Qumulo Core

This section explains how to create and manage credentials that S3 APl actions in Qumulo Core
require to access file system resources, such as access key pairs that sign requests.

0 Note
You can configure an S3 bucket to allow read-only, anonymous access (page 261). This
approach requires no credentials but limits users to non-modifying operations.

In Qumulo Core 7.2.3.1 (and higher), system users can list, create, and delete S3 access keys for
their identities (page 241).

Prerequisites

Administrative control over S3 access keys requires the following role-based access control (RBAC)

(page 59) privileges:
PRIVILEGE S3 BUCKETS WRITE : Create or delete any S3 access keys on a Qumulo cluster

PRIVILEGE S3 BUCKETS READ : List all S3 access keys on a Qumulo cluster

How S3 Access Keys Work in Qumulo Core

An identity is a single principal from an identity provider (IdP). Examples of identities include SMB

security identifiers (SIDs), Active Directory user principal names (UPNSs), POSIX user identifiers
(UIDs), and local users in a Qumulo cluster.

A Important

It isn't possible to create access keys for UIDs in an Active Directory environment that has
POSIX extensions enabled. However, it is possible to use Active Directory identity identifiers
(SIDs, UPNs, and so on).

An access key (or access key pair) is comprised of an S3 access key ID and an S3 secret access key.

The access key ID is the public component of an S3 access key pair. It identifies the user
that performs an S3 request.

The secret access key (or secret key) is the private component of an S3 access key pair. The

client uses the secret access key to sign requests. The server uses the secret access key to
validate request signatures.
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A Important

Qumulo Core uses a cryptographically secure source, certified according to FIPS
140-2 requirements, to derive secret access keys.

Because access keys are cluster-local, you can't use an access key for an identity in
one Qumulo cluster on a different Qumulo cluster.

Qumulo Core creates an access key pair whenever an authorized user requests it. For more
information, see Creating S3 Access Keys for a Qumulo Cluster (page 243).

The way in which Qumulo Core access keys let you access your Qumulo cluster makes the process

similar to the way in which IAM Access Keys let you access Amazon S3 resources. For this reason,
applications that access objects stored in a Qumulo cluster can use the Qumulo S3 APl similarly
to the native Amazon S3 API.

How S3 Access Keys work with Identities

An S3 access key doesn’t grant any additional permissions. It associates an S3 AP| request with a
specific identity (page 241) known to the Qumulo cluster.

When Qumulo Core processes a request, it evaluates permissions by using the Qumulo ACL
(QACL) mechanism that operates like the access control list (ACL) mechanism that all file system
protocols use. When the QACL grants or denies permissions to an associated identity, it also
grants or denies the same permissions to the request being processed.

For more information, see Managing Access to S3 Buckets in a Qumulo Cluster (page 260).
How Qumulo Core Stores S3 Access Keys

To authenticate S3 API requests, Qumulo Core retrieves existing access key pairs that it stores
securely as configuration metadata in your Qumulo cluster. Qumulo Core encrypts secret access
keys on disk and holds decrypted secret access keys in memory (only while it processes a
request).

A Important

Because (unlike secret access keys) your access key IDs aren't a cryptographic secret,
Qumulo Core can log and display access key IDs. After Qumulo Core initially creates your
secret access keys, it never logs or displays them again. If you lose your secret access key, it
isn't possible to recover it and you must create a new access key pair.

S3 Access Key Lifecycle in Qumulo Core

Qumulo Core doesn't limit how long you can use an access key pair after you create it. Your
system administrators must take responsibility for using the Qumulo Core REST APl or qq CLI to
view the creation dates for access keys and revoke any pair at their discretion.
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For more information, see Listing S3 Access Keys for a Qumulo Cluster (page 246).

O Note

- To facilitate key rotation, each user identity (page 241) can have at most two S3 access
key pairs associated with it. It is a good practice to delete a user's old access key after
you create a new one and test that the new key works.

If you revoke an access key pair, it isn't possible to restore it. Before you revoke an
access key pair, ensure that no critical applications depend on it.

Creating S3 Access Keys for a Qumulo Cluster

To make S3 API requests to a Qumulo cluster as a specific user, you must create an S3 access key
pair for that user identity (page 241) by using the Qumulo REST APl or qq CLI.

To Create an Access Key for Your Own User Identity by Using the gqq CLI

Run the qq s3 create access key command and use the --self flag. For example:

$ qq s3 create access key --self

The following is example output.

"access key id": "AKIAIOSFODNN7EXAMPLE",
"creation time": "2022-12-12T21:37:53.5534579287",
"owner": {
"auth id": "501",
"domain": "LOCAL",
"gid": null,
"name": "quest",
"sid": "S-1-1-12-12345678-2345678901-1234567890-500",
"uid": null
¥
"secret access key": "wJalrXUtnFEMI/K7MDENG/bPxRfiCYEXAMPLEKEY"
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A Important

After Qumulo Core initially creates your secret access keys, it never logs or displays them
again. If you lose your secret access key, it isn't possible to recover it and you must create a
new access key pair.

To Create an Access Key for Another User Identity by Using the qq CLI

To create S3 access keys for another user identity (page 241), you must have an administrator
account or have the PRIVILEGE S3 BUCKETS WRITE privilege.

To create an S3 access key for a particular user, run the qq s3 create access key command and
specify an identity. For example:

$ qq s3 create access key ANOTHER IDENTITY

You can specify an identity by using:
- A name, optionally qualified with a domain prefix:

o ad:MY_NAME

[e]

AD\MY NAME

[}

local:MY NAME

[e]

MY NAME

- An Active Directory Security |dentifier. For example: SID:S-1-1-0

A Qumulo auth ID, Qumulo Core's common representation for identities, in the form of a
numeric identifier. For example: auth id:513

A Important
Currently, it isn't possible to associate an S3 access key with a POSIX group ID (GID).

The following is example output.
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"access key id": "AKIAJKSBDMSS8EXAMPLE",
"creation time": "2022-12-12T21:37:53.5534579287",
"owner": {

"auth id": "501",

"domain": "LOCAL",

"gid": null,
"name": "qguest",
"sid": "S-1-1-12-12345678-2345678901-1234567890-500",
"uid": null
b
"secret access key": "aGsfgDFdfEGWD/D5DWERF/sRsRdsXQEXAMPLEKEY"
}
A Important

After Qumulo Core initially creates your secret access keys, it never logs or displays them
again. If you lose your secret access key, it isn't possible to recover it and you must create a
new access key pair.

To Create an S3 Access Key by Using the Qumulo Core REST API

Send a POST request to the /v1/s3/access-keys/ endpoint with the following body. You must
include at least one of the following keys:

auth _id
sid
uid

For example:

"user": {

"sid": "S-1-1-12-12345678-2345678901-1234567890-500"

The following is example output.
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"access key id": "AKIAJKSBDMSS8EXAMPLE",
"creation time": "2022-12-12T21:37:53.5534579287",
"owner": {

"auth id": "501",

"domain": "LOCAL",

"gid": null,
"name": "qguest",
"sid": "S-1-1-12-12345678-2345678901-1234567890-500",
"uid": null
b
"secret access key": "aGsfgDFdfEGWD/D5DWERF/sRsRdsXQEXAMPLEKEY"
}
A Important

After Qumulo Core initially creates your secret access keys, it never logs or displays them
again. If you lose your secret access key, it isn't possible to recover it and you must create a
new access key pair.

Listing S3 Access Keys for a Qumulo Cluster

You can list every S3 access key known to your Qumulo cluster, along with the identities
associated with the key and the key creation times, by using the Qumulo REST APl or qq CLI. The
PRIVILEGE S3 BUCKETS READ privilege is required.

O Note
Qumulo Core doesn't list access keys in any particular order. To sort keys according to fields
such as creation time or owner you must process or filter the response.

To List S3 Access Keys for Your Own User Identity by Using the qq CLI

- To list the S3 access keys for your user known to your Qumulo cluster, run the qq
s3 list access keys:

$ qq s3 list access keys --self

The following is example output. All times are in the UTC time zone.
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access key id owner creation time

000000000001 TEXAMPLE Guest 2022-12-12T21:37:53.553457928Z7

For JSON output, use the --json flag.

The following is example output. The command returns a single JSON object that
contains the combined responses from calls to the /v1/s3/access-keys/ Qumulo Core
REST API| endpoint.

{
"entries": [
{
"access key id": "AKIAIOSFODNN7EXAMPLE",
"creation time": "2022-12-12T21:37:53.5534579287",
"owner": {
"auth id": "501",
"domain": null,
"gid": null,
"name": null,
"sid": null,
"uid": null
}
b

1,
"paging": {
"next": null

}
}

To List S3 Access Keys for All User Identities by Using the qq CLI

The PRIVILEGE S3 BUCKETS READ privilege is required.

- Tolist all S3 access keys on your Qumulo cluster, run the qq s3 list access keys
command.

The following is example output. All times are in the UTC time zone.

access key id owner creation time

000000000001 FEXAMPLE Guest 2022-12-12T21:37:53.553457928Z
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For JSON output, use the --json flag.

The following is example output. The command returns a single JSON object that
contains the combined responses from calls to the /v1/s3/access-keys/ Qumulo Core
REST APl endpoint.

{
"entries": [

{
"access key id": "AKIAIOSFODNN7EXAMPLE",

"creation time": "2022-12-12T21:37:53.5534579287",
"owner": {
"auth id": "501",
"domain": null,
"gid": null,
"name": null,
"sid": null,
"uid": null
}
b

1,
"paging": {
"next": null

}

To List S3 Access Keys by Using the Qumulo Core REST API

To list all S3 access keys known to your Qumulo cluster, send a GET request to the /v1/s3/access-
keys/ endpoint.

O Note
To restrict the number of returned results, up to the maximum of 10,000 access keys (this is
the default limit), include the optional limit query parameter in the request.

The following is example output. The entries list contains the access keys, limited to the first
10,000. The paging.next field contains the URI to which you can send a GET request to retrieve
the next page of access keys. By making GET requests with all returned paging.next values, you
can iterate over all of the access keys in the cluster.
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{

"entries": [

{
"access key id": "AKIAIOSFODNN7EXAMPLE",

“creation time": "2022-12-12T21:37:53.5534579287",
"owner": {
"auth id": "501",
"domain": null,
"gid": null,
"name": null,
"sid": null,
"uid": null
}
b

1,
"paging": {
"next": null

}

Revoking S3 Access Keys for a Qumulo Cluster

To revoke an S3 access key, you must delete the access key from your Qumulo cluster by using
the Qumulo REST APl or qq CLI The PRIVILEGE S3 BUCKETS WRITE privilege is required.

To Delete an S3 Access Key by Using the gqq CLI

Run the qq s3 delete access key command and specify the access key ID. For example:

$ qq s3 delete access key \
--id 000000000001 fEXAMPLE

To Delete an S3 Access Key by Using the Qumulo Core REST API

Send a DELETE request tothe /v1/s3/access-keys/<access-key-id> Qumulo Core REST API
endpoint and specify the access key ID.

Configuring Active Directory (AD) for S3

O Note
To be able to create access keys for a user in a joined AD domain, the user must exist within
the domain’s base DN.
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For users that exist in an AD domain that has a trust relationship with the joined domain, you

must append that domain’'s base DN to the base DN in your Qumulo cluster’'s AD configuration.

To append the trusted base DN to the base DN in use—with a semicolon ( ; ) separating the
two—use the Qumulo Core Web Ul or the qq ad reconfigure command. For example:

$ qq ad _reconfigure \
--base-dn 'CN=Users, DC=joined domain,DC=example,DC=com;\

CN=Users,DC=trusted domain,DC=example,DC=com'

For more information, see Configuring Cross-Domain Active Directory Trusts (page 226)
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Creating and Managing S3 Buckets in Qumulo Core

This section explains how to create and manage S3 buckets for a Qumulo cluster. These buckets
expose a part of your Qumulo file system to applications that use the Amazon S3 API.

You can create and work with S3 buckets by using the Qumulo REST APl or qgq CLI. You can also
use the S3 API directly.

Prerequisites

To create and manage S3 buckets by using the Qumulo REST APl or qq CLI, you need the
following role-based access control (RBAC) (page 59) privileges:

PRIVILEGE S3 BUCKETS WRITE : Create and delete S3 buckets

0 Note
If you perform create and delete operations on directories by using the qq CLI, you
also need this privilege.

PRIVILEGE S3 BUCKETS READ : List S3 buckets
To create and manage S3 buckets by using the S3 API, you also need:
- Avalid Qumulo S3 access key (page 241)

- A configured AWS CLI (page 237)

How S3 Buckets Map to the Qumulo File System

An S3 bucket exposes a portion of your Qumulo file system to applications that use the Amazon
S3 APL.

The bucket root directory (or bucket root) is the directory to which you attach an S3 bucket. All
files under the bucket root directory (and all of its subdirectories) are objects in the bucket. The
presence of the slash ( /) in objects’ keys determines the directory hierarchy.

A Important
Because S3 buckets can use any directory in the file system as a root directory, the same file
can be an object in multiple buckets.
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How the Qumulo File System Determines Object Keys

The object key in a Qumulo S3 bucket is its file system path, relative to the bucket's root directory.

Only objects that are directories have a trailing slash ( /) in their keys.

The following example shows the contents of a Qumulo file system.

/
— website-data/
| L— publish.dat

L— application-data/
— develop.dat
F— processing/
L— deployment/

— datal.dat

L— data2.dat

In this example, if you have the S3 bucket bucketl with its root directory at /application-data/
deployment/ , the bucket contains objects with the following keys:

datal.dat

data2.dat

However, if you have the S3 bucket bucket2 with its root directory at /application-data/, the
bucket contains objects with the following keys:

develop.dat
processing/
deployment/datal.dat

deployment/data2.dat

0 Note
In this example:

Both buckets contain /application-data/deployment/datal.dat and /application-
data/deployment/data2.dat as objects.

- The processing/ object in bucket2 has a trailing slash because it is a directory.
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How to Name an S3 Bucket

When you create an S3 bucket, you name it. A bucket's name doesn’'t need to be related to its root
directory.

Except for names that contain the period ( . ), Qumulo Core accepts all names that conform to
the following Amazon S3 bucket naming rules.

Bucket names must be between 3 and 63 characters long.
Bucket names can consist only of lowercase ASCII letters, numbers, and hyphens ( - ).
Bucket names must start with a letter or a number.

How to Choose a Bucket Root

You specify the bucket root directory (page 251) depending on how you create your S3 bucket.

- When you create an S3 bucket by using the Qumulo REST APl or qq CLI, you can choose a
directory to use as the bucket root.

- When you create an S3 bucket by using the CreateBucket S3 APl action, the API creates a
new directory with the same name as the bucket under the default bucket directory
prefix. For more information, see Configuring the Default Bucket Directory Prefix for S3
Buckets (page 253).

If you don't specify a directory, the Qumulo Core REST APl and qq CLI use the default
bucket directory prefix (page 253).

The user that creates a new directory for a new bucket owns the directory. For more information,

see Managing Access to S3 Buckets in a Qumulo Cluster (page 260).

Creating S3 Buckets

You can create an S3 bucket by using the Qumulo REST APl or qgq CLI. You can also use the S3 API
directly.

While the Qumulo Core REST APl and qq CLI let you use an existing directory as the new bucket
root, the S3 API always creates a new directory for the bucket root.

A Important

- All S3 buckets in a Qumulo cluster share the same namespace: It isn't possible to
create two buckets with the same name, even if they use different directories as their
bucket root.

- All S3 buckets must follow the bucket naming rules (page 252).
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Configuring the Default Bucket Directory Prefix for S3 Buckets

The default bucket directory prefixis the directory under which Qumulo Core creates new bucket
root directories when it creates S3 buckets by using the CreateBucket S3 APl action or when you
create an S3 bucket without specifying a directory by using the Qumulo REST APl or qq CLI.

By default, the default bucket directory prefix for newly created buckets is the cluster’s root
directory ( /). Thus, if you create a bucket named my-bucket , its root directory is /my-bucket .

- To view the current default bucket directory prefix by using the Qumulo REST APl or qq
CLI, you need the PRIVILEGE S3 BUCKETS READ privilege.

- To change the default bucket directory prefix, you need the PRIVILEGE S3 BUCKETS WRITE
privilege.

- To enable or suspend S3 bucket versioning, use the qq s3 modify bucket command.
To Configure the Default Bucket Directory Prefix by Using the qq CLI

1. To view the current default bucket directory prefix, run the qq s3 get settings
command.

The following is example output.

{"enabled": true, "base path": "/buckets/", ...}

2. Tochange the setting, run the qq s3 modify settings command and specify the new
default bucket directory prefix. In the following example, we specify /buckets .

$ qq s3 modify settings \
--base-path /buckets

Creating an S3 Bucket by Using the qq CLI

To create an S3 bucket by using the Qumulo REST APl or qq CLI, you need the
PRIVILEGE S3 BUCKETS WRITE privilege.

A Important

In Qumulo Core 6.0.1.1 (and higher), the qq CLI command changed from s3 create bucket to
s3 add bucket and the flag for specifying the directory path has changed from --path to --
fs-path.

When you use the qq CLI to create a bucket, you can use a new or existing directory as the
bucket root.
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O Note

If an entry with the specified name or directory already exists, or if you don't have permission
to create a directory, the command returns an error. For more information, see Configuring
the Default Bucket Directory Prefix for S3 Buckets (page 253).

- To create a new, empty bucket from the default bucket directory prefix (page 253), run the
qq s3 add bucket command and specify the bucket name. For example:

$ qq s3 add bucket \
--name my-bucket

Qumulo Core creates a new directory named my-bucket under the default bucket
directory prefix.

- To create a bucket from an existing directory, run the qq s3 add bucket command and
specify the bucket name and the directory path. For example:

$ qq s3 add bucket \
--name my-bucket \
--fs-path /products/web/appliances/

- To create a bucket for a path that doesn't exist yet, specify the name and path and add the
--create-fs-path flag. For example:

$ qq s3 add bucket \
--name my-bucket \
--fs-path /products/web/appliances/ \
--create-fs-path

Creating an S3 Bucket by Using the S3 API

Run the aws s3api create-bucket command and specify the bucket name. This command uses
the CreateBucket S3 APl action. For example:

$ aws s3api create-bucket \
--bucket my-bucket
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Qumulo Core creates the bucket root directory under the default bucket directory prefix (page
253) and names it the same as the bucket. In this example, if the default bucket directory prefix is
/buckets/ , the new bucket root directory is /buckets/my-bucket/ .

O Note
When you use the CreateBucket S3 API action with the LocationConstraint parameter, the
Qumulo S3 API supports only the local region.

Configuring S3 Buckets

You can view and modify the settings for individual buckets by using the Qumulo REST APl or qq
CLI.

You can configure global settings, such as the default bucket directory prefix (page 253) for all S3
buckets. For more information about configuring anonymous access for individual S3 buckets,
see, see Enabling Anonymous Access for an S3 Bucket (page 261).

- To view the current bucket configuration by using the Qumulo REST APl or qq CLI, you
need the PRIVILEGE S3 BUCKETS READ privilege. For more information, see qq
s3 get bucket in the Qumulo qq CLI Command Guide.

- To change the bucket configuration, you need the PRIVILEGE S3 BUCKETS WRITE privilege.
For more information, see qq s3 modify bucket in the Qumulo qgq CLI Command Guide.

Enabling Object Lock for S3 Buckets

An Object Lock can prevent an S3 object from being deleted for a limited time or indefinitely. For
information about file locks in Qumulo Core, see Managing File Locks (page 58).

To Enable Object Lock for an S3 Bucket by Using the qq CLI
1. Use an account with the S3 BUCKETS WRITE role-based access control (RBAC) role (page
59).

2. Runthe qq s3 modify bucket command, specify the bucket name, and use the --enable-
object-locking flag. For example:

$ qq s3 modify bucket \
--name my-bucket \
--enable-object-locking
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To Enable Object Lock for an S3 Bucket by Using the S3 API

O Note

Currently, because Qumulo Core doesn’t support default retention periods, you can set only a

compliance retention period on an individual object in an S3 bucket by using the
PutObjectRetentionAPI action.

1. To enable versioning for your S3 bucket, use the PutBucketVersioning API action.

2. To enable Object Lock for your S3 bucket, use the PutObjectLockConfiguration API action.

Listing S3 Buckets

You can list all S3 buckets in your Qumulo cluster by using the Qumulo REST APl or qq CLI. You

can also use the S3 API directly.

To List S3 Buckets by Using the qq CLI

To list your S3 buckets by using the Qumulo REST APl or qq CLI, you need the
PRIVILEGE S3 BUCKETS READ privilege.

Run the qq s3 list buckets command.

The following is example output. All times are in the UTC time zone.

name creation time path versioning

my-bucket 2022-12-13T22:18:01.406433425Z /my-bucket Unversioned

For JSON output, use the --json flag.

The following is example output. All times are in the UTC time zone. The JSON output
contains an array named Buckets that contains the individual buckets as objects.

{
"buckets": [
{
"creation time": "2022-12-13T22:18:01.406433425Z7",
"name": "my-bucket",
"path": "/my-bucket",
"versioning": "Unversioned"
}
]
}
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To List S3 Buckets by Using the S3 API

Run the aws s3api list-buckets command. This command uses the ListBuckets S3 API action.

The following is example output. All times are in the UTC time zone. The JSON output contains an
array named Buckets that contains the individual buckets as objects.

{
"Buckets": [
{
"Name": "my-bucket",
"CreationDate": "2022-12-13T22:18:01.406Z"
}
]
}

Deleting S3 Buckets

You can delete an S3 bucket by using the Qumulo REST APl or qgq CLI You can also use the S3 API
directly.

While the Qumulo Core REST APl and qq CLI let you choose whether to also delete the bucket
root directory, the S3 API always deletes the bucket root directory.

O Note
Before you delete your S3 bucket, you must either let all in-progress upload operations for
the bucket (UploadPart, PutObject, or CopyObject) complete or you must abort the operations.

Deleting an S3 Bucket by Using the qq CLI

To delete an S3 bucket by using the Qumulo REST APl or qq CLI, you need the
PRIVILEGE S3 BUCKETS WRITE privilege.

When you use the qq CLI to delete a bucket, you can choose to also delete the bucket root
directory.

- To delete an S3 bucket, but not its root directory, run the qq s3 delete bucket command
and specify the bucket name. For example:

$ qq s3 delete bucket \
--name my-bucket

This command doesn't delete the bucket root directory. It deletes all metadata related to
the bucket from your Qumulo cluster.

258


https://docs.aws.amazon.com/AmazonS3/latest/API/API_ListBuckets.html
https://docs.aws.amazon.com/AmazonS3/latest/API/API_ListBuckets.html
https://docs.qumulo.com/qq-cli-command-guide/s3/s3_delete_bucket.html
https://docs.qumulo.com/qq-cli-command-guide/s3/s3_delete_bucket.html

If any of the following conditions are true, the commmand returns an error:
o The specified bucket doesn't exist.
° You don't have the PRIVILEGE S3 BUCKETS WRITE privilege.

o The bucket has in-progress upload operations ( UploadPart, PutObject, or
CopyObject ).

To delete a bucket together with its root directory, use the qq s3 delete bucket
command, specify the bucket name, and use the --delete-root-dir flag. For example:

$ qq s3 delete bucket \
--delete-root-dir \
--name my-bucket

If any of the following conditions are true, the command returns an error:
o You don't have permission to delete the bucket root directory.
o The bucket root directory isn't empty.

Deleting an S3 Bucket by Using the S3 API

Run the aws s3api delete-bucket command and specify the bucket name. This command uses
the DeleteBucket S3 APl action. For example:

$ aws s3api delete-bucket \
--bucket my-bucket

This command deletes the bucket root directory and all metadata related to the bucket from your
Qumulo cluster.

If any of the following conditions are true, the command returns an error:
- The specified bucket doesn't exist.
- You don't have permission to delete the bucket root directory.
- The bucket root directory isn't empty.

- The bucket has in-progress upload operations ( UploadPart, PutObject, or CopyObject).
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Managing Access to S3 Buckets in a Qumulo Cluster

This section explains how to manage access to S3 buckets in a Qumulo cluster.

Managing user access to S3 buckets in a Qumulo cluster is very similar to managing access to
SMB shares and NFS exports, with the following exceptions:

- To let a user access S3 buckets in the cluster, you must assign an S3 access key (page 241)
to the user. Alternatively, you can create presigned URLs (page 260) or enable read-only,
anonymous access (page 261) for the entire S3 bucket.

Because a Qumulo cluster restricts S3 actions based on file access control lists (ACLs), an
S3 bucket might work differently or have more restrictive permissions than expected.

0 Note

To configure an S3 bucket in Qumulo Core to work more like an Amazon S3 bucket,
use inheritable access control entries (ACEs) to imitate bucket-level permissions
(page 263).

How S3 Bucket Permissions Work in Qumulo Core

To process an S3 API request, Qumulo Core performs one or more file system operations. Qumulo
Core processes these operations by checking the user’s access against the access control lists
(ACLs) for each file that is part of the request.

O Note
To permit an action to be performed, the bucket policy (page 267) and the object’s file
system ACL must allow the action.

For authenticated requests signed with Amazon Signature Version 4, Qumulo Core maps the
access key ID (page 241) in the request to its corresponding auth ID (page 244), and then
processes the request as that user. Qumulo Core processes unsigned, anonymous requests as the
Guest user.

While Qumulo Core processes an S3 request, the ownership of any newly created files and
directories belongs to the user that makes the request. These files and directories inherit access
control entries (ACEs) from their parents (this process is the same for all protocols).
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Granting Access to S3 Buckets by Using Presigned URLs

To let trusted users perform S3 APl actions—such as GetObject or UploadPart —as if using your
user account, you can generate a presigned URL (also known as query parameter authentication),
associate the URL with specific APl actions, and then share it with trusted users. Every presigned
URLs has a configurable expiration time that ensures that the URL stops working at the
configured time.

For more information, see Authenticating Requests: Using Query Parameters (AWS Signature
Version 4) in the Amazon Simple Storage Service API Reference.

O Note
Qumulo Core accepts only presigned requests that use the PUT, GET, HEAD, and DELETE HTTP
methods. Qumulo Core rejects presigned requests for POST requests, such as the following:

- AbortMultipartUpload
- CompleteMultipartUpload
- CreateMultipartUpload

- DeleteObjects

To create a presigned URL, run the AWS CLI presign command. In the following example, the
presigned URL expires in 10 minutes (600 seconds).

$ aws2 s3 presign s3://my-bucket/my-file.txt \
--endpoint-url https://203.0.113.0:9000 \
--profile my-qumulo-profile \
--expires-in 600

The following is example output. The X-Amz-Expires header is set to 10 minutes.

https://203.0.113.0:9000/my-bucket/my-file.txt?

X-Amz-Algorithm=AWS4-HMAC-SHA256
&X-Amz-Credential=00000000000003e88527%2F20230217%2Fus-east-1%2Fs3%2Faws4 request
&X-Amz-Date=20230217T205559Z

&X-Amz-Expires=600

&X-Amz-SignedHeaders=host
&X-Amz-Signature=141fa5b10caaa8575ba9c065d2270a24celdb2ff58bb2c2e98382c76297b21ee
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Enabling Anonymous Access for an S3 Bucket

In certain cases, it might be more practical to allow anonymous (unauthenticated) requests to
access the contents of S3 buckets, for example, if you want to let users access objects from the S3
bucket by using a web browser or if the number of users who need read access is very large.
When you enable anonymous access to an S3 bucket, your users can perform read-only S3
operations without authenticating their requests.

A Important
Anonymous requests can never perform modifying operations. Qumulo Core requires all
modifying operations on an S3 bucket to be authenticated.

When you enable anonymous access for an S3 bucket, Qumulo Core performs all anonymous
requests as the Guest user. The Guest user isa member of the Everyone group, but not of the
Users group.

To ensure that anonymous requests have permission to read files in a bucket, grant read
permission to the Everyone group or to the Guest user. For more information, see Imitating
Bucket-Level Read-Only Access (page 265).

O Note
If a file's ACL doesn't allow reads for the Guest user, an anonymous request can't read the file.

- To view the current bucket policy configuration by using the Qumulo REST APl or qq CLI,
you need the PRIVILEGE S3 BUCKETS READ privilege. For more information, see qq
s3 get bucket policy inthe Qumulo qgq CLI Command Guide.

- To change the bucket policy configuration, you need the PRIVILEGE S3 BUCKETS WRITE
privilege. For more information, see qq s3 modify bucket policy in the Qumulo qq CLI
Command Guide.

The following is an example policy that enables anonymous access:
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"Id": "Anonymous Access Enabled",
"Statements": [{
"Action": [
g3 x"
1,
"Effect": "Allow",
"Principal": {
"Qumulo": ["Authenticated Users"]

+,

"Sid": "Authenticated Full Access"
A

"Action": [

"s3:GetObject",
"s3:GetObjectAcl",
"s3:GetObjectAttributes",
"s3:GetObjectTagging",
"s3:ListBucket"

1,
"Effect": "Allow",
"Principal”: {

"Qumulo": ["local:guest"]

}

"Sid": "Read-only Guest Access"

H,
"Version": "2012-10-17"

Using Inheritable ACEs to Imitate Bucket-Level Permissions

To grant multiple users access to all paths in a bucket and ensure that newly created directories
inherit the correct permissions, use inheritable access control entries (ACEs).

In Amazon S3, permission to read objects from —and write objects to— an S3 bucket applies to
the entire bucket. In Qumulo Core, each object key (page 251) corresponds to a file path relative to
a bucket’s root directory. Qumulo Core grants permissions for individual files and directories.

When users create objects in an S3 bucket in a Qumulo cluster, they might also create new
directories. The user that creates these directories owns them. However, without the correct
access control entries (ACEs) in your bucket, these directories might have restrictive permissions
that prevent other users from creating objects with the same prefix.
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How Permissions with Inheritable ACEs Work

Access control entries (ACEs) control the permissions that users have for files and directories in a
Qumulo cluster. When you add ACEs to a directory and mark them as inheritable, all new files
and directories created in that directory inherit those ACEs and pass them on.

You can use inheritable ACEs to:

Imitate bucket-level permissions by ensuring that any files and directories that your users
create in an S3 bucket receive the same permissions.

To make all paths in an S3 bucket inherit the same set of ACEs, add the ACEs to the
bucket's root directory and mark them as inheritable.

- Configure default permissions for newly created buckets.

To make a set of ACEs the default for buckets that your users create by using the S3 API,
add the ACEs to the default bucket directory prefix.

To add ACEs to a directory, use the qq CLI or use the File Explorer on a Windows client with a
mapped SMB share that contains the directory.

O Note
Adding inheritable ACEs to a directory doesn't affect any files that already exist in that
directory. For more information, see To Recursively Add a New ACL with Multithreading.

Imitating Bucket-Level Permissions by Using the qqg CLI

The following sections show how to use the qq CLI to imitate bucket-level permissions by adding
inheritable ACEs.

Imitating Bucket-Level Read-Write Access

Run the qq fs modify acl command. In the following example, we add the access control entry
(ACE) to the bucket whose root directory is /buckets/my-bucket for the user group MyWriters .

$ qq fs modify acl \
--path /buckets/my-bucket add entry \
--trustee MyWriters \
--type Allowed \
--flags 'Container inherit' 'Object inherit' \
--rights 'Delete child' 'Execute/Traverse' 'Read' 'Write file'

The ACE imitates bucket-level read-write access for a user or group of users.
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Type Flags Rights

Allowed Object inherit, Container inherit Delete child, Execute/Traverse, Read,
Write file

Imitating Bucket-Level Read-Only Access

Run the qq fs modify acl command. In the following example, we add the access control entry
(ACE) to the bucket whose root directory is /buckets/my-bucket for the user group MyReaders :

$ gq fs modify acl
--path /buckets/my-bucket add entry \
--trustee MyReaders \
--type Allowed \
--flags 'Container inherit' 'Object inherit' \
--rights 'Execute/Traverse' 'Read’

The ACE imitates bucket-level read-only access for a user or group of users.

Type Flags Rights

Allowed Object inherit, Container inherit Execute/Traverse, Read

Imitating Bucket-Level List-Only Access

Run the qq fs modify acl command. In the following example, we add two access control entries
(ACEs) to the bucket whose root directory is /buckets/my-bucket for the user group MylListers.

$ qq fs _modify acl
--path /buckets/my-bucket add entry \
--trustee MyListers \
--type Allowed \
--flags 'Container inherit' \
--rights 'Execute/Traverse' 'Read’
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$ qq fs modify acl
--path /buckets/my-bucket add entry \
--trustee MylListers \
--type Allowed \
--flags 'Object inherit' \
--rights 'Read attr'

The two ACEs imitate bucket-level list-only access for a user or group of users:

Type Flags Rights

Allowed Container inherit Execute/Traverse, Read
Allowed Object inherit Read attr
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Managing Access Policies for S3 Buckets in a Qumulo
Cluster
This section explains how to manage access policies for S3 buckets in a Qumulo cluster.

Access policies let you control specific sets of S3 API actions that each user or group can perform.
They provide an additional layer of access management for S3 buckets by adding further
restrictions to those of access keys, presigned URLs, and file system access control lists (page 263).

Managing access policies for S3 buckets in Qumulo clusters is similar to managing SMB share
access, only with a larger set of items that you can specify in the Actions (page 271) field of the
policy statement (page 268).

For information about working with access policies for S3 buckets and for qq CLI examples, see
the following sections in the Qumulo qgq CLI Command Guide:

gqq s3 get bucket policy
qq s3 set bucket policy
gq s3 modify bucket policy

gq s3 delete bucket policy

Anonymous Access to S3 Buckets

By default, S3 buckets in a Qumulo cluster are in a no policy state, in which Qumulo Core
disallows unsigned, anonymous requests and the qq s3 get bucket policy command returns

{}.

In Qumulo Core, anonymous S3 connections use the system Guest account, which is restricted to
read-only S3 API actions. To permit anonymous access in an S3 bucket policy, grant access to one
of the following principals:

- The Everyone group
- The Guest account

- Any group that includes the Guest account asa member

O Note

When you upgrade Qumulo Core version 7.1.1, the system replaces anonymous S3 bucket
access configuration with a default S3 bucket policy that permits all S3 API actions to all
principals.
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Prerequisites

The following prerequisites let you manage the access policy for an S3 bucket effectively.

- Grant your users access to the S3 bucket by using S3 access keys (page 241) or presigned
URLs (page 260), or enable read-only, anonymous access (page 261) to the S3 bucket.

- Configure inheritable file ACLs (page 263) by using the qq CLI, SMB, or NFSv4.1 access
control lists (ACLs) (page 184).

Ensure that you have the following required role-based access control (RBAC) (page 59)
privileges.

o PRIVILEGE S3 BUCKETS READ
°o PRIVILEGE S3 BUCKETS WRITE

(Optional) To delegate the management of an access policy for an S3 bucket to another
user, grant the s3:PutBucketPolicy and s3:DeleteBucketPolicy S3 APl actions to that
user in the Actions (page 271) field of a policy statement.

How Policy Statements for S3 Buckets are Structured

Policy statements for S3 buckets use the JSON format. For example:

{

"Id": "Example overall access policy description",
"Statements": [{
"Action": [
"s3:GetBucketPolicy",

1,
"Effect": "Allow",
"Index": 1,
"Principal": {
"Qumulo": ["Everyone"]

b

"Sid": "Example policy statement description"

FA

H
"Version": "2012-10-17"

To retrieve an example policy file, run the qq s3 get bucket policy --example command.

The S3 bucket policy statement contains the following fields.

268



(Optional) 1Id Describes the functionality of your overall policy
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Statements ) ) . ) )
Contains a list of statements, and the following fields for each policy

statement

0 Note
The order of the fields has no effect on the permissions that an ac-
cess policy grants for an S3 bucket.

Action : Specifies a list of API actions supported in Qumulo clusters
(page 271) to which the policy statement applies

Effect : Specifies either Allow or Deny

O Note

o Unless the policy statement has at least one matching Allow
statement and no Deny statements for an action, the system
outputs the AccessDeniedByBucketPolicy error.

o For the S3 APl and Qumulo REST API, if a user has the role-
based access control privilege (RBAC) to perform an API action,
Qumulo Core ignores the access policy (page 274) and permits
the API action.

o The ListBuckets S3 APl action has no associated access policy
permission in Qumulo Core. Instead, this S3 API action checks
each S3 bucket's policy and includes the S3 bucket in the enu-
meration if any action is allowed for a user.

Index : The system ignores this field when you configure the access
policy for an S3 bucket.

O Note

o To retrieve index for a policy statement, run the qq
s3 get bucket policycommand.

° You can target a specific policy statement by specifying its in-
dex for the - -index flag with the qq s3 modify bucket policy
modify statementcommand.
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Principal : Specifies a list of users or groups (in various formats (page
273)) to which the policy statement applies

This field uses the same identity specification as the identifier field
ofthe qq auth find identity command.

Sid: Describes the functionality of your policy statement

(Optional) Vver- If you specify this field, enter 2012-10-17 , the latest policy version from
sion Amazon. For more information, see IAM JSON Policy Elements: Version.

Actions Supported in Qumulo Core

The following table describes the subset of the Amazon S3 API Actions which Qumulo Core
supports.

O Note

Certain permissions (such as s3:AbortMultipartUpload) grant permission to both S3
APl and Qumulo Core REST API variants of an API call.

Certain permissions (such as s3:GetBucketAcl) grant permission to S3 APIs that are
currently implemented partially within Qumulo Core.

s3:* matches all S3 API actions.

s3:AbortMultipartUpload Abort a multipart upload to the S3 bucket
s3:DeleteBucket Delete the S3 bucket

s3:DeleteBucketPolicy Remove the access policy from the S3 bucket
s3:Deletelbject Delete any object from the S3 bucket
s3:DeleteObjectTagging Delete all tags from any object in the S3 bucket
s3:DeleteObjectVersion Delete any object version from the S3 bucket
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s3:

s3:

s3:

s3

s3:

s3:

s3:

s3:

s3

s3:

s3:

s3:

s3:

s3:

GetBucketAcl

GetBucketLocation

GetBucketNotification

:GetBucketObjectLockConfiguration

GetBucketPolicy
GetBucketReplication
GetBucketVersioning

GetEncryptionConfiguration

:GetLifecycleConfiguration

GetObject

GetObjectAcl

GetObjectAttributes
GetObjectTagging

ListBucket

Retrieve the access control list (ACL) for the S3 bucket

Retrieve the region in which the S3 bucket is located

O Note
Currently, because Qumulo Core doesn't use re-
gions, the system always returns local.

Retrieve the notification configuration for the S3
bucket

Retrieve the object lock configuration for the S3
bucket

Retrieve the bucket policy for the S3 bucket

Retrieve the replication state for the S3 bucket
Retrieve the versioning state for the S3 bucket
Retrieve the encryption state for the S3 bucket

Retrieve the lifecycle configuration for the S3 bucket

Download any object from the S3 bucket

O Note
The file system permissions take precedence
over this permission.

Download the access control list (ACL) for any object
in the S3 bucket

Retrieve the attributes for any object in the S3 bucket
Retrieve the tags for any object in the S3 bucket

Enumerate all objects in the S3 bucket
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s3:ListBucketMultipartUploads

s3:ListMultipartUploadParts

s3:PutBucketPolicy
s3:PutBucketVersioning
s3:PutObject

s3:PutObjectTagging

Enumerate all multipart uploads to the S3 bucket

Enumerate all multipart upload parts in the S3 buck-
et

Configure the access policy for the S3 bucket
Configure bucket versioning for the S3 bucket
Write or overwrite any object in the S3 bucket

Configure tags for any object in the S3 bucket

Principals Supported in Qumulo Core

The following table describes examples of principals which Qumulo Core supports.

Mary Lou

local:Jane

local:qguest

world:Everyone

Authenticated Users

EXAMPLE DOMAIN\Jose Ramirez

ad:Company Name

uid:1234

A username or group hame

A user or group created by using the Qumulo Core REST
APl in the local domain, prefixed by local:

An anonymous connection

Any user connected to Qumulo Core, including unauthen-
ticated, anonymous connections

Any authenticated user, excluding guest or anonymous
connections

A user or group in a specific Active Directory domain, pre-
fixed by the domain name

A user or group in any connected Active Directory do-
main, prefixed by ad:

A POSIX UID that identifies users by their RFC 2307, pre-
fixed by uid:

273


https://www.ietf.org/rfc/rfc2307.txt

gid:1234

auth id:12345678

S-1-5-1234

sid:S5-1-5-5678

A POSIX GID that identifies users by their RFC 2307, pre-
fixed by gid:

The numeric auth id of a user or group

A Windows-style security identifier (SID), optionally pre-
fixed by sid:

Role-Based Access Control (RBAC) Overrides

For the S3 APl and Qumulo REST API, if a user has the role-based access control privilege (RBAC)
to perform an APl action, Qumulo Core ignores the access policy (page 274) and permits the API

action.

The following table describes the relationship between Qumulo Core privileges and the S3 API

actions associated with them.

Qumulo Core Privilege | Associated S3 API Actions

S3 BUCKETS READ

s3:

S3 BUCKETS WRITE

s3:

s3:

s3:

S3_UPLOADS_READ

s3:

s3:

s3:

s3:

GetBucketPolicy

GetBucketVersioning

DeleteBucket
DeleteBucketPolicy
PutBucketPolicy

PutBucketVersioning

ListMultipartUploadParts

ListBucketMultipartUploads

S3 UPLOADS WRITE s3:AbortMultipartUpload
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Managing Multipart S3 Uploads in Qumulo Core

This section explains how multipart S3 uploads affect usable capacity on a Qumulo cluster and
how to abort and clean up multipart uploads manually or automatically.

Qumulo Core supports the multipart upload functionality of the S3 API, which lets you upload
objects to a bucket in parts and then, at a later time, combine these parts into a single object.

0 Note

For objects above a certain size (typically, larger than 100 MiB), applications often use the
multipart S3 uploads, rather than the PutObject S3 API action. The limitation for the PutObject
action is 5 GiB. For more information about how Qumulo handles this type of operation, see
System-Initiated Multipart S3 Uploads (page 276).

Prerequisites

To manage multipart S3 uploads by using the qgq CLI, you need the following role-based access
control (RBAC) (page 59) privileges:

PRIVILEGE S3 SETTINGS WRITE : Configure frequency of multipart upload cleanup
PRIVILEGE S3 UPLOADS READ : List multipart uploads

PRIVILEGE S3 UPLOADS WRITE : Abort multipart uploads

How Multipart S3 Uploads Affect Usable Capacity on a Qumulo Cluster
The following conditions are true for multipart S3 uploads in Qumulo Core.

- To let you resume large uploads in the event of an outage, Qumulo Core stores data on
the cluster durably.

Multipart upload data isn't visible in the Qumulo file system, and isn't included in file
system snapshots, until you complete the upload successfully by making a call to the
CompleteMultipartUpload S3 API.

0 Note

When you view the breakdown of a Qumulo cluster’s capacity by using the Qumulo
Core Web Ul, REST API, or qq CLI, Qumulo Core doesn't distinguish between capacity
that the file system and incomplete multipart uploads use.

- Qumulo Core doesn’t delete multipart data unless it aborts and cleans up the multipart
upload automatically (page 278) or you abort and clean up the multipart upload manually
(page 279).
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To check how much space incomplete multipart uploads use on your cluster, you can list the
uploads by using the Qumulo Core REST APl or qq CLI. For more information, see Listing
Multipart Uploads (page 276).

How System-Initiated Multipart S3 Uploads Work

Occasionally, when you list your multipart uploads (page 276), you might see uploads that you
didn't initiate. These are system-initiated uploads which Qumulo Core uses for PutObject and
CopyObject S3 APl actions for objects that exceed a certain size.

If Qumulo Core encounters an error while performing a system-initiated upload, it attempts to
abort the upload and clean up the partial upload data immediately.

However, if Qumulo Core is unable to clean up the incomplete upload data immediately, it cleans
up the incomplete upload data in the background, according to the expiry interval (page 278).

O Note

The process for background clean-up after incomplete and user-initiated uploads is the
same. For more information, see Aborting and Cleaning Up Multipart S3 Uploads
Automatically (page 278).

Listing Incomplete Multipart S3 Uploads

You can list the incomplete multipart uploads for a single S3 bucket by using the Qumulo Core
REST APl or qq CLI.

O Note

If you use the ListMultipartUploads S3 API action, the system doesn't show system-
initiated uploads (page 276) or how much space the uploads use on your cluster.

If you use the Qumulo Core REST API or qq CLI, Qumulo Core shows system-initiated
uploads (page 276) and how much space each upload uses on your cluster.

- Tolistincomplete uploads by using the qq CLI, run the qq s3 list uploads command
and specify the bucket name. For example:

$ qq s3 list uploads \
--bucket my-bucket
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- To list incomplete uploads by using the Qumulo Core REST API, send a GET request to the
/v1/s3/buckets/<bucket-name>/uploads/ endpoint and specify the bucket name.

The output from the qq CLI and REST API is the same. The following example output is a single
JSON object that contains the list of objects for the specified bucket. The list shows information
for each multipart S3 upload, including:

- When each upload was initiated
- Which identity initiated the upload
- When the upload received data last

How much space the upload uses on the cluster—by data, by metadata, and in total—in
units of blocks (4,096 bytes per block)
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{
"uploads": [
{
"bucket": "my-bucket",
"completing": false,
"datablocks": "16384",
"id": "00000000examplel",
"initiated": "2023-03-02T19:01:00.446468848Z",
"initiator": {
"auth id": "500",
"domain": null,

"gid": null,
"name": null,
"sid": null,
"uid": null

b

"key": "deployment/datal.dat",

"last modified": "2023-03-02T19:03:37.20927170272",
"metablocks": "3",

"system initiated": false,

"total blocks": "16387"

"bucket": "my-bucket",
"completing": false,
"datablocks": "24576",
"id": "00000000example2",
"initiated": "2023-03-02T19:09:04.530619255Z7",
"initiator": {
"auth_id": "500",
"domain": null,

"gid": null,
"name": null,
"sid": null,
"uid": null

b

"key": "release.dat",

"last modified": "2023-03-02T19:09:06.4366992362",
"metablocks": "4",

"system initiated": true,

"total blocks": "24580"
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Aborting and Cleaning Up Multipart S3 Uploads Automatically

Qumulo Core automatically aborts and cleans up an incomplete multipart S3 if the upload
doesn't receive any data after the configured expiry interval (1 day by default).

When Qumulo Core removes a multipart upload, it frees up the space that the upload uses on
the cluster. You can configure the expiry interval by using the Qumulo Core REST APl or qq CLI.

To configure the expiry interval for all current and future multipart uploads by using the qq CLI,
run the gqq s3 modify settings command and the --multipart-upload-expiry-interval flag and
specify one of the following:

- Thestring never.

- Astring in the format <quantity><units> (without a space), where <quantity> isa
positive integer less than 100 and <units> is one of the following strings:

o

o

days
hours
minutes
months

weeks

In the following example, we instruct Qumulo Core to abort and clean up uploads that haven't
received data in more than 30 days.

$ qq s3 modify settings \
--multipart-upload-expiry-interval 30days

In the following example, we disable automatic cleanup.

$ qq s3 modify settings \
--multipart-upload-expiry-interval never

Aborting or Cleaning Up Multipart S3 Uploads Manually

Use the Qumulo Core REST APl or qq CLI to abort and clean up the upload. You need the bucket
name and upload ID. For more information about looking up this information, see Listing
Incomplete Multipart S3 Uploads (page 276).
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O Note

If you are an administrative user or the user who initiated the upload, you can use the

AbortMultipartUpload S3 API action. In addition to the bucket name and upload ID, you also
need the object key for the upload.

- To abort an upload by using the qq CLI, runthe qq s3 abort upload command and
specify the upload ID. For example:

$ qq s3 abort upload \
--bucket my-bucket \
--upload-id 000000000example

- To abort an upload by using the Qumulo Core REST API, send a DELETE request to the

/v1/s3/buckets/<bucket-name>/uploads/<upload-ID> endpoint and specify the upload ID.

For example:

DELETE /v1/s3/buckets/my-bucket/uploads/000000000example

There is no response body for both the qq CLI and REST API. Qumulo Core returns a 204 No
Content status code when the upload is aborted or the cleanup is complete.
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Managing S3 Bucket Versioning in a Qumulo Cluster

This section explains how Amazon S3 Versioning works in Qumulo Core and how to configure S3
bucket versioning by using the Qumulo REST APl or qq CLI or by using the S3 API directly.

You can configure S3 bucket versioning by using the Qumulo REST APl or qq CLI. For more

information, see qq s3 modify bucket in the Qumulo qq CLI Command Guide. You can also use
the S3 API directly.

For information about S3 bucket versioning limits, see Supported Functionality and Limits (page
290).
How Bucket Versioning works in Qumulo Core

Qumulo Core stores S3 object versions as independent files in the file system. Qumulo Core
names these versions by using their version ID.

In the following example:

- The versioned files are stored in /dir/.s3-versioning~/obj .

A Important

Because .s3-versioning~ is a normal, hidden directory, visible and accessible to other
protocols. To ensure consistent S3 API behavior, we strongly recommmend avoiding the

use of other protocols to write to the directory. Any protocol can read from the
directory safely.

- An object with the object store key dir/obj has two versions:
12345a6b-7c89-0d12-3456-78fe9012f345 and abcdelf2-g3hi-j4kl-mnop-qr56stuv7wxy .
0 Note

o To access a specific version of a file by using CLI or REST API, specify the
version ID.

o To access the head version (current version) of a file, omit the version ID.

- The system-created hard link points to the latest version of the object.

- The on-disk representation is as follows:
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/
L— dir/
— .s3-versioning~/
| L— obj/
| F— 12345a6b-7c89-0d12-3456-78fe9012f345
| L— abcdelf2-g3hi-j4kl-mnop-qr56stuv7wxy
L— obj <hardlink: /dir/.s3-versioning~/o0bj/12345a6b-7c89-0d12-3456-78fe90

12345>
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Managing Object Lock for S3 Buckets in Qumulo Core

This section explains how to enable and manage Object Lock for S3 Buckets in Qumulo Core.

Prerequisites

Before you can enable Object Lock for an S3 bucket, you must first enable S3 Bucket versioning
(page 281).

How Object Lock for S3 Buckets Works in Qumulo Core
You can configure Object Lock for an S3 Bucket in three ways:

Lock with manual retention period: This configuration specifies a fixed period of time
during which an object remains locked. Qumulo Core supports compliance mode, a type
of retention period which prevents a protected object version from being overwritten or
deleted by any user.

0 Note
Currently, Qumulo Core doesn'’t support governance mode.

To configure a lock with a manual compliance mode retention period, use the
PutObjectRetention S3 APl action or specify the configuration in the headers of the
CreateMultipartUpload, CopyObject, or PutObject S3 API action.

Lock with default retention period: This configuration is similar to that of a lock with a
manual retention period. It ensures that the S3 bucket locks any new object added to it.

0 Note
Specifying a manual retention period while creating a new object in an S3 bucket

overrides the default retention period.

Legal hold: This configuration ensures that an object remains locked without an
expiration date, until you remove the hold.

To configure a legal hold, use the PutObjectlLegalHold S3 API action or specify the
configuration in the headers of the CreateMultipartUpload, CopyObject, or PutObject S3
API action.

It isn't possible to change any data or attributes of an object with a valid lock (with a manual or
default retention period) or with a legal hold by using any of the protocols which Qumulo Core
supports.
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Enabling S3 Object Lock Configuration

You can configure S3 bucket locking by using one of the following methods:
GET /v1/s3/buckets and POST /v1/s3/buckets REST APIs

qq s3 modify bucket and qq s3 add bucket CLI commands

- S3API

Viewing S3 Object Lock Configuration
You can view the Object Lock configuration for an S3 bucket in two ways:

Runthe qq fs file get attr command and use the --retrieve-file-lock flag. For

example:

$ qq fs file get attr --retrieve-file-lock --path /demo

The following is example output. (Only part of the output is shown).

{
"lock": {
"legal hold": false,
"retention period": "2024-10-08T21:53:46.493886743Z"
}
}

Run the s3api get-object-retention command and specify your bucket name, and your

S3 access key. For example:

$ aws s3api get-object-retention \
--bucket my-bucket \
--key AKIAIOSFODNN7EXAMPLE

The following is example output.
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"Retention": {
"Mode": "COMPLIANCE",
"RetainUntilDate": "2024-10-08T21:53:46.493Z"
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Supported Functionality and Known Limits for S3 in
Qumulo Core

This section documents Qumulo Core support for S3 API functionality and S3 API limits.

Supported S3 API Actions

The following table lists the S3 API actions that Qumulo Core supports and the version from
which support begins. For the full list of S3 API actions, see Actions in the Amazon Simple Storage
Service API| Reference.

O Note

- The S3 API became generally available in Qumulo Core 5.3.3. This guide doesn't
document enabling or using API actions that became available with preview
functionality in versions of Qumulo Core lower than 5.3.3.

- The Qumulo S3 protocol creates data that supports all file system functionality, such
as quotas, snapshots, replication, and Global Namespace functionality.

API Action Supported from Qumulo Core Version

AbortMultipartUpload 533
CompleteMultipartUpload 533
CopyObject 533
CreateBucket 523
CreateMultipartUpload 533
DeleteBucket 524
DeleteBucketPolicy 7.0.1.1
DeleteBucketVersioning 712

DeleteObject 521

DeleteObjects 522
DeleteObjectTagging 6.3.2
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API Action Supported from Qumulo Core Version

GetBucketAcl
GetBucketLocation
GetBucketPolicy
GetBucketVersioning
GetObject
GetObjectAcl
GetObjectlLegalHold
GetObjectLockConfiguration
GetObjectRetention
GetObjectTagging
HeadBucket
HeadObject
ListBuckets
ListMultipartUploads
ListObjects
ListObjectsV2
ListParts
PutBucketPolicy
PutBucketVersioning
PutObject
PutObjectLegalHold
PutObjectLockConfiguration

PutObjectRetention

6.1.1

512

7.0.0.1

712

504

6.1.1

7.2.3.1

7.0.0.1

7.21.1

71.2

512

5.0.4

504

533

5.05

5.0.4

533

7.0.1.1

712

521

7231

7.2.3]

7211
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API Action Supported from Qumulo Core Version

PutObjectTagging
UploadPart

UploadPartCopy

6.3.2

533

6.0.2

Unsupported S3 Functionality

The following table lists some of the S3 API functionality that Qumulo Core doesn’t support.

Unsupported

Feature

Description

BitTorrent

Bucket ACLs

Bucket lifecycle
configurations

Bucket notifica-
tions

Control of server-
side encryption

Object Lock in gov-
ernance mode

Logging controls

Multi-chunk pay-
load signing

Signature Version 2

Storage classes

Temporary access
credentials

For comparable functionality, use inheritable access control entries
(ACEs) (page 263).

All Qumulo Core data is encrypted at rest. You can’t control this function-
ality by using the S3 API.

Qumulo Core supports only compliance mode.

Qumulo Core doesn't support the streaming version of Amazon Signa-
ture Version 4 (SigV4), only the single-chunk version.

Qumulo Core supports only SigV4 signatures.

Qumulo Core doesn’t use the storage class concept. All objects have the
same storage class status.
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Unsupported Description

Feature

Virtual-hosted Qumulo Core supports only path-style bucket addressing.
bucket addressing

Web hosting con- —
figuration

S3 API Limitations
This section describes the most important S3 API limitations in Qumulo Core.
Bucket Addressing Style

Because Qumulo Core supports only path-style bucket addressing, you must configure your
client applications to use path-style addressing to send S3 API requests to a Qumulo cluster. For
more information, see Configuring the AWS CLI for Use with Qumulo Core (page 237).

ETags
RESTful APIs, such as the S3 API, use HTTP ETags to identify different resource versions.
- Qumulo Core uses a proprietary mechanism to generate an object's ETag.

- Amazon S3 uses the MD5 checksum of an object's contents as its ETag.

A Important

Well-behaved applications shouldn't attempt to interpret the contents of an ETag. However,
certain applications do assume that S3 object ETags contain the MD5 checksum of the
object’s contents. Such applications might not function properly with the Qumulo S3 API.

Listing Objects

The S3 API supports listing objects in a bucket by using the List0Objects and ListObjectsV2 API
actions.

Returning results Consistent but non-alphabet-  Alphabetical order, by object
ical order key

Arbitrary prefix Partial support for Prefix, Prefix limits results to ob-
only if Prefix isa pathtoa ject keys that begin with the
file or directory under the prefix
bucket root directory (page
251)
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T T S

Arbitrary delimiter Only the slash ( /) character Delimiter groups results into
can act as Delimiter common prefixes

O Note
Although Qumulo Core supports Prefix and Delimiter partially, it supports the most
common use case—listing the contents of S3 buckets as a hierarchical file tree—fully.)))

Request Authentication

Qumulo Core supports authenticating requests by using only Amazon Signature Version 4. Most
S3 client applications support this authentication type.

If your application attempts to use a previous Amazon signature version, you receive a 400 Bad
Request response with the error code AuthorizationHeaderMalformed .

Versioning

Object Version Limits: In Qumulo Core, S3 bucket versioning is consistent with that of
Amazon S3, with the exception of individual object versions. Qumulo Core limits
directories to approximately 4.3 billion child files. The approach that Qumulo Core takes to
indexing files in a directory might cause object creation commmands to output the
QumuloDirectoryEntryLimitReached error when a directory gets close to its capacity.
Because Qumulo Core gives object versions unique identifiers, it might be possible to
retry the command successfully. However, if you begin to observe this error, we
recommend removing previous object versions from your system.

Creating Empty Versioned Directories: Qumulo Core doesn’t support creating empty,
versioned directories.

Deleting Versioned Objects: If you don't specify an object version ID, the DeleteObject and
DeleteObjects S3 API actions create a deletion marker for an object but don't delete any
file system data. Because currently Qumulo Core doesn't support bucket lifecycle policies,
the data remains accessible by using S3 API actions and the object version ID. To delete a
specific object version permanently, specify its version ID when you use either of these
API actions.

Comparison of Known Limits between S3 in Qumulo and Amazon

This section compares the Qumulo Core S3 API limits with native Amazon S3 limits.
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Limits for S3 Buckets

Maximum number of buckets 16,000 1,000

Maximum number of objects ~ Nominally unlimited Unlimited
in one bucket

Minimum bucket name 3 characters
length

Maximum bucket name 63 characters
length

O Note

If all objects in a bucket are under the same directory—none of the object keys have the slash
(/) character in them—the maximum number of objects in the bucket is limited to the
maximum number of files in a directory. For more information, see Supported Configurations
and Known Limits for Qumulo Core (page 19).

Limits for S3 Objects
Minimum object size 0 bytes

Maximum object size (by us- 5GiB
ing PutObject)

Maximum object size (by us- 48.8 TiB (10,000 * 5 GiB) 5TiB
ing MultipartUpload)

Minimum object key length 1 character

Maximum object key length 1,530 characters, if there are 1,024 characters
no slash ( /) characters in the
key

Maximum object versions 4,294 967,296 (theoretical) Unlimited
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Limits for S3 Multipart Uploads

Minimum part ID 1

Maximum part ID 10,000

Minimum number of parts for 1
each upload

Maximum number of parts 10,000
for each upload

Minimum part size 5 MiB (except for the last part of an upload)
Maximum part size 5CGiB

Additional part size require- Must be a multiple of 4 KiB —

ments (4,096 bytes), except for the

last part of an upload

Limits for S3 APl Requests

Object keys that DeleteOb- Nominally unlimited 1,000
jects specifies

Buckets that ListBuckets re- 16,000 1,000
turns
Objects that ListObjects 1,000

and ListObjectsV2 return
Parts that ListParts returns Unlimited 1,000

Uploads that ListMultipar- 1,000
tUploads returns

O Note
DeleteObjects is subject to a 10 MiB request payload limit in Qumulo Core. This provides a
practical upper limit on the number of object keys that the API action can specify.
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In addition, the following API actions have the Qumulo-specific maximum payload size limit of 10
MiB.

CompleteMultipartUpload
CreateBucket

DeleteObjects
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Monitoring and Metrics

How Audit Logging Works

This section explains the different formats of audit logs for file system operations that Qumulo
Core generates whenever a connected client sends a request to a Qumulo cluster.

Qumulo Core creates a descriptive audit log message for every operation that a client attempts.
Then, Qumulo Core sends the audit log messages to the remote syslog instance that the audit
logging configuration specifies in compliance with RFC 5424 .

This section explains the differences between the levels of detail of audit logs in syslog CSV (page
294), syslog JSON (page 298), and CloudWatch JSON (page 300) formats. (In general, the syslog
CSV and CloudWatch JSON formats contain audit logs contain an identical number of fields,
some named differently, while the syslog JISON format has additional audit logging information.)

0 Note
Qumulo Core doesn't parse, analyze, index, or visualize the data. For more information, see

the following articles on Qumulo Care:

- Sending Audit Logs for a Qumulo Cloud Cluster to Amazon CloudWatch
Using Qumulo Core Audit Logging with Elasticsearch

Using Splunk with Qumulo Core Audit Logging
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Details Included in the Default syslog CSV Format

O Note

Because the user ID, path fields, and secondary path fields can contain characters
that must be escaped (such as quotation marks and commas), you must enclose
these fields in quotation marks.

- Qumulo Core system strips out the \n and \r newline characters from the user ID, file

path, and secondary file path fields.

Both syslog CSV and syslog JSON formats deduplicate repeated file reads. However,
for metadata changes—such as modifications to an access-control list (ACL)—only
the syslog CSV deduplicates repeated operations.

Unlike the syslog JISON format (page 298), the syslog CSV format has only values (no
keys) and the fields are empty when unused. The following table helps explain the
fields and their possible values.

By default, Qumulo Core formats audit log messages in the syslog CSV format, prefaced by the
date, time, and the name of the machine that issues the operation. The syslog CSV format
includes the following fields in the following order within the log message body.

User IP address  The IP address of the user that

User ID

. IPv4 address
performed the operation.

IPv6 address

The ID of the user who performed  String in quotation marks:

the operation. . .
P - Active Directory (AD) username

O Note - Qumulo local username

Qumulo Core specifies the . POSIX user ID (UID)
Qumulo authentication ID if it
can't resolve any of the other

user ID types. - Qumulo authentication ID

- Windows security identifier (SID)
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Protocol

Operation Type

Operation Sta-
tus

The protocol that the operation
uses.

The operation that the user or the
system attempts to perform.

A success status or an error status.

api

ftp
internal
nfsv3
nfsv4.1l
s3

smb

Connectivity operation (page 303),
such as ftp login

SMB-Specific operation (page 303),
such as smb _create share

- Audit logging operation (page 303),

such as remote syslog startup

File system operation (page 303),
such as fs create

REST API operation (page 304), such
as ad _join

Success status message: ok
Error message:

o Credential error message (page
309),such as cred in-
valid sid error

o File system operation error mes-
sage (page 309), such as fs ac-
cess _perm _not owner_error
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File ID The ID of the file on which the sys-
tem performed an operation.

O Note
For non-file entities, this field
is empty.

File Path The path to the file on which the
system performed an operation.

O Note

For files accessed by using a
snapshot, the system prefixes
the path with /.snapshot.
(This is the same path prefix
that the system uses to access
snapshotted files through
NFSv3 and SMB.)

Target File Path  The target path to the file on
which the system performed a re-
name or move operation.

For example:

Integer

String in quotation marks

String in quotation marks
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Jun 6 14:52:28
p,ok,,"",""
Jun 6 14:52:28
ig,ok,,"",""
Jun 6 14:52:40
Jun 6 14:53:22

k,3,"/my file",

Jun 6 14:53:22

k,3,"/my file",

Jun 6 14:53:22
yifilell , nn
Jun 6 14:54:05

my-machine
my-machine

my-machine
my-machine

my-machine

my-machine

my-machine

e","/another file"

Jun 6 14:55:24

my-machine

g_config’ok' , nn , un

Jun 6 14:55:24
n’ok”llll’ll

my-machine

gqumulo
qumulo

gumulo
gumulo

gumulo
qgumulo
qgumulo
gumulo

qumulo

203.

203.

203.
203.

203.

203.

203.

203.

203.

.113.0, "system",internal, remote syslog startu
.113.0,"AD\alice",api,audit modify syslog conf
.113.0,"AD\alice",api, rest login,ok,,"",""
.113.0,"AD\alice",api, fs read metadata,o
.113.0,"AD\alice",api, fs write metadata,o
.113.0,"AD\alice",api, fs write data,ok,3,"/m
.113.0,"AD\alice",api, fs rename,ok,3,"/my fil
.113.0,"AD\alice",api,begin audit modify syslo
.113.0, "system",internal, remote syslog shutdow

Details Included in the syslog JISON Format

You can configure Qumulo Core to format audit log messages in the syslog JSON format. The
fields in this format are similar to the fields that the syslog CSV format provides (page 294), with
the following exceptions.

O Note

The syslog JSON format isn't available in the Web Ul.

user id Object

In Qumulo Core 6.0.1 (and higher)
the user id object replaces the sin-
gle user ID field in the syslog CSV
format and contains the fields sid,

auth id,and name.

sid: Security identifier
auth id:Authentication ID

name : User role
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details Object

For example:

For most file system operations,
the details object replaces the
file path, secondary file path, and
file ID fields in the syslog CSV for-
mat and contains the fields

path, target,and file id.

For fs write * and fs read *
operations, the details object
also includes the offset and
file size fields.

For operations that write meta-
data or change access-control
lists (ACLs), the details object
also includes the after and be-
fore objects that include fields
for current and previous metada-
ta.

details object:

o path: File path

o target :Target file path
o file id:FileID

fs write * and fs read * oper-
ations only:

o offset:The starting position
of the operation

o file size:The size of the op-
eration

after and before objects:
o ctime: Changed timestamp
o mtime : Modified timestamp
° owner

m sid:Security identifier

B auth id:Authentication ID
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Jun 6 14:52:28 my-machine qumulo {"user id": {"auth id": "1", "sid": "S-1-5-21-98765
43210-5678901234-1234567890-1", "name": "system"}, "user_ ip": "203.0.113.0", "protoc
ol": "internal", "operation": "remote syslog startup", "status": "ok", "details":
{}}

Jun 6 14:52:28 my-machine qumulo {"user id": {"sid": "S-1-5-21-9876543210-567890123
4-1234567890-500", "auth id": "500", "name": "AD\alice"}, "user ip": "203.0.113.0",
"protocol": "api", "operation": "audit modify syslog config", "status": "ok", "detai
1s": {"second extra name": "", "extra name": ""}}

Jun 6 14:52:40 my-machine qumulo {"user id": {"auth id": "500", "name": "AD\alice",
"sid": "S-1-5-21-9876543210-5678901234-1234567890-500"}, "user ip": "203.0.113.0",
"protocol”: "api", "operation": "rest login", "status": "ok", "details": {"second ex
tra name": "", "extra name": ""}}

Jun 6 14:53:22 my-machine qumulo {"user id": {"sid": "S-1-5-21-9876543210-567890123
4-1234567890-500", "name": "AD\alice", "auth id": "500"}, "user ip": "203.0.113.0",
"protocol”: "api", "operation": "fs read metadata", "status": "ok", "details": {"pat
h*: "/my file", "file id": "4"}}

Jun 6 14:53:22 my-machine qumulo {"user id": {"name": "AD\alice", "sid": "S-1-5-21-9
876543210-5678901234-1234567890-500", "auth id": "500"}, "user ip": "203.0.113.0",
"protocol": "api", "operation": "fs write metadata", "status": "ok", "details": {"fi
le id": "4", "after": {"ctime": "2024-06-11T14:55:58.187394089Z", "mtime": "2024-0
6-11T14:55:58.187394089Z", "owner": {"sid": "S-1-5-21-9876543210-5678901234-12345678
90-500", "auth id": "500"}}, "path": "/my file", "before": {"ctime": "2024-06-11T1
4:55:43.616292461Z2", "mtime": "2024-06-11T14:55:43.616292461Z2", "owner": {"sid":
"S-1-5-21-9876543210-5678901234-1234567890-500", "auth id": "500"}}}}

Jun 6 14:53:22 my-machine qumulo {"user id": {"auth id": "500", "sid": "S-1-5-21-987
6543210-5678901234-1234567890-500", "name": "AD\alice"}, "user ip": "203.0.113.0",
"protocol": "api", "operation": "fs write data", "status": "ok", "details": {"pat
h": "/my file", "size": 261456, "file id": "4", "offset": 0, "file size": 261456}}
Jun 6 14:54:05 my-machine qumulo {"user id": {"name": "AD\alice", "auth id": "500",
"sid": "S-1-5-21-9876543210-5678901234-1234567890-500"}, "user ip": "203.0.113.0",
"protocol": "api", "operation": "fs rename", "status": "fs entry exists error", "det
ails": {"path": "/my file", "target": "/another file", "file id": "4"}}

Jun 6 14:55:24 my-machine qumulo {"user id": {"sid": "S-1-5-21-9876543210-567890123
4-1234567890-500", "auth id": "500", "name": "AD\alice"}, "user ip": "203.0.113.0",
"protocol": "api", "operation": "begin audit modify syslog config", "status": "ok",
"details": {"second extra name": "", "extra name": ""}}

Jun 6 14:55:24 my-machine qumulo {"user id": {"auth id": "1", "sid": "S-1-5-21-98765
43210-5678901234-1234567890-1", "name": "system"}, "user ip": "203.0.113.0", "protoc
ol": "internal", "operation": "remote syslog shutdown", "status": "ok", "details":

{}}

Details Included in the Amazon CloudWatch JSON Format

You can configure Qumulo Core to format audit log messages in the Amazon CloudWatch JSON
format.
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™ Tip
To download the audit log from the CloudWatch console, on the left navigation panel click
Logs > Log groups, click a log group, and then on the Log events page click Actions > Copy

search results (ASCII).

Rather than preface each line of CSV or JSON with the date and time, CloudWatch creates an
ASCII table, which contains Unix timestamps in its first column. The second column contains the
fields that are similar to the fields that both the syslog CSV format (page 294) and the syslog
JSON format (page 298) provide, with the following exceptions.

- The result field replaces the Operation Status or status field.
- The object id field replaces the File ID file id field.
- The path 1 field replaces the File Path or path field.

- The path 2 field replaces the Target File Path or target field.

For example:
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| timestamp

messag

| 1717679548000 | {"ip address": "203.0.113.0", "user": "system", "protocol": "inter
nal", "operation": "remote syslog startup", "result": "ok", "object id": "", "pat

h 1": "", "path 2": ""} |

| 1717679548000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "audit modify syslog config", "result": "ok", "object id": "", "pat
h 1": "", "path 2": ""} |

| 1717679560000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "rest login", "result": "ok", "object id": "", "path 1": "", "pat

h 2": ""} |

| 1717679602000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "fs read metadata", "result": "ok", "object id": "3", "path 1": "/m
y file", "path 2": ""} |

| 1717679602000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "fs write metadata", "result": "ok", "object id": "3", "path 1":
"/my file", "path 2": ""} |

| 1717679602000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "fs write data", "result": "ok", "object id": "3", "path 1": "/my f
ile", "path 2": ""} |

| 1717679645000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "fs rename", "result": "ok", "object id": "3", "path 1": "/my fil
e", "path 2": "/another file"} |

| 1717679724000 | {"ip address": "203.0.113.0", "user": "AD\alice", "protocol": "ap
i", "operation": "begin audit modify syslog config", "result": "ok", "object id":
“*, "path 1": "", "path 2": ""} |

| 1717679724000 | {"ip address": "203.0.113.0", "user": "system", "protocol": "inter
nal", "operation": "remote syslog shutdown", "result": "ok", "object id": "", "pat

h 1": "", "path 2": ""} [

Operation Names in Audit Logging

This section lists the operation names in Qumulo Core audit logging.
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Connectivity Operations
ftp_login
nfs mount
rest login
share_connect
smb_close handle
smb_close session

smb_Tlogin

SMB-Specific Operations
smb_create share
smb _modify share
smb_delete share

smb2 notify req

Audit Logging Operations

remote syslog shutdown

remote syslog startup

File System Operations

fs_copy_chunk

fs _create directory
fs create directories
fs create file

fs create hard link
fs create symlink

fs _create stream

fs_create
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O Note
This operation type applies to any but the previous file types.

fs _delete

fs fsstat

fs list directory
fs _open

fs read data

fs read link

fs _read metadata
fs_read user metadata
fs_rename

fs set quota

fs tree delete

fs write data

fs write metadata
fs write file lock

fs write user metadata

REST API Operations

ad_cancel operation

ad _dismiss _error

ad join

ad kerberos renew ticket

ad leave

ad modify settings

ad reconfigure

audit modify cloudwatch config

audit modify syslog config
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auth _add group

auth _add member to group
auth_assign role

auth create access token

auth create role

auth create user

auth delete access token

auth delete group

auth delete identity attributes
auth delete role

auth_delete user

auth get access token

auth get access tokens

auth modify access token

auth modify group

auth modify identity attributes
auth modify role

auth modify user

auth _modify user password
auth_remove member from group
auth _set user defined mappings
auth unassign role
cluster add nodes

cluster calculate node add capacity
cluster generate vpn private key
cluster initiate node replacement plan
cluster _install vpn keys

cluster locate disk slot

cluster modify config
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cluster modify monitoring config
cluster modify nodes
cluster modify nodes dry run
cluster modify upgrade config
cluster nodes resolve indeterminate modification
dns create

dns delete

dns modify

dns set lookup overrides
encryption create key
encryption rotate keys
encryption update config

fs _create public key

fs _delete public key

fs modify atime settings

fs modify notify settings

fs modify permissions settings
fs _modify public key

fs _release nlm locks by client
fs _release nlm locks by file
fs_replace public key

fs _sample

ftp_modify settings

identity create

identity delete

identity modify

kerberos delete keytab
kerberos modify settings

kerberos set keytab
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ldap modify settings

network create config

network delete config

network modify config
network modify interface

nfs create export

nfs delete export

nfs delete settings

nfs modify export

nfs modify settings

node halt

node restart

node set identify light

reboot pause

reboot resume

reboot start

replication abort
replication abort object relationship
replication _authorize target relationship
replication create object relationship
replication create source relationship
replication delete object relationship
replication delete source relationship
replication delete target relationship
replication dismiss source relationship error
replication dismiss target relationship error
replication _make target writable
replication modify source relationship

replication reconnect target relationship
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replication release queued snapshot
replication replicate object relationship
replication_reverse target relationship
replication start
replication target relationship lock
s3 abort upload

s3 _add bucket

s3 bucket policy explain access

s3 create key

s3 delete bucket

s3 delete key

s3 _get bucket policy

s3 modify bucket

s3 modify settings

s3 put bucket policy

saml modify settings

session change password

shutdown halt

smb_delete settings

smb_modify settings

snapshot create policy

snapshot create snapshot

snapshot delete policy

snapshot delete snapshot
snapshot lock snapshot

snapshot modify policy
snapshot modify snapshot

snapshot unlock snapshot

snapshot unlock snapshot challege
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ssl delete ca certificate
ssl modify ca certificate
ssl modify certificate
tenant_create

tenant delete

tenant modify

time modify config

tree delete cancel

tree delete start

web ui modify settings

Error Status Messages

This section lists the error status messages in Qumulo Core audit logging.

Credential Error Messages

cred error

cred identity not supported error
cred invalid local user error
cred invalid sid error

cred remote resource unavailable error

File System Operation Error Messages

fs _access denied error

fs _access error

fs access perm not owner error
fs_already read only error

fs _default stream of directory error
fs _directory cycle error

fs _directory error

fs _directory hash exhaustion error
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fs directory is symlink error
fs directory not empty error
fs_encountered portal error

fs_entry exists error

fs_entry hardlink ambiguity error

fs _entry not in subtree error

fs_exceeded maximum stream count error

fs file dirent id stale error
fs file is named stream error

fs file is symlink error

fs _file not covered by snapshot error

fs file not empty error

fs file path invalid error
fs file size error

fs file too many links error
fs invalid acl error

fs _invalid attrs error

fs _invalid file type error
fs_invalid name_error

fs invalid offset error

fs _invalid size error

fs _name size error

fs _no such entry error

fs no such file version error
fs no such inode error

fs _no such path error

fs not a directory error

fs not a file error

fs not a symlink error
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fs opened file stale error

fs _path size error
fs_permissions mode operation unsupported error
fs portal create orphanage error

fs _portal disconnected error

fs portal ended error

fs portal error

fs portal eviction error

fs portal inconsistent data error

fs portal incorrect state error

fs portal invalid lease break range error
fs portal not covered by snapshot error
fs _portal not found error

fs portal out of order lease break error
fs quota limit already set error

fs quota limit does not exist error
fs_quota no space error

fs _read only error

fs _revision mismatch error

fs s3 versioning full error

fs _same inode error

fs sharing violation error

fs _smb _share root deleted error

fs stream is default error

fs symlink loop error

fs_tag mismatch _error

fs too many aces error

fs _user metadata continuation token type mismatch

fs _user metadata empty insertion_error
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fs user metadata hash exhaustion error
fs user metadata key already exists

fs _user metadata key not found

fs user metadata too large

fs watcher missed events error
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Qumulo OpenMetrics API Specification

This section lists the names, types, labels, and descriptions for the metrics that Qumulo Core 5.3.0
(and higher) emits in OpenMetrics API format.

The Qumulo OpenMetrics API has a single endpoint that provides a complete view of point-in-
time telemetry from Qumulo Core to monitoring systems. These systems, such as Prometheus,
can consume the OpenMetrics data format that the Qumulo Core REST API emits without
custom code or a monitoring agent. For more information about data formats, see your
monitoring system’s documentation.

Accessing Qumulo Metrics

Qumulo metrics are available at the following endpoint.
https://<my-cluster-hostname>:8000/v2/metrics/endpoints/default/data

You can configure a monitoring system that supports the OpenMetrics Specification to use
bearer token authentication (page 40) to access this endpoint.

Metric Types

All Qumulo metrics belong to one of the following OpenMetrics types.

counter An integer that increases monotonically from zero, stored in <met -
ric_name> count.

O Note
During normal operation, the value of counter never decreases.

gauge A value that represents a single integer (similar to counter ), stored in <met-
ric_name>.
O Note
During normal operation, the value of a gauge metric might increase or de-
crease.
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histogram
A representation of a series of buckets, where each bucket tracks values within a
specific range.
A histogram has a count field and a sum field, stored in <metric name> count
(the total number of samples) and <metric name> sum (the sum of all samples).
Qumulo Core emits a single bucket that contains all samples.
™ Tip
You can use histogram metrics to keep track of averages by dividing the sum
field by the count field.
info Informational text about the system, stored in <metric name> info.An info

metric always has a value of 1 and labels that contain detailed information.

For more information, see Metric Types in the OpenMetrics Specification.

Metric Labels

The OpenMetrics format allows for metric labeling for coommunicating additional information. To
provide context for metrics, Qumulo Core emits metric-specific labels. For example, the name of a
protocol operation or the url of a remote server. For more information, see Available Labels
(page 322).

Available Metrics

The following table lists metric names, types, labels, and descriptions.

O Note
For Qumulo as a Service, all metrics with a node_id label are unavailable because they refer to

specific hardware.
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Metric Name

qumulo

qumulo node

qumulo_ad netlogon request
_errors

qumulo _ad netlogon request
_latency seconds

Metric

Type

info
(page 314)

info
(page 314)

counter
(page 313)

histogram
(page 314)

Labels Suppor-
ted
from
Qumulo
Core
Version
530

max_drive failures
max_node failures
name
platform
service model
uuid
version
™ Tip
Don't confuse thi
s label for the Qu
mulo Core versio
n with the identi
cally named labe
| for the kernel ve
rsion for the qumu
lo _kernel metric.
6.0.2
node id (page 324)
node model
53.0
domain_url (page 323)
server_url (page 324)
53.0

domain url (page 323)

server_url (page 324)

Description

Qumulo Core
information, in-
cluding the
cluster name,
cluster UUID,
and the current
Qumulo Core
version.

Information
about the
nodes in the
cluster, includ-
ing the node ID
and the node
model

The total num-
ber of Active Di-
rectory (AD)
NETLOGON re-
quests that re-
sulted in an er-
ror

The total laten-
cy for AD NETL-
0GON requests
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Metric Name Metric Labels Suppor- | Description

Type ted
from
Qumulo
Core
Version
qumulo ad netlogon requests counter ) 530 The total num-
(page 313) demieiln Ul (jgEge 525) ber of complet-

server_url (page 324) ed AD NETLO-
GON operations

qumulo cpu_crit temperature celsius gauge 7202 The critical
(page313) ~ PY (page 322) temperature
node id (page 324) threshold for
each physical
CPU

qumulo cpu_max_temperature gauge 531 The maximum
. - cpu (page 322)
_celsius (page 313) temperature
node id (page 324) threshold for
each physical
CPU

qumulo cpu_temperature gauge 55 530 The tempera-
_celsius (page 313) = <P (Page 322) ture for each

node id (page 324) physical CPU, in
degrees Celsius

qumulo_disk endurance gauge ) 531 The remaining
_percent (page 313) o GBS [[pede 22 disk endurance
drive bay (page 323) value for each
disk in the clus-
node_id (page 324) ter, ranging
100 (no disk
wear) to 0
(disk is worn
fully)

qumulo _disk transport counter ok 43 532 The total num-
_errors (page 313) disk_type (page 323) ber of commu-

drive bay (page 323) nication errors
between the
node_id (page 324) specified drive

and its host.
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Metric Name Metric Labels Suppor- | Description

Type ted
from
Qumulo
Core
Version
qumulo disk uncorrectable counter o o 532 The total num-
_media_errors (page 313) ddele Type [pegie 325 ber of uncor-
drive bay (page 323) rectable errors
on the speci-
node_id (page 324) fied drive's
physical media.
qumulo disk is unhealthy gauge ) 43 530 The health of
(page 313) disk_type (page 323) each disk in the
drive bay (page 323) cluster, ranging
from 0 (the
node_id (page 324) disk is healthy)
to 1 (thedisk
is unhealthy)
qumulo _disk operation histogram o o 530 The total laten-
_latency seconds (page 314) o sk Epe [peae ) cy for disk 1/O
drive bay (page 323) operations
io type (page 323)
node id (page 324)
qumulo fan speed rpm gauge . 53.0 The fan speed,
(page 313) fan (page 323) in RPM
node id (page 324)
qumulo fs capacity bytes gauge — 53.0 The total cluster
(page 313) space, in bytes
qumulo fs directory gauge , 530 The number of
_tree entries (page 313) entry_type (page 323) file system ob-
path (page 324) jectson the
cluster, sorted
by object type
qumulo fs directory gauge . e 530 The amount of
_used bytes (page 313) PRIER ([l 224 space that ob-
usage_type (page 324) ject types use,
in bytes
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Metric Name

qumulo fs free bytes

qumulo fs snapshots

qumulo_ldap lookup
_request _errors

qumulo ldap lookup
_request latency seconds

qumulo_ldap lookup
_requests

qumulo ldap operation
_errors

qumulo ldap operation
_latency seconds

qumulo ldap operations

Metric
Type

gauge
(page 313)

gauge
(page 313)

counter

(page 313)

histogram
(page 314)

counter
(page 313)

counter
(page 313)

histogram

(page 314)

counter
(page 313)

Labels

domain_url (page 323)

server _url (page 324)

domain_url (page 323)

server _url (page 324)

domain_url (page 323)

server _url (page 324)

domain_url (page 323)

domain_url (page 323)

domain_url (page 323)

Suppor-
ted
from
Qumulo
Core
Version

53.0

530

530

530

530

53.0

530

530

Description

The free space
on the cluster,
in bytes

The number of
snapshots on
the cluster

The total num-
ber of LDAP re-
quests that re-
sulted in an er-
ror

The total laten-
cy of LDAP re-
quests

The total num-
ber of complet-
ed LDAP re-
guests

The total num-
ber of LDAP op-
erations that re-
sulted in an er-
ror

The total laten-
cy for LDAP op-
erations

The total num-

ber of complet-
ed LDAP opera-
tions
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Metric Name

qumulo_memory correctable
_ecc_errors

qumulo network interface
_is down

qumulo network interface
~link speed bits per second

qumulo network interface
_receive errors

qumulo network interface
_received bytes

Metric
Type

counter
(page 313)

gauge
(page 313)

gauge
(page 313)

counter
(page 313)

counter
(page 313)

Labels

node_id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node_id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node id (page 324)

Suppor-
ted
from
Qumulo
Core
Version

53.0

530

530

53.0

530

Description

The total num-
ber of memory
errors that
Qumulo Core
corrected auto-
matically

The interface
status, 0 (inter-
faceisup)or 1
(interface is
down)

The negotiated
link speed for
the specified
interface

The total num-
ber of receive
errors on the
specified inter-
face

The total bytes
received on the
specified inter-
face
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Metric Name

qumulo network interface
_received packets

qumulo network interface
_transmit _errors

qumulo network interface
_transmitted bytes

qumulo network interface
_transmitted packets

qumulo power supply
_1s unhealthy

qumulo protocol client
_connections

Metric
Type

counter
(page 313)

counter
(page 313)

counter
(page 313)

counter
(page 313)

gauge
(page 313)

counter
(page 313)

Labels

bond (page 322)
interface (page 323)
role (page 324)

node_id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node_id (page 324)

bond (page 322)
interface (page 323)
role (page 324)

node id (page 324)

location (page 323)

node_id (page 324)

protocol (page 324)

Suppor-
ted
from
Qumulo
Core
Version

53.0

530

530

530

530

530

Description

The total num-
ber of packets
received on the
specified inter-
face

The total num-
ber of transmis-
sion errors on
the specified
interface

The total num-
ber of bytes
transmitted on
the specified
interface

The total num-
ber of packets
transmitted on
the specified
interface

PSU health, 0
(healthy) or 1
(unplugged, re-
moved, or unre-
sponsive)

The total num-
ber of clients
that have con-
nected to the
specified proto-
col
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Metric Name

qumulo protocol client
_disconnections

qumulo protocol operation
_bytes

qumulo protocol operation
_latency seconds

qumulo protocol operations

qumulo quorum node is
_offline

Metric
Type

counter
(page 313)

counter
(page 313)

histogram
(page 314)

counter
(page 313)

gauge
(page 313)

Labels Suppor-

ted
from
Qumulo
Core
Version

protocol (page 324) 530

53.0
data_type (page 322)

io type (page 323)

op_name (page 324)

protocol (page 324)
data_type (page 322) =30
io type (page 323)

op_name (page 324)

protocol (page 324)

data type (page 322) >0
io_type (page 323)

op_name (page 324)

protocol (page 324)

node_id (page 324) 530

Description

The total num-
ber of clients
that have dis-
connected
from the speci-
fied protocol

The total bytes
that protocol
operations have
transferred

The total laten-
cy for protocol
operations

The total num-
ber of complet-
ed protocol op-
erations

The online sta-
tus for each
node in the
cluster, 0
(node online) or
1 (node of-
fline)
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Metric Name Metric Labels Suppor- | Description

Type ted
from
Qumulo
Core
Version
qumulo time is not synchronizing gauge node_id (page 324) 530 The time syn-
(page 313) chronization

status for each
node in the
cluster, 0 (time
is synchronized)
or 1 (timeisn't
synchronized)

Available Labels

The following table lists metric label names, possible values, and descriptions.

Possible Values Description

bond The bond to which a network inter-
- bond0
face belongs
bond1l
cpu A non-negative integer The CPU index in the node

data type The data type that an operation

data: Read or write operations on th
transfers

e data of afile.

metadata : Operations (such as looku
p, stat,or getattr) unrelated to a fi
le's data

none : Operations that operate on nei
ther the file data nor the metadata.

0 Note

The protocol often requires these
operations for session negotiatio
N and authentication.
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Label Possible Values Description

Name

isk t Th lyi
disk type hdd - Hard Disk Drive e underlying storage type
ssd : Solid-State Drive
domain url  An Active Directory domain (for exam- The URL of the domain

ple, my-domain.com) or an LDAP bind
URI (for example, ldap://my-server.my-
domain.com)

drive bay A drive bay name. For example: b3, 1.1  The physical drive bay in the chassis.

entry type The file system object type
R - alternate data stream 4 J yP

directory
file
other

symlink

fan A fan name, for example system fan 1 The fan name
interface An interface name, for example etho The interface name

io type , The 1/O that an operation performs
- composite

none
read

wait : A blocking operation that takes
an indeterminate amount of time

write

location A location on the chassis, for example The location on the chassis.
left or right

O Note
For PSU, this location is relative
to the back of the node.
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Label
Name

node id

op_name

path

protocol

role

server_url

usage_type

Possible Values

A positive integer that represents a node
ID in the cluster.

Any operation name, including NFSv3,
NFSv4.1, SMBv2, SMBV3, REST, S3, repli-
cation, or FTP

Slash (/)

nfs : NFSv3 or NFSv4.]
smb : SMBvV2 or SMBvV3
rest

s3

replication

ftp

frontend

backend

A hostname (for example, ad.my-do-
main.com) or an IP address

data
metadata

snapshot

Description

A value that differentiates between
the different nodes in a cluster

The recorded operation

The path to a directory in the file sys-
tem

The protocol of the recorded opera-
tion

The role of the interface

O Note

frontend includes protocol, man-
agement, and replication traffic.
backend includes all intra-node
communications.

The URL of a remote server

The data type that uses space
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